Bruker software support is available via phone, fax, e-mail, Internet, or ISDN. Please contact your local office, or directly:

Address: Bruker Analytik GmbH
         Software Department
         Silberstreifen
         D-76287 Rheinstetten
         Germany

Phone:  +49 (7243) 5161 440
Fax:     +49 (7243) 5161 480
E-mail:  nmr-software-support@bruker.de
FTP:     ftp.bruker.de / ftp.bruker.com
WWW:     www.bruker.de / www.bruker.com
ISDN:    on request
## Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chapter 1</strong></td>
<td>Introduction</td>
<td>3</td>
</tr>
<tr>
<td>1.1</td>
<td>About this manual</td>
<td>3</td>
</tr>
<tr>
<td>1.2</td>
<td>Conventions</td>
<td>3</td>
</tr>
<tr>
<td>1.3</td>
<td>About dimensions</td>
<td>4</td>
</tr>
<tr>
<td>1.4</td>
<td>About digitally filtered Avance data</td>
<td>5</td>
</tr>
<tr>
<td>1.5</td>
<td>Usage of acquisition commands in AU programs</td>
<td>5</td>
</tr>
<tr>
<td>1.6</td>
<td>Starting commands from the XWIN-NMR menu</td>
<td>6</td>
</tr>
<tr>
<td><strong>Chapter 2</strong></td>
<td>XWIN-NMR parameters</td>
<td>7</td>
</tr>
<tr>
<td>2.1</td>
<td>About XWIN-NMR parameters</td>
<td>7</td>
</tr>
<tr>
<td>2.2</td>
<td>Parameter value types</td>
<td>10</td>
</tr>
<tr>
<td>2.3</td>
<td>Parameter files</td>
<td>10</td>
</tr>
<tr>
<td>2.4</td>
<td>Acquisition (eda) parameters</td>
<td>11</td>
</tr>
<tr>
<td>2.5</td>
<td>Acquisition status (dpa) parameters</td>
<td>52</td>
</tr>
<tr>
<td>2.6</td>
<td>Routing (edasp) parameters</td>
<td>57</td>
</tr>
<tr>
<td>2.7</td>
<td>Lock (edlock) parameters</td>
<td>58</td>
</tr>
<tr>
<td><strong>Chapter 3</strong></td>
<td>Spectrometer configuration commands</td>
<td>61</td>
</tr>
<tr>
<td><strong>Chapter 4</strong></td>
<td>Lock commands</td>
<td>101</td>
</tr>
<tr>
<td><strong>Chapter 5</strong></td>
<td>Shim commands</td>
<td>117</td>
</tr>
<tr>
<td><strong>Chapter 6</strong></td>
<td>Probehead commands</td>
<td>131</td>
</tr>
<tr>
<td><strong>Chapter 7</strong></td>
<td>Parameter handling commands</td>
<td>147</td>
</tr>
<tr>
<td><strong>Chapter 8</strong></td>
<td>Pulse and AU program commands</td>
<td>169</td>
</tr>
<tr>
<td><strong>Chapter 9</strong></td>
<td>Acquisition commands</td>
<td>189</td>
</tr>
<tr>
<td><strong>Chapter 10</strong></td>
<td>Temperature commands</td>
<td>225</td>
</tr>
<tr>
<td><strong>Chapter 11</strong></td>
<td>MAS/Solids commands</td>
<td>237</td>
</tr>
<tr>
<td><strong>Chapter 12</strong></td>
<td>Rename and delete commands</td>
<td>257</td>
</tr>
<tr>
<td><strong>Chapter 13</strong></td>
<td>Miscellaneous</td>
<td>265</td>
</tr>
<tr>
<td><strong>Chapter 14</strong></td>
<td>NMR Suite files</td>
<td>277</td>
</tr>
</tbody>
</table>
Chapter 1

Introduction

1.1 About this manual

This manual is a reference to XWIN-NMR acquisition or acquisition related commands and parameters. Every command is described on a separate page with its syntax and function as well and its main input/output files and parameters. Although file handling in XWIN-NMR is completely transparent to the user, it is sometimes useful to know which files are involved and where they reside. For example, if you have permission problems or if you want to process or interpret your data with third party software.

Some of the commands referred to in this manual are processing commands. They are all described in the Processing reference manual.

1.2 Conventions

Font conventions

- \texttt{zag} - commands to be entered on the command line are in courier bold italic
- \texttt{wobb-SW} - commands to be clicked are in times bold italic
- \texttt{go=2} - pulse program statements are in courier small
1.3 About dimensions

XWIN-NMR can acquire 1, 2 or 3 dimensional data. The dimensions of a dataset are indicated with the terms F3, F2 and F1 which are used as follows:

1D data
   F1 - acquisition dimension

2D data:
   F2 - acquisition or direct dimension
   F1 - indirect dimension

3D data:
F3 - acquisition or direct dimension
F2 - indirect dimension
F1 - indirect dimension

In 3D processed data, F2 is always the second and F1 the third dimension. In 3D raw data, this order can be the same or reversed, depending on the value of AQSEQ (see the description of this acquisition parameter).

1.4 About digitally filtered Avance data

The first points of the raw data measured on an Avance spectrometer are called group delay. These points represent the delay caused by the digital filter and do not contain spectral information. However, they contain information about the digital filtering and are required for processing. The first couple of points of the group delay are always zero. The group delay only exists if digital filtering is actually used, i.e. if the acquisition parameter DIGMOD is set to digital.

1.5 Usage of acquisition commands in AU programs

Many acquisition commands described in this manual can also be used in AU programs. The description of these commands contains an entry USAGE IN AU PROGRAMS. This means an AU macro is available which is usually the name of the command in capitalized letters. Note that ICON-NMR automation automatically calls acquisition AU programs. If, in this manual, the entry USAGE IN AU PROGRAMS is missing, no AU macro is available. Usually, such a command requires user interaction and it would not make sense to put it in an AU program. However, if you still want to use such a command in AU, you can do that with the XCMD macro which takes an XWIN-NMR command as argument. Examples are:

```plaintext
XCMD("eda")
XCMD("setdef ackn no")
```

AU programs can be set up with the command `edau`.

Acquisition commands can also be used in an XWIN-NMR macro. These are scripts created with `edmac` containing a sequence of XWIN-NMR commands. The syntax of each line is simply an XWIN-NMR command (in lowercase letters) as it would be entered on the command line.
1.6 Starting commands from the XWIN-NMR menu

This manual describes all acquisition commands as they can be entered on the command line. However, they can also be clicked from the XWIN-NMR popup menus. Most acquisition commands can be found under the Acquire menu. There, the corresponding command line commands are specified in square brackets.
Chapter 2

XWIN-NMR parameters

2.1 About XWIN-NMR parameters

XWIN-NMR parameters are divided in acquisition, processing, plot and output parameters. In this manual, we will mainly concern ourselves with acquisition parameters. Furthermore, we will discuss the acquisition related lock and prosol parameters.

The following terms will be used:

acquisition parameters
Parameters that must be set by the user, for example with \texttt{eda}, and that are interpreted by acquisition commands, for example \texttt{zg}.

acquisition status parameters
Parameters that are set by acquisition commands like \texttt{zg}. They represent the status of the raw data and can be viewed, for example with \texttt{dpa}. Some acquisition status parameters are used as input by processing commands.

lock parameters
Parameters that are used for locking the magnetic field. They can be set up with the \texttt{edlock} command and are interpreted when you lock in, either with the
lock command or from the BSMS keyboard.

prosol parameters

Probehead and solvent dependent parameters, mainly pulse lengths and power levels. They can be set up with the edprosol command. The getprosol command reads the prosol parameters and copies them to the corresponding acquisition parameters.

input parameters

Parameters that are interpreted by the commands described in this manual. They can be:

• acquisition parameters (input of, for example, zg)
• lock parameters (input of edlock, lock and lopo)
• prosol parameters (input of edprosol and getprosol)

output parameters

Parameters that are set or modified by commands described in this manual. They can be:

• acquisition status parameters (output of, for example, zg)
• lock parameters (output of edlock)
• prosol parameters (output of edprosol)

temporary parameters

Parameters that are not stored in parameters files and not interpreted directly by acquisition commands. They are related to other parameter that are directly interpreted by acquisition commands. If you change a temporary parameter, for example in eda, the related parameters will be automatically adjusted. An example of a temporary is AQ that is determined by the equation:

\[ AQ = \frac{2*TD}{SW*SFO1} \]

Acquisition parameters can be set with the parameter editor eda and acquisition status parameters can be viewed with dpa. Alternatively, each parameter can be set or viewed by entering its name in lowercase letters on the command line. Here are some examples of how you can set or view the parameter TD:

On a 1D dataset:
• \textit{td} - set the parameter TD
• \textit{1s td} - view the status parameter TD

On a 2D dataset:
• \textit{td} - set the parameter TD in the F2 dimension (= direct dimension)
• \textit{2 td} - set the parameter TD in the F2 dimension (same as \textit{td})
• \textit{1 td} - set the parameter TD in the F1 dimension (= indirect dimension)
• \textit{2s td} - view the status parameter TD in the F2 dimension
• \textit{1s td} - view the status parameter TD in the F1 dimension

On a 3D dataset:
• \textit{td} - set the parameter TD in the F3 dimension (= direct dimension)
• \textit{3 td} - set the parameter TD in the F3 dimension (same as \textit{td})
• \textit{2 td} - set the parameter TD in the F2 dimension (= indirect dimension)
• \textit{1 td} - set the parameter TD in the F1 dimension (= indirect dimension)
• \textit{3s td} - view the status parameter TD in the F3 dimension
• \textit{2s td} - view the status parameter TD in the F2 dimension
• \textit{1s td} - view the status parameter TD in the F1 dimension

Although status parameters are normally not changed by the user, a command like \textit{1s td} allows you to do that. This, however, would make the dataset inconsistent.

Before an acquisition has been performed, the acquisition status parameters of a dataset do not contain significant values. After the acquisition, they represent the status of the raw data.

Most acquisition status parameters are set to the same values as the corresponding acquisition parameters. In other words, the acquisition command has done what you told it to do. There are, however, some exceptions:
• when an acquisition was interrupted, the acquisition status parameters might not have been updated yet.
• some acquisition parameters are automatically adjusted by the acquisition command, e.g. RG and FW.
• the values of some parameters are a result of the acquisition. They cannot be set by the user (they do not appear as acquisition parameters) but they are
stored as acquisition status parameters. Examples are AQSEQ, YMAX_a and NC.

### 2.2 Parameter value types

With respect to the type of values they take, acquisition parameters can be divided into three groups:

- parameters taking integer values, e.g. NS, TD, DR
- parameters taking real (float or double) values, e.g. SW, O1, DE
- parameters using a predefined list of values, e.g. AQ_mod, DIGTYP

You can easily see to which group a parameter belongs from the parameter editor opened with the command `eda`. Note that the values of parameters which use a predefined list are stored in the parameter file as integers. The first value of the list is always stored as 0, the second value as 1 etc. Table 2.1 shows the values of the parameter AQ_mod as an example:

<table>
<thead>
<tr>
<th>Parameter value</th>
<th>Integer stored in the proc(s) file</th>
</tr>
</thead>
<tbody>
<tr>
<td>qf</td>
<td>0</td>
</tr>
<tr>
<td>qsim</td>
<td>1</td>
</tr>
<tr>
<td>qseq</td>
<td>2</td>
</tr>
<tr>
<td>DQD</td>
<td>3</td>
</tr>
</tbody>
</table>

**Table 2.1**

### 2.3 Parameter files

XWIN-NMR parameters are stored in various files in the dataset directory tree.

In a 1D dataset:

```
<du>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters
acqus - acquisition status parameters
```

In a 2D dataset:

```
<du>/data/<user>/nmr/<name>/<expno>/
```
acqu - F2 acquisition parameters
acqu2 - F1 acquisition parameters
acqus - F2 acquisition status parameters
acqu2s - F1 acquisition status parameters

In a 3D dataset:
<du>/data/<user>/nmr/<name>/<expno>/
acqu - F3 acquisition parameters
acqu2 - F2 acquisition parameters
acqu3 - F1 acquisition parameters
acqus - F3 acquisition status parameters
acqu2s - F2 acquisition status parameters
acqu3s - F1 acquisition status parameters

2.4 Acquisition (eda) parameters

This paragraph contains a list of all acquisition parameters with a description of their function. Most of them are interpreted by various acquisition commands like zg, go, ii, resume, gs, rga and pulsdisp. Some, however, are only interpreted by specific commands which are then specified in the list below. Acquisition parameters can be set with eda or by typing their names in lowercase letters on the command line.

AQ - acquisition time in seconds
  • takes a float value
  • temporary parameter calculated from the equation:
    \[ AQ = \frac{2 \times TD}{SW \times SFO1} \]
  • AQ represents the time to acquire one scan. If you change AQ, TD is changed accordingly. The above equation holds for DIGTYP = SADC. Other digitizers require a 1-4 extra dwell times. This number is automatically detected from your digitizer by the acquisition software.

AMP[0-31] - amplitude of pulses
  • takes float values in percent
  • can be set from eda by clicking Amp ** Array **
  • can also be set by entering amp0, amp1 etc. on the command line
• can also be set from gs by adjusting (FID display)
• can be only used on Avance-AQS spectrometers
• interpreted by the pulse program statements amp0, amp1, amp2 etc.
• The parameter AMP defines the percentage of the maximum pulse power. It can be used instead of or in addition to the parameter PL. The advantage of AMP is that the relation between AMP values and pulse power is more linear than in the case of PL. Furthermore the pulse phases is more stable.

AQ_mod - acquisition mode
• takes one of the values qf, qsim, qseq, DQD
• can be set from eda or by entering aq_mod on the command line
• The values of AQ_mod have the following meaning:

  qf = single channel detection.

  qseq = quadrature detection in sequential mode. Two channels are used, whose reference phase differs by 90°. In the resulting fid, two successive data points have been acquired by different detectors with a time difference of DW.

  qsim = quadrature detection in simultaneous mode. Two channels are used, whose reference phase differs by 90°. In the resulting fid, two successive data points have been acquired simultaneously by the two detectors. The time difference between these points is 2* DW.

  DQD = digital quadrature detection. Simultaneous mode that eliminates quad images and O1 spikes. AQ_mod can only be set to DQD when the parameter DIGMOD is set to digital or homodecoupling digital. When you set DIGMOD to analog, AQ_mod automatically changes to qsim. Furthermore, DQD can only be used up to a certain spectral width as is shown in table 2.6. Above this value, acquisition commands automatically switch the acquisition mode to qsim. In that case, the acquisition parameter AQ_mod = DQD but the acquisition status parameter AQ_mod = qsim. Note that, in order to use DQD, your Avance spectrometer must be equipped with a DQD device on the RCU.

AUNM - name of an acquisition AU program
• takes a character array value
can be set from *eda* or by entering *aunm* on the command line

interpreted by *xaua*

The command *xaua* executes the AU program specified by AUNM. Although this can be any AU program, AUNM is normally used to specify an AU program that performs an acquisition. For example, in several standard parameter sets, AUNM is set to *au_zg*. The command *xaua* can be entered on the command line or called from AU program with its macro XAU.

BF1 - BF8 - basic frequency for frequency channel f1 to f8

- take a double value (MHz)
- are automatically set when NUC1, NUC2 etc. are selected from *edasp*
- When you set up an experiment and define NUC1 in the routing table, BF1 is automatically read from the nucleus table. In the same way, BF2 is automatically read when NUC2 is defined etc. The routing table can be opened with *edasp* or by clicking NUCLEI in *eda*. The nucleus table is created with the command *cf* that can be executed by the NMR Superuser. This command prompts you for the 1H basic frequency and then automatically calculates the basic frequencies for all other nuclei. For each nucleus, *cf* sets the basic frequency such that the most common reference substance for that nucleus would resonate at about 0 ppm. If you want to change the nuclei table, you can do that with the command *ednuc*. This is, for example, necessary if you are using a different reference substance for a certain nucleus. Note, that if you execute cf and change the 1H basic frequency, you must click RESTORE in the nuclei table and execute *cfbsms*, after *cf* has finished.

CNST[0-31] - array of constants used in pulse programs

- takes float values
- can be set from *eda* by clicking *CNST **Array***
- can also be set by entering *cnst0, cnst1* etc. on the command line
- interpreted by the pulse program statements *cnst0, cnst1, cnst2* etc.
- The values of the parameter array CNST can be used as constants in a pulse program. For example, the pulse program line:

  "d2 = ls/cnst2*2"
uses the value of CNST2 as a coupling constant. Note the difference between
the pulse program statement \texttt{cnst2} and the XWIN-NMR command \texttt{cnst2}.
The latter is actually not a command but a way of setting the value of
CNST[2].

\textbf{CPDPRG1 - CPDPRG8 - names of CPD programs}

- take a character string value
- can be set from \texttt{eda} by entering a name or by clicking the down arrow and
then selecting a CPD program from the appearing list
- can also be set by entering \texttt{cpdprg1}, \texttt{cpdprg2} etc. on the command line
- interpreted by the pulse program statements \texttt{cpd1 - cpd8}, \texttt{cpds1 - cpds8}
and \texttt{cpdngs1 - cpdngs8}
- The values of CPDPRG1 - CPDPRG8 are the names of composite pulse
decoupling (CPD) programs. The pulse program statements \texttt{cpd1} executes
the CPD program defined by CPDPRG1, \texttt{cpd2} executes the CPD program
defined by CPDPRG2 etc. In several Bruker CPD type parameter sets, the
CPD program is specified by CPDPRG2 and executed on frequency channel
\texttt{f2}. For example, the parameter set \texttt{C13CPD} contains the following settings:

\begin{verbatim}
CPDPRG2 = waltz16
PULPROG = zgpg30
\end{verbatim}

and the pulse program \texttt{zgpg30} contains the following line:

\begin{verbatim}
d1 cpd2:f2
\end{verbatim}

The statements \texttt{cpd3} and \texttt{cpd4} which execute the CPD programs specified
by CPDPRG3 and CPDPRG4, respectively, are often used in 3D experi-
ments. Note, however, that the \texttt{cpd1 - cpd8} commands are equivalent and
can be used to run any CPD program on any frequency channel.

\texttt{cpds1} works like \texttt{cpd1}, except that it will execute the CPD program syn-
chronously with the pulse program. This means \texttt{cpds1} always starts the CPD
program at the beginning, whereas \texttt{cpd1} continues the CPD program where
it was last stopped by the \texttt{do} statement. The difference between \texttt{cpds2} and
\texttt{cpd2}, \texttt{cpds3} and \texttt{cpd3} etc. is equivalent.

\texttt{cpdng1} works like \texttt{cpd1}, except that the transmitter gate for channel \texttt{f1} will
not be opened. \texttt{cpdngs1} works like \texttt{cpds1}, except that the transmitter gate
for channel \texttt{f1} will not be opened. For the channels \texttt{f1}, \texttt{f2} etc. the statements
\texttt{cpdng2}, \texttt{cpdng3} etc are available. The \texttt{cpdng*} and \texttt{cpdngs*} statements are
available for Avance-AQX but not for the Avance-AQS.

The list of CPD programs which appears when you click the down arrow in eda, contains both Bruker and user defined CPD programs. Bruker CPD programs must be installed, once, with expinstall. You can set up your own CPD programs with the command edcCPU.

D[0-31] - array of delays

- takes float values (seconds)
- can be set from eda by clicking $D**array**$
- can also be set by entering $d0, d1, d2$ etc. on the command line
- interpreted by the pulse program statements $d0 - d31, id0 - id31, dd0 - dd31, rd0 - rd31$

- The pulse program statement $d0$ causes a delay of $D0$ seconds, $d1$ causes a delay of $D1$ seconds etc. In principle, all delays can be used for any purpose. In Bruker pulse programs, however, some conventions are followed. These are listed in the file Param.info that can be viewed with edpul. For example, $D1$ is used as a relaxation delay, $D0$ is used in combination with $IN0$ and $ND0$ as incrementable delay in 2D experiments. $D0$ and $D10$ are used as incrementable delays in 3D experiments. Note however, that all delays $D1 - D31$ are incrementable, not only $D0$ and $D10$. For more information click:

  Help → Other Topics → Writing pulse programs

DDR - digital digitizer resolution

- takes an integer value
- temporary parameter calculated according to the equation:

$$DDR = 2^\log(DECIM) + 1$$

- cannot be set by the user
- DDR expresses the enhancement of the digitizer resolution by digital filtering. The total digitizer resolution, as defined by DR, is the sum of the hardware resolution (see table 2.2) and DDR.

DE - pre-scan delay

- takes a float value (microseconds)
- can be set from eda or by entering de on the command line
DE is executed as a part of the go statement. On Avance-AQX spectrometers, DE consists of 5 pre-scan subdelays DEPA, DERX, DE1, DE2 and DEADC. These subdelays start simultaneously at the beginning of DE and after each subdelay a certain action is performed:

DEPA: the preamplifier is switched from transmit to observe mode (default 2 µsec)
DERX: the receiver gate is opened (default 3 µsec)
DE1: the intermediate frequency (if required) is added to the frequency of the observe channel. This corresponds to the execution of the syrec statement (default 2 µsec). The intermediate frequency is only used for AQ_mod = DQD or, if your spectrometers has an RX22 receiver, for any value of AQ_mod.
DE2: the phase of the receiver is set to zero (default 1 µsec)
DEADC: the digitizer is enabled (default 4 µsec)

Note that sub-delay DE2 is used on Avance-AQX but not on Avance-AQS.

DE can be set from eda or from the command line. The subdelays can be set with the command edscon. Their maximum value is DE - 1 µsec. On Avance-AQS, the DE2 does not exist.

After DE, the digitizer starts to sample the data points.

For DIGMOD = analog, the parameter DE has a different purpose. It is used to achieve a near zero first order phase correction of the spectrum. In this case, DE does not consist of the above subdelays and is automatically adjusted when SW or DW are changed.

DECIM - decimation factor of the digital filter

- takes an integer value
- cannot be set by the user
- Avance spectrometers use the concept oversampling which means that the data points are sampled much faster than specified by DW. This results in a larger number of points than specified by the user; a multiple of TD. Before the data are written to disk, they are digitally filtered which reduces (decimates) their number to TD. The decimation factor is defined by the following equation:
DECIM = DW/DWOV

where DWOV is the oversampling dwell time. Note that DECIM can only take an integer value and DWOV must be greater than the minimum value for the current digitizer (see table 2.2). See also the acquisition status parameter DECIM.

DIGMOD - digitizer mode

- takes one of the values analog, digital, homodecoupling-digital
- can be set from eda or by entering digmod on the command line
- In most standard parameter sets, DIGMOD is set to digital which means that oversampling and digital filtering is used. Oversampling means that the data points are sampled much faster that specified by DW. This results in a larger number of points than specified by the user; a multiple of TD. Before the data are written to disk, they are digitally filtered during which their number is reduced (decimated) to TD. For homodecoupling experiments on a Avance-AQX spectrometers, DIGMOD must be set to homodecoupling-digital. Digital filtering is then switched on but the amount of oversampling is smaller (a larger DWOV is used). For homodecoupling experiments on Avance-AQS spectrometers, DIGMOD must be set to digital because the reduction of the oversampling rate is not necessary. For DIGMOD = analog, digital filtering is switched off and analog filters are used. In that case, your Avance spectrometer works like a AMX/ARX spectrometer. However, since only a limited number of analog filter values is available for Avance, setting DIGMOD to analog is not recommended.

DIGTYP - digitizer type

- takes one of the values listed in table 2.2.
- can be set from eda or by entering digtyp on the command line
- DIGTYP must be set to the value which corresponds to the digitizer in your spectrometer. If you enter digtyp on the command line, you can choose from all digitizers which are available for Bruker spectrometers. However, if you click on DIGTYP in eda, only the digitizer(s) which exist in your spectrometer will appear. If you start your experiment with a Bruker standard parameter set (read with rpar), DIGTYP is usually set to the correct value. This is the value that was entered during the installation of the parameter sets with expinstall. If your spectrometer contains more than one digi-
tizer, you might want to change the default value of DIGTYP. Note that the SADC digitizer cannot be used for sequential acquisition (AQ_mod = qseq).

<table>
<thead>
<tr>
<th>digityp</th>
<th>digitizer resolution (bit)</th>
<th>DWOV range (microseconds)</th>
</tr>
</thead>
<tbody>
<tr>
<td>FADC (BC133)</td>
<td>12</td>
<td>0.05</td>
</tr>
<tr>
<td>HADC (HRD16)</td>
<td>16</td>
<td>2.5 - 5.0</td>
</tr>
<tr>
<td>SADC</td>
<td>16</td>
<td>3.325 - 6.65</td>
</tr>
<tr>
<td>HADC+</td>
<td>16</td>
<td>2.5 - 5.0</td>
</tr>
<tr>
<td>SADC+</td>
<td>16</td>
<td>3.325 - 6.65</td>
</tr>
<tr>
<td>IADC</td>
<td>16</td>
<td>0.1/0.05</td>
</tr>
</tbody>
</table>

Table 2.2

DQDMODE - sign of the frequency shift during digital quadrature detection

- takes one of the values add or subtract
- can be set from eda or by entering 1 dqdmode on the command line
- DQDMODE defines the frequency shift applied in Digital Quadrature Detection mode as positive (add) or negative (subtract).

DR - digitizer resolution

- takes an integer value
- DR is the sum of the hardware resolution (see table 2.2) and the digital digitizer resolution DDR. It is automatically set to the maximum resolution of the current digitizer (DIGTYP). Because Avance spectrometers use the principle of oversampling, this value can be higher than the resolution of the digitizer.

Usually, you want to use maximum resolution and keep this value of DR. In some cases, however, it is useful to set DR to a lower value. For example, if you want to acquire a large number of scans which might cause overflow for the maximum value of DR. However, to solve this problem, you can also set the parameter OVERFLW to check to halt the acquisition as soon as data overflow would occur.

DS - number of dummy scans

- takes an integer value
interpreted by the pulse program statement \( go=n \), \( gonp=n \) and \( rcyc=n \)

- can be set from **eda** or by entering **ds** on the command line

- Dummy scans are scans during which no fid is accumulated. Other than that, they are identical to normal scans, which means they take the same time (AQ) and perform phase cycling. Dummy scans are used to reach steady state conditions concerning T1 relaxation. This is necessary whenever the recycle delay of the experiment is shorter than 4 times the T1 value of the measured nucleus. Furthermore, they are used to establish a stable temperature. This is especially important in decoupling and TOCSY experiments where the irradiation high power increases the sample temperature. Dummy scans are performed if \( DS > 0 \) and the pulse program contains a \( ze \) statement before the \( go=n \) or \( rcyc=n \) loop. If a \( zd \) is used instead of \( ze \), dummy scans are omitted.

**DSLIST** - dataset list

- takes a character array value
- can be set from **eda** by entering a name in the **DSLIST** field or by clicking the down arrow and selecting a name from the appearing list. Note that this list also contains the entry **EDIT CURRENT** which allows you to edit the currently defined dataset list.
- can also be set by entering **dslist** on the command line
- interpreted by the pulse program statements: \( wr \#n, wr \##, ifp, dfp, rfp \)

- **DSLIST** defines the name of a variable dataset list. Such a list can be created with **edlist → ds** and has the following format:

  ```plaintext
  sucrose 1 1 C:\ guest new
  sucrose 2 1 C:\ guest new
  fructose 1 1 D:\ guest old
  ```

  where the option **new/old** is used to delete/keep a possibly existing dataset.

The list defined by **DSLIST** is interpreted by pulse program statements:

- \( wr \#\# \) - stores the data in the dataset defined at the current list position
- \( wr \#n \) - stores the data in the dataset defined at list position \( n \)
- \( ifp \) - increments the dataset list position
- \( dfp \) - decrements the dataset list position
- \( rfp \) - resets the dataset list position

where \( n = 1,2,3 \) etc.
DSPFIRM - firmware used for digital filtering
- takes one of the values sharp, medium, smooth, user_defined
- can be set from eda
- DSPFIRM defines the filter function used for digital filtering. This determines the maximum spectral width that can be used. For high resolution experiments, DSPFIRM is usually set to sharp. The values medium and smooth are used for other applications. Note that smooth cannot be used for AQ_MOD = DQD. For DSPFIRM = user-defined, an external file is read from xwinmnhome/exp/stan/nmr/lists/DSPFIRM.

DW - dwell time
- takes a float value
- can be set from eda or by entering dw on the command line
- temporary parameter, calculated from the equation:
  \[ DW = \frac{10^{6}}{2 \times SW \times SFO1} \]
- The dwell time is the time between the acquisition of two successive data points. Although it is normally calculated from SW, you can also set dw. In that case, the spectral width is adjusted according to the equation:
  \[ SW = \frac{10^{6}}{2 \times (0.05 + DW) \times SFO1} \]
- When you set DW, you will often notice that the value you enter is slightly adjusted. The reason is that, when oversampling is used, the relation
  \[ DW = DWOV \times DECIM \]
  must be fulfilled and DECIM can only take integer values.

DWOV - oversampling dwell time
- cannot be set by the user
- automatically set according to DIGTYP and DW
- has a minimum value which depends on the digitizer (see table 2.2)
- The parameter DWOV reflects the principle of oversampling. This is used when DIGMOD = digital and means that the data are sampled much faster than specified by the user. In other words, a data point is sampled every DWOV \( \mu \text{s} \) rather than every DW \( \mu \text{s} \) where DWOV is only a fraction of DW. DWOV is set to the minimum value that can be handled by the digitizer or
DSP-firmware (see table 2.2). Actually the value of DWOV is often a little above the minimum because the following relation must be fulfilled:

\[ \text{DWOV} = \frac{\text{DW}}{\text{DECIM}} \]

Here, DECIM is the decimation factor that can only take integer values. For DIGMOD = analog (oversampling/digital filtering is switched off), DECIM is automatically set to 1 and DWOV is set to the value of DW.

**EXP** - experiment performed
- takes a character array value
- is set by ICON-NMR
- ICON-NMR sets EXP to the value of the parameter set that was used for the experiment.

**FCUCHAN[0-8]** - routing between logical frequency channels and FCU’s
- array of integer values
- can be set from `eda` but is normally set graphically from the `edasp` window (see this command for more information)
- The values of FCUCHAN define the relation of the FCU’s to the logical frequency channels. For example, FCUCHAN[1] = 2 means that FCU 2 is used for logical channel f1.

**FnMODE** - Acquisition mode of the indirect dimensions (2D and 3D)
- takes one of the values described below
- for 2D data, it can be set with `eda` or by entering `1 fnmode`
- for 3D data, it can be set with `eda` or by entering `2 fnmode` (F2 dimension) or `1 fnmode` (F1 dimension)
- interpreted by the pulse program statement `mc`

The parameter FnMODE is available in XWIN-NMR 3.0 and newer. It defines the acquisition mode of the indirect dimensions in a multi-dimensional experiment. The use of the `mc` statement and the FnMODE parameter, simplifies the switching of the acquisition mode and allows you to use the same pulse program for various experiments. For this reason, the number of Bruker pulse in XWIN-NMR 3.0 could be reduced compared to previous versions.

FnMODE can take the following values:
**XWIN-NMR parameters**

undefined
this value must be used if the pulse program contains no \texttt{mc} statement.

\textit{QF}
succeeds fids are acquired with incrementing time interval without changing any phase program. This corresponds to the \texttt{mc} clause F1QF or F2QF.

\textit{QSEQ}
succeeds fids will be acquired with incrementing time interval and phases 0 and 90 degrees. This corresponds to the \texttt{mc} clause F1PH or F2PH.

\textit{TPPI}
succeeds fids will be acquired with incrementing time interval and phases 0, 90, 180 and 270 degrees. This corresponds to the \texttt{mc} clause F1PH or F2PH.

\textit{States}
succeeds fids will be acquired incrementing the time interval after every second fid and phases 0 and 90 degrees. This corresponds to the \texttt{mc} clause F1PH or F2PH.

\textit{States-TPPI}
succeeds fids will be acquired incrementing the time interval after every second fid and phases 0,90,180 and 270 degrees. This corresponds to the \texttt{mc} clause F1PH or F2PH.

\textit{Echo-Antiecho}
special phase handling for gradient controlled experiments. This corresponds to the \texttt{mc} clause F1EA or F2EA.

For more information on the \texttt{mc} statement and the use of FNMODE click:

Help → Other Topics → Writing pulse programs

FW - analog filter width
- takes a float value
- can be set from \texttt{eda} or by entering \texttt{fw} on the command line
- FW defines the width of the analog filter. For DIGMOD = digital/homodecoupling-digital, FW is automatically set for maximum oversampling. The value depends on the digitizer type, typically 125000 for HADC/2.

FIDRES - FID resolution
A temporary parameter calculated from the equation:

\[ FIDRES = SW \times SFO1 / TD \]

Although FIDRES is normally calculated from SW, you can also set FIDRES. In that case, TD is adjusted while SW remains the same. Note that the value that you enter for FIDRES is often adjusted a little. The reason is that TD is recalculated according to \( TD = SW \times SFO1 / FIDRES \) and rounded to the nearest power of two. FIDRES is then adjusted to fulfil the same equation.

**FQ1LIST - FQ8LIST** - irradiation frequency lists

- take a character array value
- can be set from **eda** by entering a name or by clicking the down arrow and selecting a name from the appearing list
- can also be set by entering **fq1list, fq2list** etc. on the command line
- interpreted by the pulse program statements \( fq1 \) to \( fq8 \)
- The parameters FQ1LIST to FQ8LIST define the names of frequency lists and are interpreted by the pulse program statement \( fq1 \) to \( fq8 \). For example, the first time \( fq1 \) is executed, the first value in the frequency list defined by FQ1LIST is read. The second time \( fq1 \) is executed, the second value in this list is read etc. At the end of the frequency list, the list position is set back to the first value. Note that \( fq1 \) can be executed multiple times because it occurs on several lines of the pulse program or because it occurs on a line that is part of a loop. In the same way \( fq2 \) reads the list defined by FQ2LIST etc. The \( fq1 \) to \( fq8 \) statements must be preceded with a delay and followed by the frequency channel on which the pulse will be executed, for example:

\[ d1 \ fq2:f2 \]

In Bruker pulse programs, \( fq1 \) is normally used on channel f1, and \( fq2 \) on channel f2 but any combination is allowed. The delay must be greater than 2 \( \mu s \). The frequency lists can be created or modified with the command **edlist**.

**GP031** - gradient parameter table

- takes a list of real values (gradients) and character strings (filenames)
can be set from *eda* by clicking *GP031 edit*

- the gradients are interpreted by pulse program statements `gron0-gron31` and `:gp0-:gp31`
- the filenames are interpreted by pulse program statements `:gp0-:gp31`
- XWIN-NMR allows you to use static gradients and shaped gradients. Static gradients have a constant strength during the time they are on. They are switched on by the pulse program statements `gron0-gron31`. These read the gradient strength for each dimension from the GP031 table. The `groff` command switches the static gradients off. According to table 2.3, the pulse program section

```plaintext
d21 gron2
d22
d23 groff
```

would switch the X, Y and Z gradient on during the time D1+D2 with gradient strengths 75.0, 75.0 and 75.0, respectively. The gradient strength is expressed as a percentage of the maximum strength and runs from -100.0 to 100.0%. Static gradients do not use the `Filename` entry of the GP031 table.

Shaped gradients have a strength that varies in time. They are switched on by the pulse program statements `gp0-gp31`. These interpret the `Filename` field of the gradient table. A file which is defined here contains a list of values between -1 and 1. Each value represents the relative gradient strength for a given time interval. They are multiplied with the values of GPX, GPY and GPZ to give the percentage of the maximum gradient strength for the respective dimension. According to the table 2.3, the statement `p16:gp2` would switch on the X, Y and Z gradient on during the time P16 with gradient strengths 75.0, 75.0 and 75.0, respectively. The strength of each gradient would then vary in time according to the list of values in the file `gradrec5m`. When you

```
<table>
<thead>
<tr>
<th>Index</th>
<th>GPX</th>
<th>GPY</th>
<th>GPZ</th>
<th>Filename</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
<td>50.0</td>
<td>SINE.100</td>
</tr>
<tr>
<td>1</td>
<td>-50.0</td>
<td>-50.0</td>
<td>-50.0</td>
<td>RECT.1</td>
</tr>
<tr>
<td>2</td>
<td>75.0</td>
<td>75.0</td>
<td>75.0</td>
<td>GRADREC5m</td>
</tr>
</tbody>
</table>
```
click the down arrow to the right of each Filename field, a list of available files will appear. Such a list contains both Bruker and user defined gradient files. The former must be installed once with expinstall, with the option Install Library Gradient Files selected. The latter can be created with the Shape Tool (command stdisp). The gradient files reside in the directory:

\textit{xwinnmrhome/exp/stan/nmr/lists/gp}

The gradient parameters can also be set from the keyboard. For example, entering \texttt{gpx2, gpy2, gpz2} allows you to set the gradient strength for the three respective dimensions. With \texttt{gpnam2} you can set the shaped gradient file name.

**GRDPROG** - gradient program name

- takes an ascii string value
- interpreted by the pulse program statement \texttt{ngrad}
- Standard gradient programs are delivered with XWIN-NMR. They must be installed once, with the command \texttt{expinstall} with the option Install Library Gradient Files selected. The \texttt{ngrad} pulse program statement is mainly used on AMX/ARX spectrometers. On Avance systems, the \texttt{gron/groff} are normally used for gradient control. An exception is gradient shimming, where the \texttt{ngrad} statement is used.

**HDDUTY** - homodecoupling duty cycle (in percent)

- takes a float value
- can be set from \texttt{eda} or by entering \texttt{hdduty} on the command line
- HDDUTY describes the ratio between the time used for homodecoupling and the time used for actual signal detection.

**HPMOD** - routing between high power amplifiers and preamplifier modules

- array of integer values
- can be set from \texttt{eda} but is normally set graphically from the \texttt{edasp} window (see this command for more information)

**HPPRGN** - high power preamplifier gain

- takes one of the values \textit{normal} or \textit{plus}
Gain selection for spectrometers equipped with HPPR preamplifiers. By default, HPPRGN is set to normal. The value plus is only used for test purposes and should not be used for experiments.

INP[0-31] - array of increments for pulses P[0-31]
- takes double values (µsec)
- can be set from eda by clicking INP ** array **
- can also be set by entering inp0, inp1, inp2 etc. on the command line
- interpreted by the pulse program statements ipu0 - ipu31 and dpu0 - du31
- The pulse program statement p0 executes a pulse with a length specified by P0. This length can be modified by the following pulse program statements:
  - ipu0 increments the pulse length by INP[0]
  - dpu0 decrements the pulse length by INP[0]
  - rpu0 resets the pulse length to the value of P[0]

In the same way, you can modify the length of the pulses executed by p1 to p31 with INP[1] to INP[31], respectively.

IN[0-31] - array of increments for delays D[0-31]
- takes double values (sec)
- can be set from eda by clicking IN ** array **
- can also be set by entering in0, in1, in2 etc. on the command line
- interpreted by the pulse program statements id0 - id31 and dd0 - dd31
- The pulse program statement d0 causes a delay with a length specified by D[0]. This length can be modified by the following pulse program statements:
  - id0 - increments the delay by IN[0]
  - dd0 - decrements the delay by IN[0]
  - rd0 - resets the delay to the value of D[0]

In the same way, you can modify the length of the delays caused by d1 to d31 with IN[1] to IN[31], respectively.

In 2D dataset, IN[0] and ND[0] play a special role. In eda, they appear as the single parameters IN0 and ND0 in the F1 dimension. They are determined by the following equation:
\[
\text{SW}(F1) = \frac{1}{(SFO1 \times \text{IN0} \times \text{ND0})}
\]

where IN0 is the spectral width and ND0 the number of occurrences of \(d0\) in the pulse program. If you change IN0 or ND0, SW is automatically recalculated. If you change SW, IN0 is recalculated and ND0 remains the same. You can set these parameters in \texttt{eda} or, from the command line, with:

\[
\begin{align*}
\text{in0} & \quad \text{(same as } \text{1in0}) \\
\text{nd0} & \quad \text{(same as } \text{1nd0}) \\
\text{1sw} &
\end{align*}
\]

Note that IN0 and ND0 only exist in the F1 dimension but SW exists in F2 and F1.

In a 3D dataset, IN0 and ND0 play the same role in F1 indirect dimension as they do in the 2D dataset. F1, however, is the third dimension now. For the F2 indirect dimension F2, the parameters IN10 and ND10 are used. In 3D, the following equations hold:

\[
\begin{align*}
\text{SW}(F1) &= \frac{1}{(SFO1 \times \text{IN0} \times \text{ND0})} \\
\text{SW}(F2) &= \frac{1}{(SFO1 \times \text{IN10} \times \text{ND10})}
\end{align*}
\]

You can set these parameters in \texttt{eda} or, from the command line, with:

\[
\begin{align*}
\text{in0} & \quad \text{(same as } \text{1in0}) \\
\text{nd0} & \quad \text{(same as } \text{1nd0}) \\
\text{in10} & \quad \text{(same as } \text{2in10}) \\
\text{nd10} & \quad \text{(same as } \text{2nd10}) \\
\text{1sw} & \\
\text{2sw}
\end{align*}
\]

Note that IN0 and ND0 only exist in F1, IN10 and ND10 only in F2 but SW exists in F3, F2 and F1.

\text{L[0-31]} - array of loop counters

- takes integer values
- can be set from \texttt{eda} by clicking \texttt{L**array**}
- can also be set by entering \texttt{10, 11, 12} etc. on the command line
- interpreted by pulse program statements \texttt{10-131, iu0-iu31, du0-du31 and ru0-ru31}
- The parameters \text{L[0]} - \text{L[31]} are read by the pulse program statements \texttt{10 - 131}. These are mainly used in loop structures like \texttt{10 to x times 10} where
x is a pulse program label; a number or a string which labels a previous line in the pulse program. An example of such a structure is:

```
4 (p1 ph1)
d2...
lo to 4 times 13
```

The loop counter values can be varied as follows:

- `iu0 - iu31` increment the loop counter used 10 - 131 by 1.
- `du0 - du31` decrement the loop counter used 10 - 131 by 1.

Note that these increments and decrements only count during the execution of the current pulse program. They are not stored in the parameters L[0] - L[31]. Furthermore,

- `ru0 - ru31` reset the loop counter used 10 - 131 to L[0] - L[31]

The statements 10 - 131 are also used in if structures (conditions). Two simple conditions are:

```
if "(l3 != 0)" : true if l3 is unequal zero
if "(l3 == 0)" : true if l3 equals zero
```

Further conditions are:

```
if "(l3 operand expression)"
```

where operand can be: `==, !=, >, <, >= or <=` and expression can be a number or an arithmetic expression built from pulses, delays and/or loop counters. The statements effected by a certain condition must be put between curly brackets. Furthermore, you can use the else structure for statements which must be executed if the condition is not true. An example is:

```
if "(l5 > 2)"
{
    p1 ph1
}
else
{
}
```

Note that the syntax of the conditional statements is similar to C language.
syntax. However, you cannot use the C "else if" statement.

**LOCNUC - lock nucleus**

- takes a character string value
- can be set from *eda* by entering a name in the *LOCNUC* field or by clicking the down arrow and selecting a nucleus from the appearing list
- can also be set by entering *locnuc* on the command line
- is interpreted by *edlock, lock, lopo, lopoi, sref*
- High resolution samples are usually locked on 2H or 19F. For these two nuclei, standard lock parameter files are delivered with XWIN-NMR. These can be edited with the command *edlock*.

**MASR - MAS spin rate**

- takes a float value
- can be set from *eda* or by entering *l masr*
- can also be set with the commands *mas* or *masr*
- The MAS spin rate is usually set from the MAS control window which is opened with the command *mas*.

Note that entering *masr* on the command line does not merely set the parameter MASR but starts the XWIN-NMR command *masr*.  

**NBL - number of blocks (of acquisition memory)**

- takes an integer value
- interpreted by the pulse program statements *st, st0, ze, zd, wr, if.*
- The parameter NBL is used to acquire FID’s in multiple memory blocks, for example in NOE difference experiments. For NBL = 1 (the default value), one FID (NS averages) is written to disk at the end of the acquisition. For NBL > 1, multiple FIDs are acquired in the acquisition memory before these are written to disk. The *st* statement increments the memory pointer by TD in order to use the next block. The statement *wr #0* will write NBL FIDs to disk. The following pulse program statements interpret NBL:

  - *st* - increment the memory pointer by TD
  - *wr* - write NBL blocks to disk
  - *st0* - set the memory pointer to the position of the first FID
  - *ze, zd* - clear the acquisition memory of all NBL blocks
XWIN-NMR parameters

iF - increment the file pointer in the raw data file by NBL*TD

cF - decrement the file pointer in the raw data file by NBL*TD

nbl - loop counter specifying the number of blocks

If TD is not a multiple of 256 (1024 bytes), successive FIDs will still begin
at 1024 byte memory boundaries. This is so for the FIDs in the acquisition
memory as well as on disk. The size of the raw data file (ser) is therefore
always a multiple of 1024 times NBL.

ND0 - number of delays D0

- takes an integer value
- temporary parameter
- only used in 2D and 3D datasets in the F1 dimension
- Number of d0 statements in the increment loops of a pulse program for 2D
  or 3D experiments. Used to calculate the spectral width in the F1 dimension
  according to:

\[
SW = 1 / (SFO1 * ND0 * IN0)
\]

ND10 is typically set to 2, if the evolution time contains a 180 degree pulse (e.g. HMQC,
HMBC, HSQC). Otherwise, it is set to 1 (e.g. NOESY, COSY, ROESY, TOCSY).

ND10 - number of delays D10

- takes an integer value
- temporary parameter
- only used in 3D datasets in the F2 dimension
- Number of d10 commands in the increment loops of a pulse program for 3D
  experiments. Used to calculate the spectral width in the F2 dimension
  according to

\[
SW = 1 / (SFO1 * ND10 * IN10)
\]

ND10 is typically set to 2, if the evolution time contains a 180 degree pulse. Otherwise, it is set to 1. Usually this is described in the pulse program com-
ment section.

NS - number of scans

- takes an integer value
interpreted by the pulse program statement \texttt{go=n}, \texttt{gonp=n} and \texttt{rcyc=n}

- can be set from \texttt{eda} or by entering \texttt{ns} on the command line

- The pulse program statements \texttt{go=n} and \texttt{rcyc=n} loop \texttt{NS} times to the line which the label \texttt{n}. In Bruker pulse programs, the label \texttt{n} is usually 2. The acquired data are accumulated in memory. After \texttt{NS} scans, the pulse program continues with the next statement which is often \texttt{wr #0}. This statement writes the accumulated data to disk.

After setting \texttt{NS}, you can calculate the resulting experiment time with the command \texttt{expt}. Then you can adjust \texttt{NS} such that the available time is properly used. Alternatively, you can set \texttt{NS} to a high value and halt the experiment (with the command \texttt{halt}) when time is up (see also \texttt{DS} and \texttt{OVERFLW}).

NUC1 - NUC8 - nucleus for frequency channel f1 - f8

- take a value from a predefined list of nuclei
- can be set from \texttt{eda} by clicking NUCLEI
- can also be set from \texttt{edasp} (same as clicking NUCLEI in \texttt{eda})

The parameter NUC1 assigns a nucleus to the frequency channel f1, NUC2 assigns a nucleus to the frequency channel f2 etc. In most routine experiments, only NUC1, NUC2 and NUC3 are used. For example:

a 1D PROTON experiment without decoupling:

\begin{verbatim}
NUC1 = 1H
NUC2 = off
NUC3 = off
\end{verbatim}

a 1D C13 experiment with 1H decoupling:

\begin{verbatim}
NUC1 = 13C
NUC2 = 1H
NUC3 = off
\end{verbatim}

a 2D 1H experiment with 13C and 15N coupling:

\begin{verbatim}
NUC1 = 1H
NUC2 = 13C
NUC3 = 15N
\end{verbatim}

In 2D datasets, NUC1 in the indirect dimension (F1) must be set explicitly by
clicking F1-NUCLEI in *eda* (see the description of NUCLEI). In 3D datasets, this principle holds for both indirect dimensions, F2 and F1.

Because most Avance spectrometers are equipped with a maximum of four channels, NUC5 to NUC8 are normally unused. Therefore, they appear at the end of the *eda* table.

**NUCLEI** - set up nuclei and spectrometer routing

- appears in *eda* but is not a parameter
- opens the routing table (*edasp*) in 1D, 2D-F2 and 3D-F3
- In 1D and in the 2D and 3D acquisition (= direct) dimension, NUCLEI is not a parameter but a button to open the routing table. From this table, you can assign nuclei to the logical frequency channels of the spectrometer and define the amplifier routing. Clicking NUCLEI in *eda* is the same as entering *edasp* on the command line. In the routing table, you can specify the nucleus or nuclei to be used for the experiment. For the f1 channel, you can click the NUC1 button and select a nucleus from the appearing list. The basic frequency, BF1, is automatically set. Then you can specify the frequency offset; OFSH1 for 1H or OFSX1 for X nuclei. The irradiation frequency SFO1 is automatically calculated as the sum of the basic frequency and frequency offset. Note that the parameters NUC1, BF1 and SFO1 also appear in *eda* but cannot be set from there. However, the frequency offset (OFSH1 or OFSX1) appears in *eda* as O1 and can be set from there. In a multi nuclear experiment, you can set up the parameters for channel f2, f3 etc. in the same way as described for f1.

The NUCLEI table also shows the spectrometer routing. The hardware elements which have been detected when the spectrometer was configured (with *cf* or *config*) will appear in this list. When you select a nucleus for a certain channel, the default routing is automatically set. Normally, this is okay. Only in very special cases it is useful to change it. The routing table consists of the following stages:

Channel---FCU---Amplifier---Swibox/I ---Swibox/O---Preamplifier

You can set up the routing by connecting an element from one stage to an element of the next stage. A connection can be installed or removed by clicking the two elements involved. The routing must follow following rules:

a) Between the logical frequency channels and FCU’s any combination is allowed but only one to one.
b) An FCU can be connected to one amplifier only but an amplifier can be connected to multiple FCU’s. Furthermore, FCU1 can only be connected to the first three amplifiers. FCU2 can only be connected to the first four amplifiers.

c) The first four Amplifiers are automatically connected to Switchbox input in a fixed way. These connections cannot be changed.

d) Between the Switchbox input and Switchbox output, any connection is allowed but only one to one.

e) Between the Switchbox output and the Preamplifier modules, any connection is allowed but only one to one. Make sure that the cables are connected accordingly.

f) The output of the fifth and sixth amplifier must be connected directly to the Preamplifier modules. Any combination is allowed but only one to one and only to Preamplifier modules which are not connected to a Switchbox output.

Avance spectrometers which are used for solid state experiments usually contain high power amplifiers with two output stages:

- a low power output: typically 150 W for 1H or 300 W for X nuclei.
- a high power output: typically 1000 W for 1H or X nuclei

The second output appears as an extra stage in the routing table to the right of the switchbox. If you use the second output stage, the switchbox is always bypassed.

If you make a routing connection which is not allowed, you will get a message that it is illegal. You must remove it before you can save the routing table. Some connections are allowed but not recommended. In that case, you only get a warning.

Two extra switches are available to control the routing:

Preferred preamplifier

toggle between selective and unselective Preamplifier module

Preferred output for 19F

toggle between the 19F and X Switchbox output for 19F nucleus

Note that changing these settings changes the default routing. When you change these settings, you must click the DEFAULT button to make them ef-
At the bottom of the NUCLEI table you will find the following buttons:

SAVE - save the parameters and routing and quit

SWITCH F1/F2 - exchange the F1 and F2 nucleus including the frequency and frequency offset

SWITCH F1/F3 - exchange the F1 and F3 nucleus including the frequency and frequency offset

DEFAULT - set the default amplifier routing for the current nuclei

CANCEL - quit without saving any changes

PARAM - shows the routing parameters

In a 2D dataset, NUCLEI has a different function in the two dimensions. In F2, it works like in 1D experiments; it opens the routing table. In F1, it opens the nuclei list and allows you to select the nucleus for this dimension. The same principle holds for 3D data; in F3, NUCLEI opens the routing table, in F2 and F1 it opens the nuclei list.

The spectrometer routing is stored under the current dataset in the acquisition parameters FCUCHAN, RSEL, SWIBOX, PRECHAN and HPMOD (see the description of these parameters). These can be viewed by clicking the PARAM button in the routing table. Note that these parameters appear in eda and can be set from there. This, however, is not very common as setting them from the routing table is much more convenient. In Bruker parameter sets (see rpar), the routing parameters have been set according to the configured hardware. This corresponds to the routing that will be set by clicking the default button in the routing table.

O1 - O8 - irradiation frequency offset for frequency channel f1 - f8 in Hz

- take a double value (Hz)
- can be set from eda or by entering o1, o2 etc. on the command line
- can also be set from edasp by adjusting OFSH1, OFSX1, OFSH2 etc.
- can also be set from gs by adjusting Offset (FID display)
- O1 - O3 can be set by clicking utilities → O1, O2, O3 (spectrum display)
- O1 can be set by clicking utilities → sw-sfo1 (spectrum display)
The parameter O1 represents the irradiation (carrier) frequency offset. It is the center of the spectral region to be acquired. O1 is related to the basic frequency and the carrier frequency according to:

\[ O1 = SFO1 - BF1 \]

The button `sw-sfo1` in the `utilities` menu can be used if you are setting up your experiment from an existing spectrum. It sets O1 to the center of the currently displayed spectral region. The buttons O1, O2 and O3 put the cursor on the spectrum. You can then set the corresponding frequency offset by moving the mouse and clicking the middle mouse button on a certain position. Because most Avance spectrometers are equipped with a maximum of four channels, O5 to O8 are normally unused. Therefore, they appear at the end of the `eda` table. See also O1P-O8P.

O1P - O8P - irradiation frequency offset for frequency channel f1 - f8 in ppm

- take a double value (ppm)
- temporary parameters calculated from the equations:
  \[ O1P = O1/BF1 \]
  \[ O2P = O2/BF2 \]
- can be set from `eda` or by entering `o1p`, `o2p` etc. from the command line
- can be set by setting O1 - O8 (see these parameters)
- The parameter O1P represents the irradiation (carrier) frequency offset in ppm. Because chemical shift values are expressed in ppm, it is usually more convenient to set O1P rather than O1.

OVERFLW - data overflow check

- takes one of the values `check` or `ignore` (default is `ignore`)
- can be set from `eda` or by entering `l overflw` on the command line
- For OVERFLW = `check`, acquisition commands check for possible data overflow. Note that for OVERFLW = `check`, the performance of the spectrometer RCU is decreased and the smallest possible dwell times cannot be used any more. Thus, if no overflow is to be expected, you should set OVERFLW to `ignore`.

P[0-31] - array of pulse lengths

- takes float values (µseconds)
• can be set from **eda** by clicking **P ** array **

• can also be set by entering **p0, p1, p2** etc. on the command line

• interpreted by the pulse program statements **p0 - p31, ipu0 - ipu31, dpu0 - dpu31, rpu0 - rpu31**

• The pulse program statement **p0** executes a pulse of **P[0] µseconds**, **p1** executes a pulse of **P[1] µseconds** etc. In principle, all pulses can be used for any purpose. In Bruker pulse programs, however, certain conventions are used. You can view the file that contains these conventions by entering the command **edpul param.info**

**PARMODE** - dimensionality of the raw data

• takes one of the values 1D, 2D or 3D

• interpreted by **zg, rpar** and by all processing commands which access raw data (see Processing Reference Manual)

• The parameter PARMODE defines the dimensionality of the raw data. 1D, 2D or 3D. It is interpreted by acquisition commands like **zg** and cross checked with the current pulse program. If the dimensionality of PARMODE and the pulse program are different, a warning will appear. If you want, you can still continue the acquisition.

PARMODE is also interpreted by processing commands which access the raw data. If, for example, you enter **ft** on a 1D dataset, it is simply Fourier transformed. If however, you enter **ft** on a 2D dataset, you are first prompted to enter the FID number you want to Fourier transform. Processing commands which access processed data, like **abs**, interpret the processing parameter **PPARMOD** rather than the acquisition parameter PARMODE.

If you change PARMODE and set it to a lower dimension, the unnecessary files are deleted. For example, if you change it from 2D to 1D the files **acqu2** and **proc2** are deleted. However, you are warned before this actually happens and you have the possibility of keeping all files.

If you enter **rpar** to read a parameter set with a different dimensionality then the current dataset, a warning about this will appear. If you click OK, the data files and superfluous parameters files will be deleted. However, if you enter **rpar** with two arguments on the command line, i.e. **rpar <name> <type>**, this will happen without a warning. The reason is that **rpar** is often used in automation.
PHCOR[0-31] - array of correction angles for phase programs

- takes float values (degrees)
- can be set from **eda** by clicking *PHCOR ** array ***
- can also be set by entering *phcor0, phcor1* etc. on the command line
- interpreted by the pulse program statements *ph0:r - ph31:r*
- The option :r after a phase program statement in a pulse program adds phase correction factor to the phase. For example, the statement:

```
pl ph8:r
```

executes a pulse with the current phase from phase program ph8 plus the value of PHCOR[8] For ph8 = 0 1 2 3 and PHCOR[8] = 2, the phase cycle would be 2 92 182, 272 degrees.

PCPD[1-8] - array of CPD pulse lengths

- takes float values (µsec)
- can be set from **eda** by clicking *PCPD ** array ***
- can also be set by entering *pcpd1, pcpd2* etc. on the command line
- interpreted by the CPD program command *pcpd*
- The PCPD parameters represent pulse lengths for CPD decoupling. They are interpreted by the CPD command *pcpd*. Which PCPD pulse is used depends on the frequency channel on which the CPD program runs. For example, the pulse program statement:

```
d1 cpd2:f2
```

runs the CPD program defined by CPDPRG2 on channel f2. Therefore, a *pcpd* command in this CPD program will execute a pulse of length PCPD[2].

Note that the element PCPD[0] exists but cannot be used because there is no channel that corresponds to it.

PH_ref - receiver phase correction

- takes a float value (degrees)
- interpreted by the pulse program statement *go=n phxx:r*
- PH_ref adds a value to the receiver phase. For example, the pulse program statement:

```
go=2 ph30:r
```
starts the acquisition with receiver phase:

\[ \text{ph30 + PH\_ref} \]

The AU program \textit{phtran} calculates the value of PH\_ref for a 2D dataset from the spectrum phase correction values of a 1D row (for more information, type \textit{edau phtran} and view the header of the AU program).

\textbf{PL[0-31]} - array of power levels

- takes float values (dB)
- can be set from \textit{eda} by clicking \textit{PL** Array**}
- can also be set by entering \textit{pl0, pl1} etc. on the command line
- can also be set from the \textit{gs} dialog window
- interpreted by the pulse program statements pl0, pl1, pl2 etc.

The power levels PL[0] to PL[31] can be used to set the power for the frequency channels. The default power for channel fn is PL[n] (PL[1] for f1, PL[2] for f2 etc.) You can, however, explicitly assign a certain power level to a certain channel in the pulse program. For example, the pulse program statements:

\begin{align*}
\text{pl1: f2} \\
\text{pl3: f4}
\end{align*}

set the power of channel f2 to PL[1] and the power of channel f4 to PL[3]

Note the difference between the pulse program statement \textit{pl1} and the command \textit{pl1} entered on the XWIN-NMR command line. The latter is not really a command but simply a way to set the parameter PL[1]. The parameters PL[0-31] can also be used to set the power of hard or shaped pulses in CPD programs. For example, the CPD program statement:

\begin{align*}
\text{p31: sp1: 180, pl=pl1}
\end{align*}

sets the power of the shaped pulse sp1 to PL[1].

\textbf{POWMOD} - power mode

- takes one of the values \textit{low, high or linear}
- POWMOD defines the power mode for spectrometers equipped with a high power accessory. The value \textit{linear} is unused.

\textbf{PRECHAN} - routing between Switchbox outputs and Preamplifier modules

- array of integer values
can be set from *eda* but is normally set graphically from the *edasp* window (see this command for more information)

- The values of PRECHAN define the connection between the switchbox outputs and the HPPR preamplifier modules. For example:
  
  \[
  \begin{align*}
  &\text{PRECHAN}[1] = 0 : \text{Output 1 is connected to HPPR module 0} \\
  &\text{PRECHAN}[3] = 1 : \text{Output 3 is connected to HPPR module 1} \\
  &\text{PRECHAN}[1] = 2 : \text{Output 1 is connected to HPPR module 2} \\
  &\text{PRECHAN}[2] = 3 : \text{Output 2 is connected to HPPR module 3}
  \end{align*}
  \]

  For a standard HPPR configuration the module number correspond to the following units: 0 = 2H, 1 = X-BB, 2=1H, 3=User-Box and 4 = 19F. For more information on the HPPR preamplifier see the BASH spectrometer documentation.

**PROSOL** - copy prosol parameters to corresponding acquisition parameters

- takes one of the values *true* or *false*
- is not a parameter but a push button in the *eda* dialog box
- Clicking the PROSOL button causes the prosol parameters to be read and copied to the corresponding acquisition parameters. As such, clicking PROSOL is equivalent to entering \texttt{getprosol} on the command line. The value of PROSOL indicates whether or not the prosol parameters have been copied, either by clicking PROSOL or running \texttt{getprosol}. Note that the \texttt{getprosol} command is automatically performed by ICON-NMR and \texttt{buttonmr}. Prosol parameters can be set up with the \texttt{edprosol} command. This is usually done once, after the installation of a new version of XWIN-NMR. The default relations between prosol and acquisition parameters are listed in table table 7.1.

**PRGAIN** - high power preamplifier gain

- takes one of the values *low* or *high*
- Gain selection for spectrometers equipped with MSL preamplifiers. Normally, PRGAIN is set to *high*. The value *low* is only used for very strong NMR signals.

**PULPROG** - pulse program used for the acquisition

- takes a character string value
can be set from **eda** by entering a name or by clicking the down arrow and selecting a pulse program from the appearing list. This list contains the entry **EDIT CURRENT** that allows you to edit the currently defined pulse program

- can also be set by entering **pulprog** on the command line
- also set by the command **edcproj <name>**

  Acquisition commands run the pulse program defined by PULPROG. If you set the pulse program in **eda**, you can click the down arrow to the right of the PULPROG field. A list of Bruker and user defined pulse programs will appear and you can click the one you need. Note that Bruker pulse programs must be installed once with **expinstall**. If you start your experiment by reading a standard parameter set (with **rpar**), PULPROG is usually set to the appropriate pulse program.

**QNP** - QNP nucleus selection

- takes one of the values 1, 2 or 3
- If the current probehead is set to a QNP probe (see **edhead**), acquisition commands will interpret the parameter QNP to switch the probe to the correct nucleus. QNP is a normally set with the AU program **qnpset**. Type **edau qnpset** to view this AU program.

**RECCHAN[0-15]** - array of receiver channels

- takes integer values
- can be set from **eda** by clicking **RECCHAN **Array **
- only used on Avance-AQS spectrometers
- **RECCHAN** enables the use of a different FCU than routed with **edasp** to generate the observe reference frequency. As such, the delay for the 22 MHz switching can be skipped.

**RG** - receiver gain

- takes an integer value
- RG controls the amplitude of the FID signal before it enters the digitizer. It is usually determined automatically with the command **rga**. This command performs an automatic determination of the optimum receiver gain. It runs several acquisitions with varying receiver gain until the maximum value is found that does not cause overflow. The parameter RG is then set to this value and depends on the receiver system of your spectrometer. If the RG
value is already known from previous experiments, it can be set from `eda` or by entering `rg` on the command line. `rg` can also be set from `gs`.

**RO** - sample rotation frequency in Hz

- takes an integer value
- can be set from `eda` or by entering `1 ro` on the command line
- interpreted by `ro acqu`
- The command `ro acqu` will set sample rotation to the value of RO. It will wait for 60 seconds and then check if the specified rate has been reached. If this is not the case, an error message is displayed.

Note that RO can be set by entering `1 ro` on the command line but not by entering `ro`. The latter would start the command `ro`.

**RSEL** - routing between FCU’s and amplifiers

- array of integer values
- can be set from `eda` but is usually set graphically from the `edasp` window (see this command for more information)
- The values of RSEL define the connections between the FCU’s and the amplifiers. For example:
  
  \[
  \text{RSEL}[1] = 2 : \text{FCU 1 is connected to amplifier 2} \\
  \text{RSEL}[2] = 0 : \text{FCU1 is not connected to any amplifier} \\
  \text{RSEL}[0] \text{ is unused}
  \]

**SEOUT** - SE 451 receiver unit output to be used

- takes one of the values `HR` or `BB`
- This parameter is only used on DMX spectrometers with an SE451 receiver. This parameter is normally set to `HR`.

**SFO1 - SFO8** - irradiation (carrier) frequencies for channels f1 to f8

- take a double value (MHz)
- are automatically calculated from the equation:

  \[
  \text{SFO1} = BF1 + O1 \\
  \text{SFO2} = BF2 + O2 \\
  \text{etc.}
  \]

  where O1, O2 etc. are set from `edasp` or `eda`
Xwin-NMR parameters

- can also be set with gs by adjusting Frequency (FID display)
- SFO1 can be set by clicking utilities \( \rightarrow \) sw-sfo1 (spectrum display)
- The parameter SFO1 represents the irradiation (carrier) frequency for channel f1. It is usually set from the by defining the nucleus and frequency offset for channel f1 in the routing table (opened with edasp).

SP07 - shaped pulse parameter table

- can be set from eda by clicking SP07 edit
- allows you to set power level, frequency offset, phase alignment and filename for 32 shaped pulses.
- interpreted by pulse program statements like sp0 - sp31
- When you open eda and click on SP07 edit, a list of shaped pulse parameters will appear as displayed in table 2.4.

### Table 2.4

<table>
<thead>
<tr>
<th>Index</th>
<th>Power[dB]</th>
<th>Offset-Freq</th>
<th>Phase-Align</th>
<th>Filename</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1.0</td>
<td>0.0</td>
<td>0.5</td>
<td>Gauss</td>
</tr>
<tr>
<td>1</td>
<td>20.0</td>
<td>0.0</td>
<td>0.5</td>
<td>Sinc1.1000</td>
</tr>
<tr>
<td>2</td>
<td>120.0</td>
<td>0.0</td>
<td>0.55</td>
<td>Q3.1000</td>
</tr>
<tr>
<td>3</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

The table has 32 entries (index 0-31) which are interpreted by the pulse program statements sp0 - sp31. These occur on pulse program lines like:

```plaintext
p1:sp2:f1
```

This line interprets entry 2 of the table and execute a Q3.1000 shaped pulse on channel f1 with length P1, Power 120.0, Offset 0.0 and Phase 0.55. When you click the down arrow to the right of a Filename entry, a list of available shape files will appear. This lists contains both Bruker and user defined shape files. The former must be installed once with expinstall. The latter can be created with the Shape Tool (command stdisp).

The SP07 entries are also available as acquisition parameters. They do not appear individually in eda but they can be set from the command line (see table 2.5)
They also appear as acquisition status parameters when you enter **dpa**.

**SOLVENT** - the sample solvent

- takes a character string value
- can be set from **eda** by entering a name or by clicking the down arrow and selecting a solvent from the appearing list
- can also be set by entering **solvent** on the command line
- interpreted by **getprosol** and ICON-NMR automation
- also interpreted by **lock -acqu, lopo** and **sref**
- The parameter SOLVENT must be set to the name of the solvent used in the current sample. Some acquisition parameters like pulse length and power level are dependent on the probehead and the solvent. The command **getprosol** interprets SOLVENT and PROBEHD and sets all dependent parameters accordingly. These parameters must be defined once, with **edprosol**, for all probeheads and solvents. After **getprosol** has been done, the **eda** parameter PROSOL is set to TRUE. In ICON-NMR automation, **getprosol** is automatically performed after a standard experiment has been read.

**SW** - spectral width in ppm

- takes a double value (ppm)
- can be set from **eda** or by entering **sw** on the command line
- SW can be set by clicking **utilities → sw-sfo1**
- The spectral width should be set to such a value that all relevant peaks are expected to fall within that range. This means, for an unknown sample, SW should be set to a large value, like 50 ppm for a proton spectrum. The spectral width determines the dwell time according to the following equation:

<table>
<thead>
<tr>
<th>Description</th>
<th>Acquisition parameters</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>power level</td>
<td>SP[0-31]</td>
<td><strong>sp0 - sp31</strong></td>
</tr>
<tr>
<td>frequency offset</td>
<td>SPOFFS[0-31]</td>
<td><strong>spoffs0 - spoffs31</strong></td>
</tr>
<tr>
<td>phase alignment</td>
<td>SPOAL[0-31]</td>
<td><strong>spoal0 - spoal31</strong></td>
</tr>
<tr>
<td>file name</td>
<td>SPNAM[0-31]</td>
<td><strong>spnam0 - spnam31</strong></td>
</tr>
</tbody>
</table>

Table 2.5
DW = 1/(2*SW*SFO1)

where DW is expressed in µsec.

When you enter a certain value for SW, you may notice that it is slightly adjusted by XWIN-NMR. The reason is that the digitizer hardware can only handle discrete values of DW. For DIGMOD = digital/homodecoupling-digital, the maximum allowed spectral width depends on the digitizer, the acquisition mode and the DSP firmware (see table 2.6 and 2.7).

SW can also be set interactively by clicking the sw-sfo1 button in the 1D utilities menu. This will set SW to the region currently displayed on the screen. It will also set SFO1 to the frequency of the center of that region. For 2D and 3D experiments, SW as it is described above corresponds to the width in the acquisition dimension. In the indirect dimensions, the spectral width are calculated from the parameters IN0, IN10, ND0, and ND10. In 2D, the following relations count:

\[
\begin{align*}
SW(F1) &= 1/(SFO1*ND0*IN0) \\
SWH(F1) &= 1/(ND0*IN0)
\end{align*}
\]

In 3D, the following relations count:

\[
\begin{align*}
SW(F2) &= 1/(SFO1*ND10*IN10) \\
SWH(F2) &= 1/(ND10*IN10) \\
SW(F1) &= 1/(SFO1*ND0*IN0) \\
SWH(F1) &= 1/(ND0*IN0)
\end{align*}
\]

SWH - spectral width in Hz
- takes a double value
- can be set from eda or by entering swh on the command line
- is related to SW according to the following equation:

\[
SWH = SW * SFO1
\]

During experiment setup, SW is usually defined and SWH is automatically calculated from it. The maximum values depend on the digitizer, the acquisition mode and the DSP firmware as it is shown in table 2.6 and 2.7.

Note that SWH is stored in the parameter file acqu as SW_h.

SWIBOX - routing between Switchbox inputs and Switchbox outputs
- array of integer values
can be set from *eda* but is normally set graphically from the *edasp* window (see this command for more information)

- The values of SWIBOX define the connection between the switchbox inputs and switchbox outputs. For example, SWIBOX[1] = 3 means that Input 1 is connected Output 3.

**Table 2.6** Maximum SW (kHz) for AQ_mod = DQD

<table>
<thead>
<tr>
<th>DSPFIRM</th>
<th>Sharp</th>
<th>Medium</th>
</tr>
</thead>
<tbody>
<tr>
<td>FADC</td>
<td>25</td>
<td>100</td>
</tr>
<tr>
<td>HADC</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>HADC+</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>HADC2</td>
<td>25</td>
<td>100</td>
</tr>
<tr>
<td>SADC</td>
<td>18.75</td>
<td>18.75</td>
</tr>
<tr>
<td>SADC+</td>
<td>18.75</td>
<td>18.75</td>
</tr>
<tr>
<td>HRD16</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>IADC</td>
<td>25</td>
<td>100</td>
</tr>
</tbody>
</table>

**Table 2.7** Maximum SWH (kHz) for AQ_mod = qsim

<table>
<thead>
<tr>
<th>DSPFIRM</th>
<th>Sharp</th>
<th>Medium</th>
<th>Smooth</th>
</tr>
</thead>
<tbody>
<tr>
<td>FADC</td>
<td>100</td>
<td>150</td>
<td>200</td>
</tr>
<tr>
<td>HADC</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>HADC+</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>HADC2</td>
<td>100</td>
<td>150</td>
<td>200</td>
</tr>
<tr>
<td>SADC</td>
<td>75</td>
<td>75</td>
<td>75</td>
</tr>
<tr>
<td>SADC+</td>
<td>75</td>
<td>75</td>
<td>75</td>
</tr>
<tr>
<td>HRD16</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>IADC</td>
<td>100</td>
<td>150</td>
<td>200</td>
</tr>
</tbody>
</table>

TD - time domain; number of raw data points
XWIN-NMR parameters

- takes an integer value
- The parameter TD determines the number of raw data points to be acquired. A large value of TD enhances the spectrum resolution, but also increases the acquisition time AQ. TD is usually set to a power of 2, for example 64k for a 1D spectrum. The FID resolution is related to the number of data points according to:

\[
FIDRES = SW \times SFO1 / TD
\]

In a 2D experiment, TD in the acquisition dimension (F2) has the same meaning as in 1D. In the indirect dimension (F1), it represents the number of increments. As such, it is interpreted by pulse program statements like:

\[\text{lo to n times } td1\]

In a 3D experiment, TD in the acquisition dimension (F3) has the same meaning as in 1D. In the indirect dimensions (F2 and F1), it represents the number of increments. As such, they are interpreted by statements like:

\[\text{lo to n times } td1; F1 loop in 2D or 3D experiments}\n\[\text{lo to n times } td2; F2 loop in 3D experiments\]

In XWIN-NMR 3.0 and newer, the statement \[\text{lo to n times } td1\] can be replaced by the \text{mc} statement. Do not confuse this with the XWIN-NMR processing command \text{mc} that performs magnitude calculation.

TD0 - loop counter for multidimensional experiments
- takes an integer value
- interpreted by the pulse program statement \text{td0}
- TD0 is normally used as a loop counter for multiple 1D experiments that are measured under varying conditions (for example varying temperature or pressure) and that are stored as 2D data. Similarly, it can be used for multiple 2D experiments that are stored as 3D data.

TE - demand temperature on the temperature unit
- takes a float value
- can be set from \text{eda} or by entering \text{te} on the command line
- interpreted by \text{teset}
The command `teset` sets the temperature on the temperature unit to the value of TE. It be entered on the keyboard, or called from AU program with its macro TESET.

**V9** - maximum variation of a delay

- takes a float value (between 0.0 and 100.0 percent)
- can be set from `eda` or by entering `v9` on the command line
- interpreted by pulse program statements like `d1:r, p1:r`

The pulse program statement `d1` causes a delay D1. The statement `d1:r`, however, causes a delay D1 plus a random value. As such, the delay is different every time the statement `d1:r` is executed. The parameter V9 specifies, in percent, the maximum amount which is added to or subtracted from D1. As such, the effective delay varies between 0 and 2*D1. The `:r` option can be used for any of the statements `d0 - d31` and `p0 - p31` to vary `D[0-31]` and `p[0-31]`, respectively. Note that the command `gs` ignores the `:r` option.

**VALIST** - variable amplitude (power) list

- takes a character array value
- can be set from `eda` by entering a name or by clicking the down arrow and selecting a name from the appearing list. This list contains the entry `EDIT CURRENT` that allows you to edit the currently defined amplitude list.
- can also be set by entering `valist` on the command line
- interpreted by user defined pulse program statements

The parameter VALIST defines the name of variable amplitude (power) list. Such a list can be created with `edlist va` and has entries like:

```
-6.0
0.0
3.0
6.0
```

that represent attenuation values in dB.

The usage of a VA list is different from pulse and delays lists. You must define the statement by which a VA list is accessed in the pulse program. Such a statement can have any name, for example the name `vanam` is used in the examples below. The suffixes `.inc`, `.dex` and `.res` can be used to increment, decrement and reset the list's position, respectively. Furthermore, the
caret operator (^) allows you to read a list value and increment the list position with one statement. The following pulse program entries illustrate the use of a variable amplitude list:

```plaintext
define list<power> vanam = <$VALIST>
definition of the power list
dl vanam:f2 vanam.dec
set the power to the current value of the list and decrement the index
dl vanam[2]:f3
set the power to the second value of the list
"vanam.idx = vanam.idx + 3"
increment the list index by 3
dl vanam^:f4
set power to the current value of the list increment the index
```

As an alternative to using a list defined by the parameter VALIST, you can explicitly define a variable amplitude (power) list filename or even the list values in the pulse program. The following examples illustrates such definitions:

```plaintext
define list<power> vanam=<my_filename>
define list<power> vanam={10 30 50 70}
```

Note that the second definition does not require a list file. For more information on using variable amplitude lists click:

**Help → Other Topics → Writing pulse programs**

VCLIST - variable counter list

- takes a character array value
- can be set from `eda` by entering a name or by clicking the down arrow and selecting a name from the appearing list. This list contains the entry `EDIT CURRENT` that allows you to edit the currently defined counter list.
- can also be set by entering `vclist` on the command line
- interpreted by the pulse program statements `lotox times c` in `ivc,vcidx`
- The parameter VCLIST defines de name of variable counter list. Such a list can be created with `edlist → vc` and has entries like:
The currently defined list is interpreted by the pulse program statement:

\[ \text{lo to } x \text{ times } c \]

where \( x \) is a pulse program label and \( c \) is the value at the current position of the counter list. When this statement is executed for the first time, the current position is the first entry in the list. The position is incremented by the statement \( \text{ivc} \).

**VDLIST** - variable delay list
- takes a character array value
- can be set from **eda** by entering a name or by clicking the down arrow and selecting a name from the appearing list. This list contains the entry **EDIT CURRENT** that allows you to edit the currently defined delay list.
- can also be set by entering **vdlis** on the command line
- interpreted by the pulse program statements \( \text{vd, ivd and vdidx} \)
- The parameter VDLIST defines the name of variable delay list. Such a list can be created with **edlist → vd** and has entries like:
  
  10m
  50m
  2s

  where m = milliseconds and s = seconds. The currently defined list is interpreted by the pulse program statement \( \text{vd} \) that reads the delay value at the current position. When \( \text{vd} \) is executed for the first time, the current position is the first entry in the list. The position is not incremented by \( \text{vd} \); this is done by the statement \( \text{ivd} \). As such, \( \text{vd} \) is normally used in combination with \( \text{ivd} \). The statement "\( \text{vdidx=n} \)" sets the index to position \( n \) in the list.

**VPLIST** - variable pulse list
- takes a character array value
- can be set from **eda** by entering a name or by clicking the down arrow and selecting a name from the appearing list. This list contains the entry **EDIT CURRENT** that allows you to edit the currently defined pulse list.
- can also be set by entering **vplist** on the command line
• interpreted by the pulse program statements \texttt{vp, ivp} and \texttt{vpidx}

• The parameter VDLIST defines the name of variable pulse list. Such a list can be created with \texttt{edlist \rightarrow vp} and has entries like:

  \begin{align*}
  10u \\
  50m \\
  2s
  \end{align*}

where \(u\) = microseconds, \(m\) = milliseconds and \(s\) = seconds. The currently defined list is interpreted by the pulse program statement \texttt{vp} that reads the pulse length value at the current position. When \texttt{vp} is executed for the first time, the current position is the first entry in the list. The position is not incremented by \texttt{vp}; this is done by the statement \texttt{ivp}. As such, \texttt{vp} is normally used in combination with \texttt{ivp}. The statement \texttt{"vpidx=\$n"} sets the index to position \(n\) in the list. A variable pulse list can only be used for hard pulses, not for shaped pulses or shaped gradients. As an alternative to a VP list, you can also specify a list of pulse values within the pulse program using a \texttt{define} statement. For more information on this topic click:

\textit{Help $\rightarrow$ Other Topics $\rightarrow$ Writing pulse programs}

VTLIST - variable temperature list

• takes a character array value

• can be set from \texttt{eda} by entering a name or by clicking the down arrow and selecting a name from the appearing list. This list also contains the entry \texttt{EDIT CURRENT} which allows you to edit the currently defined temperature list.

• can also be set by entering \texttt{vtlist} on the command line

• interpreted by the AU program macros RVTLIST, VT, IVTLIST, DVTLIST

• The parameter VTLIST defines the name of variable temperature list. Such a list can be created with \texttt{edlist \rightarrow vt} and has the following format:

  \begin{align*}
  300 \\
  320 \\
  340
  \end{align*}

where each entry is a temperature value in Kelvin.

Temperature lists are interpreted by the \texttt{AU program macros}:

\texttt{RVTLIST - open the temperature list defined by VTLIST}
VT - read the current value from the list and set it on the temperature unit
IVTLIST - increment the current position in the list to the next value
DVTLIST - decrement the current position in the list to the previous value

Note that temperature lists are only interpreted by AU program macros, not by pulse program statements.

WBST - number of wobble steps
- takes an integer value between 256 and 4096 (default 256)
- interpreted by `wobb`
- The parameter WBST determines the number of steps (frequencies) used for tuning and matching a probehead (wobbling). A probehead is correctly tuned when the dip of the wobble curve is exactly at the center of the display. Normally, the default value of WBST (256) is high enough for exact tuning. If necessary, you can set WBST to a higher value for a better resolution. Note, however, that the maximum useful value is the screen resolution. Setting WBST to a higher value would not give you any advantage; it would only reduce the refresh rate. The command `atma` automatically calculates the optimum number of steps and does not interpret WBST.

WBSW - wobble sweep width
- takes a double value between 1 KHz and 4 MHz
- can be set from `eda` or by entering `wbsw` from on the command line
- can also be set by clicking `Acquire → Observe fid window → wobb-SW`
- interpreted by `wobb`
- The parameter WBSW sets the frequency range for tuning and matching a probehead (wobbling). The center of the wobble region is determined by SFO1. The command `atma` automatically calculates the optimum sweep width and does not interpret WBSW.

ZGOPTNS - acquisition (zg) options
- takes a character array value
- can be set from `eda` by entering `zgoptns` on the command line

---

1. During tuning/matching `atma` temporarily sets the parameters WBST and WBSW to the calculated values and then resets them to their original values.
• The parameter allows you to set an option to acquisition commands like zg and go. As an alternative, acquisition options can also be specified on the command line or in the pulse program. For example, the option DQF can be set in the following three ways:

  by setting the parameter ZGOPTNS to DQF
  by specifying the option as an argument, e.g.:
  
  zg -DDQF
  by defining the option in the pulse program, e.g.:

  #define DQF

2.5 Acquisition status (dpa) parameters

This paragraph contains a list of all acquisition status parameters with a description of their function. They are stored for each dataset in the file:

<du>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition status parameters

and can be viewed with dpa. Some acquisition status parameters are interpreted by processing commands that work on raw data. Others are only stored as information for the user.

After an acquisition has finished, most acquisition status parameters have been set to the same value as the corresponding acquisition parameter. Sometimes, however, this is different. For example:

• some parameters are continuously updated during the acquisition, e.g. NS, F1-TD (in 2D). When the acquisition is halted with halt, the current values are stored as acquisition status parameters.

• some acquisition parameters are adjusted at the beginning of the acquisition, e.g. RG, FW, DR, SW. The modified values are stored as acquisition status parameters.

• the values of some parameters are a result of the acquisition. They cannot be set by the user (they do not appear as acquisition parameters) but they are stored as acquisition status parameters. Examples are AQSEQ, YMAX_a, LOCSHIFT, NC.
The acquisition status parameters which are a result of or adjusted by the acquisition are listed below.

**AQ_mod** - acquisition mode
- takes one of the values \( qf, qsim, qseq \) or \( DQD \)
- can be viewed from `dpa` or by entering `1s aq_mod` on the command line
- Normally, the acquisition status parameter `AQ_mod` is set to the same value as the acquisition parameter `AQ_mod`. If, however, `AQ_mod = DQD` but `DIGMOD = analog`, `zg` performs an acquisition in simultaneous mode and sets the status parameter `AQ_mod` to `qsim`. The same thing happens if your spectrometer is not equipped for DQD (see also the description of `AQ_mod` in chapter 2.4).

**AQSEQ** - 3D acquisition order
- only used in 3D datasets
- takes one of the values `321`, `312`
- can be viewed with `dpa` or by entering `1s aqseq` on the command line
- interpreted by the processing command `tf3`
- `AQSEQ` describes the order in which the 3 dimensions have been acquired; F3-F2-F1 or F3-F1-F2. `AQSEQ` is automatically set according to the loop structure in the pulse program. A 3D pulse program usually contains a double nested loop with loop counters `td1` and `td2`. If `td1` is used in the inner loop and `td2` in the outer loop, `AQSEQ` is set to `312`. Otherwise it is set to `321`.

`AQSEQ` is evaluated by a command which processes the raw data, usually `tf3`. The output data of this command are always in the order F3-F2-F1. If the acquisition status parameter `AQSEQ` is not set, `tf3` evaluates the processing parameter `AQORDER` to determine the acquisition order.

**DECIM** - decimation factor of the digital filter
- takes an integer value
- can be viewed with `dpa` or by entering `1s decim` on the command line
- interpreted by all processing commands which work on raw data.
- also interpreted by `abs` and `apk`
• Processing commands which work on the raw data like `em` or `ft` interpret the exact value of DECIM to account for the group delay. The commands `abs` and `apk` check whether DECIM is 1 (no oversampling) or greater than 1 (oversampling) to handle the so called smilies at the spectrum edges (see also the description of DECIM in chapter 2.4).

EXP - experiment performed
• takes a character array value
• ICON-NMR sets EXP to the value of the parameter set that was used for the experiment.

FnMODE - Acquisition mode in the indirect dimensions (2D and 3D)
• takes one of the values `undefined`, `QF`, `QSEQ`, `TPPI`, `States`, `States-TPPI` or `Echo-Antiecho`.
• can be viewed with `dpa` or by entering `1s fnmode` (2D)
• interpreted by 2D and 3D processing commands that access raw data. These are usually `xfb` or `xf2` for 2D data and `tf3` for 3D data.

The parameter FnMODE is available in XWIN-NMR 3.0 and newer. It is interpreted by processing commands to determine the Fourier transform mode in the indirect dimension(s). In XWIN-NMR 2.6 and older the processing parameter MC2 is used for that purpose. Note that in XWIN-NMR 3.0 and newer, MC2 is still available. It is interpreted when the acquisition status parameter FnMODE has the value `undefined`.

DSPFVS - DSP firmware version
• takes an integer value between 11 and 15
• interpreted by processing commands that access raw data
• Different DSP firmware versions filter the raw data in a different way. It is set according to the acquisition parameter DSPFIRM. DSPFVS, together with DECIM, is interpreted to account for the group delay of digitally filtered data. DSPFVS must also be interpreted by third party software which processes digitally filtered Avance data.

LGAIN - loop gain; lock regulator gain
• is set to a value between -80 and 0 dB
• can be viewed with `dpa` or by entering `1s lgain`
LGAIN is set at the end of the acquisition to the loop gain value used at that moment, i.e. the value currently set on the BSMS unit. This usually, but not necessarily corresponds to the value of LGain in the edlock table. For example, if lock-in was performed with the command lock, the loop gain is first read from the edlock table and set on the BSMS unit. However, pressing the Autolock or Lock On/Off key on the BSMS keyboard performs lock-in without first reading the edlock table. Note in this respect that the current value of loop gain can also be changed from the BSMS keyboard (by pressing the two keys indicated with MENU) or by the command lgain.

LOCSHFT - lock shift
- takes one of the values true or false
- can be viewed with dpa or by entering 1s locshft
- The value of LOCSHFT indicates whether or not the sample was locked during the acquisition.

LTIME - loop time; lock regulator time
- is set to a value between 0.001 and 1.0 seconds
- can be viewed with dpa or by entering 1s ltime
- LTIME is a lock parameter (edlock) rather than an acquisition parameter (see the description of LGAIN above).

LFILTER - loop filter; lock regulator cut-off frequency of the lowpass filter
- is set to a value between 1 - 200 Hz
- can be viewed with dpa or by entering 1s lfilter
- LFILTER is a lock parameter (edlock) rather than an acquisition parameter (see the description of LGAIN above).

LOCKPOW - lock power
- is set to a value between -60 and 0 dB
- can be viewed with dpa or by entering 1s lockpow
- LOCKPOW is a lock parameter (edlock) rather than an acquisition parameter (see the description of LGAIN above).

MASR - MAS spin rate
- takes a float value
XWIN-NMR parameters

- can be viewed with \texttt{dpa} or by entering \texttt{ls masr}
- set by \texttt{masr get}
- The acquisition status parameters MASR is continuously updated when the MAS monitor (started with \texttt{masrmon}) is active. This, however, requires \texttt{masrmon} to be started from the current dataset. See also the description of MASR in chapter 2.4.

NC - normalization constant
- takes an integer value
- can be viewed with \texttt{dpa} or by entering \texttt{ls nc} (1D), or \texttt{2s nc} (2D)
- set by acquisition commands and by the processing commands \texttt{genfid}, \texttt{genser} and \texttt{addfid}
- interpreted by all processing commands that access raw data
- On Avance spectrometers, acquisition commands set NC to minus the value of DDR. Note that for DIGTYP = analog, DDR is 0 and, as such, NC is also 0. The processing commands mentioned above create pseudo raw and NC is set according to the input processed data.

PROBHD - probehead
- takes a character string value
- can be viewed with \texttt{dpa} or by entering \texttt{ls probhd} on the command line
- PROBHD is set at the end of an acquisition to the current probehead as it was defined with \texttt{edhead} before the acquisition.
- \texttt{LOCNUC}

HOLDER - sample changer holder position
- takes an integer value
- can be viewed by entering \texttt{ls holder}
- set by ICON-NMR

AUTOPOS - identification information from BEST-NMR rack or well-plate
- takes a character string value (A1-A12, B1-B12, ... , H1-H12)
- can be viewed by entering \texttt{ls autopos}
- set by ICON-NMR

LOCKED - lock status during acquisition
• takes one of the values TRUE or FALSE
• can be viewed by entering \texttt{is locked} on the command line
• The status parameter LOCKED indicates whether or not the magnetic field was locked during the entire acquisition

2.6 Routing (edasp) parameters

The command \texttt{edasp} opens the routing table where you can select the nuclei and the spectrometer routing. When you select a nucleus for a certain frequency channel, the basic frequency and the default routing for that channel are automatically set.

Parameters displayed in the routing table:

BF1 - basic frequencies for channel f1
  same as the \texttt{eda} parameter BF1
NUC1 - nucleus for channel f1
  same as the \texttt{eda} parameter NUC1
SFO1 - irradiation frequency for channel f1
  same as the \texttt{eda} parameter SFO1
OFSX1 - irradiation frequency offset for the first X nucleus
OFSH1 - irradiation frequency offset for the first 1H
OFSF1 - irradiation frequency offset for the first F, 3H or Tl
OFSX2 - irradiation frequency offset for the second X nucleus
OFSH2 - irradiation frequency offset for the second 1H
OFSF2 - irradiation frequency offset for the second F, 3H or Tl
  etc.
  when defined for channel f1, these parameters correspond to O1 in \texttt{eda}
  when defined for channel f2, these parameters correspond to O2 in \texttt{eda}
  etc.
Note that the command `edsp` reads the values for OF* that were stored by the previous `edsp` or `edasp` command. If the latter was performed on different dataset, the OF* values might differ from the corresponding O1, O2 etc. (see the description of `edsp`).

**Parameters which can be viewed by clicking PARAM**

- **FCUCHAN** - connections between logical frequency channels and FCU’s
- **RSEL** - connections between FCU’s and amplifiers
- **SWIBOX** - connections between Switchbox inputs and Switchbox outputs
- **PRECHAN** - connections between Switchbox outputs and Preamplifier modules
- **HPMOD** - connections between high power amplifiers and Preamplifier modules

**Two switches to change the default routing**

These parameters appear in the `edasp` dialog box under their descriptive names. Their two possible values are offered as radio buttons. They are not stored under the current dataset but in the file `specpar`.

- **DEFRSEL** - Preferred preamplifier
  - takes one of the values selective or unselective
- **DEF19F** - Preferred output for 19F
  - takes one of the values 19F or X

`edasp` stores its parameters under the current dataset in the file:

```
<du>/data/<user>/nmr/<name>/<expno>/
```

`acqus` - acquisition parameters

and the dataset independent file:

```
<xwhome>/conf/instr/<instrum>
```

`specpar` - `edasp` parameters

Note that the routing table can also be opened from the `eda` dialog box, by clicking the NUCLEI button.
2.7 Lock (edlock) parameters

Lock parameters are used for locking the magnetic field and for referencing the spectrum. The lock-in procedure can be performed from the BSMS keyboard or with the command `lock` or `lopo`. Referencing the spectrum can be done with the command `sref`.

**Lock parameters used for locking the magnetic field:**
- **Lockfreq** - lock irradiation frequency
- **Field** - Field value (H0)
- **BFREQ** - Basic frequency
- **Solvent** - Sample solvent
- **LPower** - Lock power; the power used to irradiate the lock nucleus (-60 to 0 dB).
- **LGain** - Loop gain; lock regulator gain (-80 to 0 dB)
- **LTime** - Loop time; lock regulator time constant (0.001 to 1.0 seconds)
- **LFilt** - Loop filter, lock regulator cut-off frequency of the lowpass filter (1 to 200 Hz)
- **LPhase** - Lock phase; the phase of the lock signal
- **Nucleus** - Observe nucleus
- **Distance** - chemical shift of the lock nucleus (irradiation frequency offset)

**Lock parameters used for referencing:**
- **Ref.** - chemical shift of the reference signal (default 0)
- **Width** - width of the region where the reference signal is searched
- **RShift** - reference shift for default calibration

The parameters **LPower**, **LPhase**, **LGain**, **LTime** and **LFilt** are probehead and solvent dependent. They are stored for each probehead and for each solvent separately in:

```
<xwhome>/conf/instr/<instrum>/prosol/<probeID>/<solvent>/

bsmspar - probehead dependent lock parameters
```
The other \textit{edlock} parameters are only solvent dependent and are stored in the file:

\verb|<xwhome>/conf/instr/|

\texttt{2Hlock} - probehead independent lock parameters
Chapter 3

Spectrometer configuration commands

This chapter describes all XWIN-NMR spectrometer configuration commands. These are commands which must be executed once after installing a new version of the NMR Suite.
NAME

cf - configure the spectrometer

DESCRIPTION

The command cf allows you to configure the spectrometer. It can be executed as a single command or as a part of the XWIN-NMR configuration suite (command config).

cf should be executed:

- after installing a new version of the NMR Suite
- in case of spectrometer communication problems

It prompts you for the NMR Superuser password and will then ask you various questions. The type of questions depend on whether you perform a first time or a second or later time configuration.

First time configuration:

cf will prompt you for the following information:

Enter new instrument name:

Enter a name for your spectrometer. The default name is spect. Note that the name that you enter is the hostname of the spectrometer internal CPU. As such, it must be different from the hostname of the PC or Workstation that controls the spectrometer. If you choose a hostname different from spect, you must specify this name in hosts file (see below).

What type of spectrometer?

Enter the type of your spectrometer. This question only appears on A*X and Avance-AQX. If you have an Avance-AQS, cf automatically detects your spectrometer type.

Basic 1H frequency (with offset O1=0) in MHz:

Enter the 1H frequency that corresponds to the strength of your magnet. Note that this frequency is typically, but not necessarily, one of the values 400.13, 500.13, 600.13 etc.
After you have answered these questions, a window will appear that shows a list of all peripheral spectrometer hardware. For each unit, you have to specify the rs232 channel to which it is connected.

Next, the nuclei table will appear. Normally you can store this table as it is by clicking SAVE. If, however, you want to change the nuclei table, you can do that here. Note that you can also do that at a later time with the command ed-nuc.

Finally, an overview over the spectrometer configuration is shown. This allows you to check if your spectrometer hardware has been detected correctly. If some of the hardware is missing, please run cf again. If this does not change anything, run the spectrometer hardware checks.

A first time configuration is a configuration that is, for example, done on a new spectrometer, a new computer, a new disk or a new XWIN-NMR home directory. If, however, a new version of XWIN-NMR is installed in the same directory as a previous version, the configuration is still available. cf then runs a repeated configuration.

Repeated configuration:

cf will prompt you for the following information:

Configuration for <name>, change that (y/n) ?

where name is the spectrometer name which was specified the last time cf was executed. Hit Enter to keep this name or enter a new name.

All other questions are the same as the first time you ran cf. If the spectrometer hardware has not changed, you can answer each question with Enter.

The window with the peripheral spectrometer hardware normally shows the correct serial ports. If, however, a unit could not be reached, it has the value no. In that case, you must specify its serial port number.

The nuclei table should be closed with SAVE. If, however, you have changed the basic frequency, you must first click RESTORE.

If you specify an instrument name different from spect, this name must be specified in the hosts file. This file can be edited from the Windows Explorer or from a UNIX shell. It concerns the file:

/etc/hosts (under UNIX)
C:\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS (under Windows)
You must keep the name `spect` and append a white space plus the new instrument name, for example:

```
149.236.99.99 spect my_spectrometer
```

On most Avance-AQX spectrometers, a hardware list is needed. This is normally created during the installation of the spectrometer by the service engineer. The hardware list contains information about spectrometer components that cannot be detected by `cf`. When your spectrometer is extended with new hardware components, the hardware list must be updated accordingly. This must be done from the Windows Explorer or from a UNIX shell by editing the file:

```
/<xwhome>/conf/instr/<instrum>/hardware_list
```

After each modification of this file, `cf` must be executed.

If the `hardware_list` file does not exist, `cf` assumes a standard spectrometer. Some spectrometers are, indeed, equipped with standard components and do not need a hardware list. All possible hardware components are listed in the file:

```
/<xwhome>/conf/instr/hardware.exam
```

This file is not delivered with the NMR Suite nor is it interpreted by any command. It can be created with the XWIN-NMR command `cfmakelist` and can be used as a reference.

`cf` will automatically configure the sample changer and the temperature unit if these are specified in the hardware list. These unit will then appear in the list of hardware components where you can enter their rs232 channel number. For the sample changer, `cf` will prompt you with a few extra questions (see the command `cfbacs`). If the sample changer and temperature unit are not specified in the hardware list, they must be configured in a separate step with the commands `cfbacs` and `cfte`, respectively.

We strongly recommend to save the spectrometer configuration by copying the files `uxnmr.par` and `hardware_list` (see below) to floppy disk or CD and printing them out.

**INPUT FILES**

```
<xwhome>/exp/stan/nmr/form/
  acqu.e.D - acquisition parameter format file (eda) for Avance

/<xwhome>/conf/instr/<instrum>/
```
hardware_list - hardware units that cannot be not detected by cf

OUTPUT FILES
(also INPUT files for repeated configuration)

<xwhome>/conf/instr/
  curinst
  hardware.exam - list of all hardware entries (output of cf makelist)

<xwhome>/conf/instr/<instrum>
  uxnmr.info - spectrometer configuration overview
  uxnmr.par - spectrometer configuration
  nuclei - nuclei table

<xwhome>/conf/instr/<curinst>/rs232_device
  acb - Amplifier control board rs232 channel
  bacs - Sample changer rs232 channel
  bsms - BSMS rs232 channel
  lock - lock display rs232 channel
  preemp - preemphasis rs232 channel
  preamp1 - HPPR preamplifier rs232 channel
  preamp2 - second HPPR preamplifier rs232 channel
  preamp3 - third HPPR preamplifier rs232 channel
  rx22 - rx22 or rxc receiver unit rs232 channel
  temp - temperature unit rs232 channel

SEE ALSO
  config, expinstall, cfte, cfchars, cfmas, cfbpsu, cfmas

---

1. For multiple RCU spectrometers only.
**NAME**

cfbacs - configure sample changer

**DESCRIPTION**

The command **cfbacs** allows you to configure the sample changer. It first prompts you for the rs232 channel. Then it will ask you the following questions:

*Should the sample changer control the lift?*

with **no** as default answer.

*Delay between SX and the next command [sec]*?

where SX refers to the sample change. This delay is required for the sample to settle in the magnet. The first command after sample change is typically **ro** to switch the sample rotation on. The minimum value depends on the magnet type and lies, typically, between 10 and 30 seconds.

The command **cfbacs** can also be used if your spectrometer has no sample changer. This is, for example, useful for the automation setup with ICON-NMR on a separate workstation.

**cfbacs** can also be executed as a part of the XWIN-NMR configuration suite (command **config**). If your spectrometer uses a hardware list, and the sample changer is specified in that list, **cfbacs** can be skipped. The configuration of the sample changer is then executed by the command **cf** (see this command for more information on the hardware list).

**INPUT AND OUTPUT FILES**

`<xwhome>/conf/instr/<instrum>/rs232_device/

bacs - serial port for sample changer unit

<xwhome>/conf/instr/<instrum>/

bacs_params - number of holders in the sample changer`

**SEE ALSO**

config, cf, cfte, cfmas, cfbpsu
cfbpsu

NAME
cfbpsu - configure BPSU unit

DESCRIPTION
The command cfbpsu allows set the rs232 channel for the BPSU unit. This unit is used for LC-NMR experiments.

CFbpsu can also be executed as a part of the XWIN-NMR configuration suite (command config).

INPUT AND OUTPUT FILES
<xwhome>/conf/instr/<instrum>/rs232_device/

cpsu - serial port for BPSU unit

SEE ALSO
config, cf, cfte, cfmas, cfacs
cfte

NAME

    cfte - configure the temperature unit

DESCRIPTION

    The command \texttt{cfte} allows you to set the rs232 channel port for the temperature unit.

    \texttt{cfte} can also be executed as a part of the XWIN-NMR configuration suite (command \texttt{config}).

INPUT AND OUTPUT FILES

    $<xwhome>/conf/instr/<instrum>/rs232_device/

    \texttt{temp} - rs232 channel for the temperature unit

SEE ALSO

    config, cf, cfbacs, cfmas, cfbpsu
**NAME**

compileall - compile Bruker and User AU programs

**DESCRIPTION**

The command **compileall** compiles all Bruker and User defined AU programs. In order to compile Bruker AU programs, these must be installed first. This can be done with the command **expinstall**, with the option "Install Bruker library AU programs/modules" enabled.

For more information on AU programs please refer to the AU reference manual.

**INPUT FILES**

$xwhome$/exp/stan/nmr/au/src/*

AU programs (source files)

**OUTPUT FILES**

$xwhome$/prog/au/bin/*

AU programs (executable binaries)

**SEE ALSO**

expinstall, cplbruk, cpluser, edau, xau, xaua, xaup, delau, renau
config

NAME

config - start the XWIN-NMR configuration suite

DESCRIPTION

The command config starts the XWIN-NMR configuration suite. It opens a dialog box which contains a list configuration steps. If this dialog box does not appear, it is probably iconified. Just click its icon to open it. The config dialog box shows the following entries:

Spectrometer configuration [cf]
Temperature unit configuration [cfte]
Sample changer configuration [cfbacs]
Solvent table setup [edsolv]
Probehead table setup [edhead]
Solvent dependent parameter setup [edprosol]
Lock parameter setup [locnuc,edlock]
Configure MAS pneumatic unit [cfmas]
Configure BPSU unit for LC-NMR [cfbpsu]
Avance spectrometer constants [edscon]
Avance frequency routing [edsp]
Installation of standard experiments [expinstall]

For each entry the corresponding XWIN-NMR command is shown between square brackets. In order to start the configuration, do the following:

1. Check the entries which correspond to your spectrometer and uncheck the others. Note that [cf] should always be checked, even on a datastation. In case of doubt, you can just leave the default selection.

2. Click the Start button. The first checked command is executed. Most commands prompt the user for input.

Note that the dialog box is sometimes HIDDEN behind the config win-
dow!
Wait until the command has finished.
3. Click the Continue button to execute the next command.
4. Click the Continue button to execute the next command.
5. ect.
6. When all checked commands have been executed, click Quit to leave the configuration suite.

The button Cancel allows you to start the entire configuration suite from the beginning, i.e. to rerun all checked commands.

INPUT FILES
<xwhome>/prog/tcl/xwish3-scripts/
config - config Tcl/Tk source file
see also the OUTPUT FILES of the individual commands

OUTPUT FILES
see the OUTPUT FILES of the individual commands

SEE ALSO
cf, cfte, cfbacs, edsolve, edhead, edprosol, locnuc, edlock, cfmas, cfbpsu, edscon, edsp, expinstall
NAME
cortab - correction table creation

DESCRIPTION
The command cortab opens a window from which amplifier correction tables for acquisition can be created. These tables are used to correct the non-linearity of the pulse power level versus the pulse length. The amplifier linearization is performed in steps of 1 dB over the range between -6 and 73 dB and involves both amplitude linearization and phase correction. It requires that the amplifier output is connected to an external attenuator, which, in turn, is connected to the receiver input. The Cortab program will inform you how to connect the cables and to which value you must set the attenuator. The result of an amplifier linearization is a correction table which is a list correction values for the pulse amplitudes and phase values. An example of a correction table is shown in table 3.1.

Once a correction table exist, it is automatically used by acquisition commands like zg. If you want to check the accuracy of the amplifier linearization, Cortab allows you to do that by running a so called verification test. Amplifier linearization and verification can be done in one Cortab experiment or in two separate experiments.

On Avance-AQS spectrometers, only amplifiers require a Cortab correction. On Avance-AQX spectrometers, however, both ASU’s (Amplitude Setting Unit) and amplifiers show non-linearity and require Cortab correction. Because the ASU appears earlier in the RF path, its correction table must be created first. The result of the ASU correction is then automatically used for the amplifier correction.

Amplifier linearization can be performed in two possible ways:
- the amplifier output is connected to the external attenuator
- the amplifier output is connected to the preamplifier (as in an NMR experiment) and the preamplifier output is connected to the external attenuator

The output of these two possibilities is not exactly the same. In general, the second one, involving the preamplifier, is used because it is a better simulation of
the NMR experiment.

The cortab window allows you to setup the linearization experiments for various nuclei, perform these experiments and view the results. A regular Cortab session involves the steps listed below. Each step is specified by its button in the main Cortab window.

**Hardware Configuration** (Xwin-nmr 3.0 and older)

Clicking this button makes the spectrometer configuration available for Cort-

---

<table>
<thead>
<tr>
<th>AMP_POWER</th>
<th># power in dB</th>
<th>correction in %</th>
</tr>
</thead>
<tbody>
<tr>
<td>-6.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>-5.000</td>
<td>-32.644</td>
<td></td>
</tr>
<tr>
<td>-4.000</td>
<td>-38.510</td>
<td></td>
</tr>
<tr>
<td>-3.000</td>
<td>-37.361</td>
<td></td>
</tr>
<tr>
<td>-2.000</td>
<td>-35.032</td>
<td></td>
</tr>
<tr>
<td>-1.000</td>
<td>-31.672</td>
<td></td>
</tr>
<tr>
<td>0.000</td>
<td>-29.128</td>
<td></td>
</tr>
<tr>
<td>1.000</td>
<td>-24.939</td>
<td></td>
</tr>
<tr>
<td>2.000</td>
<td>-22.977</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>72.000</td>
<td>-0.008</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AMP_PHASE</th>
<th># power in DB</th>
<th>correction in degree</th>
</tr>
</thead>
<tbody>
<tr>
<td>-6.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>-5.000</td>
<td>-0.636</td>
<td></td>
</tr>
<tr>
<td>-4.000</td>
<td>0.622</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>72.000</td>
<td>4.323</td>
<td></td>
</tr>
</tbody>
</table>

**Table 3.1**
ab. You must do this once, at the beginning of the first `cortab` session after the spectrometer configuration (as done with `cf` or `config`). It must only be repeated when your hardware has changed and `cf` has been executed again. In XWIN-NMR 3.1 and newer, this button does not appear because the spectrometer configuration is automatically read.

**Experiment Setup**

Clicking this button opens a dialog box where you can define one or more Cortab experiments. Cortab experiments should be defined for each nucleus that you intend to use in your NMR measurements. To set up an experiment, you must click an element from each field in the Setup window in the order listed below. Note that the experiment definition requires information about the spectrometer routing. This can be obtained by entering `edasp` on a data-set that contains a NMR experiment with the selected nucleus. Further note that a selection in one field may restrict the number of elements in the next field.

- **Nucleus**
  
  Select a nucleus

- **Channel**
  
  Select the channel (FCU) on which the chosen nucleus is observed

- **Ampli**
  
  Select the amplifier to which the chosen FCU is routed.

- **Pre Ampli**
  
  Select the preamplifier module to which the chosen amplifier is routed.

- **Functions**
  
  Select the type of Cortab function (experiment) you want to do for the chosen nucleus.

On Avance-AQS spectrometers, the following functions are available:

- BLA linearization
- BLA verification
- SGU verification
- BLA Shape correction

On Avance-AQS spectrometers, most users only need the BLA linearization. This function will create the correction tables that are required for the acquisition (see table 3.1). BLA verification is an optional func-
tion that allows to check the result of the BLA linearization. SGU verification is only used to check the SGU hardware if a BLA linearization would fail. It does not use possible existing Cortab correction tables. The BLA shape correction is only needed for experiments that require high power shaped pulses.

On Avance-AQX spectrometers, Amplifier (BLA) and ASU (MULT and MOD) functions are available. They must be set up and executed in two separate series because they require different hardware connections. First you must set up one series for the ASU functions, in the order MULT - MOD, and execute this series (see Start Experiment below). Then you can set up and execute a second series for the Amplifier linearization.

• **Add Experiment**
  Adds the selected experiment (function) to the scheduled series. Instructions are displayed regarding the required hardware connections and the recommended value for the external attenuator is shown. Carefully follow the outlined instructions.

In one Cortab series, you can add experiments for:

- various nuclei
- one nucleus with various routings
- linearization and verification

You cannot, however, set an ASU correction and a BLA linearization in one series because they require different hardware connections.

• **Return**
  Closes the dialog box and returns to the main Cortab window

**Start experiment**

Clicking this button executes all experiments in the currently scheduled series. They are performed in the order in which they appear in the list. Each linearization experiment involves the following steps:

• A receiver gain test
determines the optimum receiver gain for the current experiment. If this is successful (S/N > 25 and the optimum receiver gain lies between 1 and 32), the experiment continues with the next step. If this is not successful, the experiment aborts and an information window will
appear telling what to do (usually adjust the external attenuator). Just follow the given instructions and restart the experiment.

- An attenuation test.
  performs an ASU attenuation test. This is normally successful and the experiment continues with the next step. If it is not successful, the experiment aborts; you might have an ASU hardware problem.
- The actual Cortab experiment, for example the BLA amplifier linearization.

Note that you can add extra experiments during the execution of a Cortab experiment. They are simply appended to the end of the current series and executed as a part of that execution.

In principle, you are ready now. The correction table has been created and it will automatically be used by the acquisition. If, however, you want to check the Cortab result, you can do that with the View Results button as described below.

**View Results**

This button is only active when an experiment is selected in the Selection Desktop of the Cortab window. You can select an experiment by clicking an element in the fields Nucleus, Channel and Ampli. Clicking View Results will then open a window where the results of the selected experiment are shown. The window consists of the following fields:

- **Date of the experiments**
  A list of dates at which Cortab experiments were performed.

- **Name of the experiments**
  When a date is selected, a list of result filenames created at that date is displayed. For example:

  Amp_Power_res - theoretical and experim. amplifier output voltage
  Amp_Phase_res - experimental amplifier phase values
  Elec_Hard_Testfile - all Cortab results of the current date

When you click an entry, the contents of the corresponding file is shown. Note that, files like Amp_Power_res do not contain the correction values but rather the theoretical and experimental values from which the correction values were calculated. In fact, the experimental values are the result of an acquisition after the calculation and applica-
tion of the correction values. The file Elec_Hard_Testfile contains the result of all Cortab experiments executed during the selected day.

- A data field where the contents of the selected file is displayed.

Furthermore, the following push buttons are available:

- **Graphic window**
  opens a window with graphical representation of the Cortab result. At the time of this writing this was only available on UNIX systems.

- **File print to printer**
  Sends the currently displayed result to the printer

- **Back to main window**
  Closes the ‘View Results’ window and returns to the main Cortab window

**Stop experiment**

Clicking this button stops the current experiment and empties the list of scheduled series.

**Scheduled series**

Clicking this button opens a dialog box where the currently scheduled experiments are shown. The dialog box contains the following buttons:

- **Read Series**: reads previously saved set of experiments
- **Save Series**: saves the currently scheduled experiments to disk
- **Remove All**: removes all experiments from the scheduled list
- **Remove**: removes the selected experiment from the list
- **Exit**: exits the dialog box and returns to the main Cortab window

**Nucleus List refresh**

Clicking this button updates the nucleus list adding experiments that have been finished since Cortab has been started.

Cortab experiments use two spectrometer channels simultaneously:

- the pulse channel: selected by the user in the Cortab **Experiment Setup**, i.e. the channel that is routed to the amplifier (or ASU) that is being corrected.
• the observe channel: automatically selected by the Cortab program. If the pulse channel is f1, the observe channel is f2. Otherwise the observe channel is f1.

The selection of the observe channel is transparent to the user. An exception to this is the Avance-DPX spectrometer with ASU2/LOT. Here, only the f1 channel can be selected for observation. Cortab experiments on f1 (using f2 as the observe channel) require a hardware modification. A description of this modification as well as various other Cortab details are described in the Cortab manual which can be opened from XWIN-NMR by clicking Help → Other topics → Cortab.

**INPUT FILES**

<xwhome>/prog/app-defaults/
  Cortab - cortab window resources
<xwhome>/exp/stan/nmr/au/src/
  X* - cortab AU programs (sources)
<xwhome>/prog/au/bin/
  X* - cortab AU programs (binaries)
<xwhome>/exp/stan/nmr/lists/pp.hwt
  corcpdsDAV.* - cortab pulse programs for Avance-AQS
  corcpdsDMX.* - cortab pulse programs for Avance-AQX-DMX
  corcpdsDRX.* - cortab pulse programs for Avance-AQX-DRX
  corcpdsDPX.* - cortab pulse programs for Avance-AQX-DPX

<xwhome>/qtp/
  Date.tmp - time and date of last Hardware configuration
  *.conf - hardware configurations (input of Experiment Setup)
  functions.AV - functions for Avance-AQS (input of Exper. Setup)
  functions.DRX - functions for Avance-AQX (input of Exper. Setup)

**OUTPUT FILES**

On Avance-AQX and Avance-AQS spectrometers

<xwhome>/conf/instr/<instrum>/cortab
amp<fcu no.>_<nucl.>_ampl. RO - amplifier correction tables

where RO is the router output number.

<xwhome>/qtp/<nucleus>/FCU<no>/<ampl. descr.>/<date>/

Amp_Power_res - theoretical and experimental amplifier output voltage
Amp_Phase_res - experimental amplifier phase values
Att_verif_pha.<expno> - amplifier verification result
Elec_Hard_Testfile - all Cortab results of the current date

*.conf - hardware configurations (output of Hardware Configuration)
functions.* - Cortab functions (output of Hardware Configuration)

On Avance-AQX spectrometers only

<xwhome>/conf/inst/<instrum>/cortab

mma<fcu no.>_<nucl.>_ampl. RO - ASU correction tables

<xwhome>/qtp/<nucleus>/FCU<no>/<ampl. descr.>/<date>/

Mod_Power_res - theoretical and experimental ASU output voltage
Mod_Phase_res - experimental ASU phase values
Mult_Power_res - theoretical and experimental ASU output voltage
Mult_Phase_res - experimental ASU phase values
Att_verif_ampl.<expno> - MULT ampl. verification result
Att_verif_pha.<expno> - MULT ampl. verification result
Modverif_amp_<pln>.<expno> - MOD ampl. verification result
Modverif_pha_<pln>.<expno> - MOD phase verification result

SEE ALSO

zg
cplbruk, cpluser

NAME

cplbruk - compile Bruker AU programs
cpluser - compile user defined AU programs

SYNTAX

cplbruk [ <name> | all ]
cpluser [ <name> | all ]

DESCRIPTION

The command cplbruk allows you to compile one or more Bruker AU programs. Before you can use it, the command expinstall must have been executed once, with the option "Install Bruker library AU programs/modules" enabled. Then you can use cplbruk in three different ways:

- cplbruk <name> - compile the Bruker AU program <name>
- cplbruk all - compile all Bruker AU programs
- cplbruk - a list of Bruker AU programs appears; click one to compile it

If you specify an argument, then it may contain wildcards; for example cplbruk a* compiles all Bruker AU programs which start with a.

The command cpluser works like cplbruk, except that it compiles user defined AU programs.

For more information on AU programs please refer to the AU reference manual.

INPUT FILES

<xwhome>/exp/stan/nmr/au/src/*

AU programs (source files)

OUTPUT FILES

<xwhome>/prog/au/bin/*

AU programs (executable files)
SEE ALSO
expinstall, compileall, edau, xau, xaua, xaup, delau, reau
**ednuc**

**NAME**

ednuc - edit the nuclei table

**DESCRIPTION**

The command `ednuc` opens the nuclei table. This table consists of two columns; the left column shows a list of nuclei, the right column the corresponding basic frequency.

Within the nuclei table, you can perform the following actions:

- Change the frequency of a nucleus by entering a new number in the right column.
- Delete a nucleus by clicking its entry in the left column.
- Click ADD to add a nucleus. A list of all nuclei will appear and you can click the one you want to add.
- Click RESTORE to restore the original nuclei table. All changes you made will be undone. This must be done once, if you have changed the basic frequency with `cf`.
- Click SAVE to close the nuclei table, saving all changes.
- Click QUIT to close the nuclei table, discarding all changes.

**INPUT FILES**

- `<xwhome>/conf/instr/<instrum>/nuclei` - nuclei table
- `<xwhome>/exp/stan/nmr/lists/nuclei.all` - complete nuclei table (input of ADD and RESTORE)

**OUTPUT FILES**

- `<xwhome>/conf/instr/<instrum>/nuclei` - nuclei table
SEE ALSO
edsolv, edhead, edlock, edprosol
edprosol

NAME
edprosol - edit probehead and solvent dependent parameters

DESCRIPTION
The command edprosol opens a dialog box in which you can set the probehead and solvent dependent (prosol) parameters. This is typically done during the installation of your spectrometer for all probeheads and solvents you want to use. However, you can always run edprosol again at a later time to set the prosol parameters for additional probeheads and/or solvents.

Setting the prosol parameters involves the following steps:

1. Select the probehead, solvent(s) and nucleus:
   - **Probes name**
     By default, the current probehead (as defined with edhead) is selected. Prosol parameters must be defined for each probehead separately.
   - **Solvent**
     The default value is All. If you keep that value, the same prosol values will be stored for all solvents. If, however, you select a specific solvent, the prosol parameters will be stored for that solvent only.
   - **Nucleus**
     By default, the nucleus of frequency channel f1 of the current dataset (NUC1) is selected. Prosol parameters must be set for each nucleus separately.

2. This step is optional. You can enter two comment lines; for example the conditions under which the pulses/power levels have been determined (filters etc.).

3. Select the channels for which you want to define the parameters. You can do this by clicking one of the following radio buttons:
   - **F1+F2** : prosol parameters for the f1 and f2 frequency channel
   - **F3** : prosol parameters for the f3 frequency channel
   - **Global** : a few prosol parameters that count for all frequency channels

By default, **F1+F2** is checked. Most experiments only use channel f1 or f1
and f2. If you are using f3, you have to set the prosol parameters for this channel as well. Note that f1, f2 and f3 refer to the logical frequency channels as you will see them in the routing table (edasp). They should not be confused with the terms that are used to indicate the dimensions of a 2D or 3D dataset.

4. Select the type of pulses that you want to set. For this purpose the following radio buttons are available at the bottom of the window:

- **Standard hard pulses**
  shows a list of standard hard pulses and allows you to set their pulse lengths, power levels and mixing times (toesy and roesy only)

- **Standard soft pulses**
  shows a list of standard soft pulses and allows you to set their pulse lengths, power levels, phase alignments and shape files

By default, **Standard hard pulses** is checked which is sufficient for most experiments.

5. Set the pulse lengths and power levels for the selected frequency channel(s) and pulse type(s). You should start with the 90° hard pulse which must have been determined before you start edprosol. Then you can define all other pulses for the current channel. You can enter the pulse length and click the calc button to determined the corresponding power level. Alternatively, you can enter the power level and click the calc button to determine the corresponding pulse length. This, however, only works if the pulse length is set to 0 at the time calc is clicked. Note that the relation used by calc is determined by the 90° hard pulse.

6. Save the prosol parameters by clicking the **Save** button at the bottom of the dialog box.

To the right of the Save button, you will find the following buttons:

- **Copy to probe**
  opens a list of all probeheads. You can select the probehead(s) for which you want to store the prosol parameters and then click one of the buttons **Save to all solvents** or **Save to selected solvents**.

- **Print screen**
  List the currently selected prosol parameters on the printer

- **Exit**
  Quit the edprosol dialog box.
The **edprosol** dialog box provides a few additional options if you switch to expert mode. You can do that by clicking *File → expert mode*. Right above the parameter table, an arrow button will appear where you can select the amplifier connected to the currently selected channel. The default amplifier is normally correct. At the bottom if the window, two extra radio buttons will appear:

- **user-defined hard pulses**
  shows a list of user-defined pulses and allows you to set their pulse length and power level.
- **user-defined soft pulses**
  shows a list of user-defined pulses and allows you to set their pulse length and power level.

User defined hard and soft pulses require a separate (user defined) relations file. It can be setup from the Windows Explorer or from a UNIX shell.

The **edprosol** window allows you to set up a probehead dependent tune file. You can do that by clicking *File → Edit tunefile*. On first time execution, this command displays the example tune file that is delivered with XWIN-NMR. When you save the file, it is stored for the probehead that is currently defined in **edprosol**. Probehead dependent tune files are read by the command **tune .sx**.

The prosol parameters are interpreted by the **getprosol** command that copies them to the corresponding acquisition parameters. The default relations between prosol and acquisition parameters are listed in table 7.1. Note that **getprosol** is automatically performed as part of the ICON-NMR automation.

**edprosol** can also be executed as a part of the XWIN-NMR configuration suite (command **config**).

Note that the probehead and solvent dependent lock parameters are set with **edlock**.

The command **edprosol** replaces the commands **prosol**, **solvloop** and **liprosol** which were used in XWIN-NMR versions 2.6 and older.

**INPUT FILES**

```
<xwhome>/exp/stan/nmr/lists/group/
  example_bsms - example tune file (input for first *File → Edit tunefile*)
<xwhome>/prog/tcl/xwish3_scripts
```
edprosol - Tcl/Tk script that is started by edprosol

<xwhome>/prog/tcl/libtix/prosol/lib/lists

routing - default spectrometer routing

INPUT AND OUTPUT FILES

If you select Solvent(s) All:

<xwhome>/conf(instrum)/prosol/probeID/

nucleus.channel.amplifier - standard prosol parameters
params - global (channel independent) prosol parameters
tunefile - probe dependent tune file (input for File → Edit tunefile)

If you select a specific solvent:

<xwhome>/conf(instrum)/prosol/probeID/<solvent>

nucleus.channel.amplifier - standard prosol parameters
params - global (channel independent) prosol parameters
tunefile - probe dependent tune file (input for File → Edit tunefile)

SEE ALSO

getprosol, edlock
edscon

NAME

edscon - edit spectrometer constants

DESCRIPTION

The command edscion opens a dialog window, where you can set certain spectrometer parameters (constants). The term constant refers to the fact that these parameters count for all datasets. edscion must be executed once as part of the spectrometer configuration. It can be entered from the command line or it can be executed as part of the config suite.

For Avance-AQX spectrometers, the upper part of the edscion window offers the following parameters:

- BLKTR[1-8] - ASU and transmitter blanking preset time (default 3µ)
- BLKPA[1-5] - preamplifier blanking preset time (default 3µ)
- PHASPR[1-8] - phase switching preset time (default 3µ)
- SHAPPR[1-8] - shaped pulse calculation preset time (default 1.6µ)
- PHASP4[1-8] - 4PH modulator phase switching preset time (default 0.5µ)

They specify the time between a blanking or switching step and the beginning of the RF pulse. As such they are called preset parameters. For Avance-AQS, only BLKTR appears.

BLKTR and BLKPA are blanking preset times. The principle of blanking is used in the ASU (Amplitude Setting Unit), transmitter and preamplifier. This means they only allow RF signal to pass during the time they are blanked. Because of the finite switching time, blanking is triggered before the start of the RF pulse. The ASU and transmitter are blanked BLKTR µsec before the pulse, the preamplifier is blanked BLKPA µsec before the pulse. All three units are unblanked (allow no further RF passing) at the end of the pulse.

PHASPR and PHASP4 are phase switch preset times. In many pulse programs, the phase of the RF pulse is switched after every scan, using a phase program (list). Because of the finite switching time, the phase switch is triggered before the start of the RF pulse. When a regular phase list like

```
phl = 0 90 180 270
```

is used, the phase is switched PHASPR µsec before the pulse. If, however, your
spectrometer is equipped with a 4-phase modulator, and a phase list like

\[ \phi_1 = +x +y -x -y \]

is used, the phase is switched PHASP4 \( \mu \)sec before the pulse. Note that the default value for PHASP4 (0.5\( \mu \)) is much shorter than that for PHASPR (3\( \mu \)). The reason is that the switching of phases created by the 4-phase modulator is much faster than that of regular phases.

SHAPPR is a shaped pulse preset time. A shaped pulse requires a short preparation time, for example to reset a pointer to the beginning of the list of values that defines the shape. Note that after each shaped pulse, the pulse program must contain a minimum delay of 2 \( \mu \)sec on the respective channel.

Each preset parameter is an array of 16 elements but only elements 1 - 8 are used, corresponding to the maximum of 8 spectrometer channels. For BLKPA, only elements 1 - 5 are used, corresponding to the 5 preamplifier modules. For most high resolution experiments, you do not have to change the preset parameters and you can work with the default values that have been set during the installation of your spectrometer. However, for some solids state experiments, it is often useful to use shorter values. We recommend the following settings:

- CRAMPS experiments (with f1 as the 1H observe channel):
  - BLKTR[1] = 0.7 \( \mu \)s for DMX
  - BLKTR[2] = 0.7 \( \mu \)s for DRX
  - PHASPR[1] = 0.6 \( \mu \)s for DMX with TFH board (see uxnmr.info)

- CP experiments:
  - PHASPR[2] = 1.7 \( \mu \)s
  - PHASPR[2] = 0.6 \( \mu \)s for DMX with TFH board (see uxnmr.info)

- Back to back pulses:
  - PHASPR[n] = 0.6 \( \mu \)s Avance-AQX with TFH board (see uxnmr.info)
  - PHASPR[n] = 1.7 \( \mu \)s for DMX with TFX or DRX

For more information on this topic, click Help → Other topics → Solids Users Manual

The use of the **edscon** preset parameters can be switched off by inserting the statement

\[ \text{preset off} \]

at the beginning of a pulse program. This has the same effect as setting all **edscon** preset parameters to zero. In this case, the blanking and switching steps
described above occur at the beginning of the RF pulse. Nevertheless, you can enable the preset blanking for each individual channel, e.g.:

\[ 2 \mu \text{ gatepulse 1} \] : enable blanking for channel f1
\[ 2 \mu \text{ gatepulse 1|2} \] : enable blanking for channel f1 and f2

In this example, the blanking of ASU, transmitter and preamplifier is triggered 2 µsec before the RF pulse.

The edscen dialog box also shows the so called pre-scan subdelays. These are all part of the pre-scan delay DE. This is a hidden delay (it is not specified in the pulse program) but is automatically introduced by the go statement.

On Avance-AQX spectrometers, DE consists of 5 pre-scan subdelays DE1, DE2, DERX, DEADC and DEPA that all start simultaneously at the beginning of DE. At the end of each subdelay a certain action is performed:

DE1: the intermediate frequency (if required) is added to the frequency of the observe channel. This corresponds to the execution of the syrec statement (default 2 µsec). The intermediate frequency is only used for AQ_mod = DQD or, if your spectrometers has an RX22 receiver, for any value of AQ_mod.

DE2: the phase of the receiver is set to zero (default 1 µsec)

DERX: the receiver gate is opened (default 3 µsec)

DEADC: the digitizer is enabled (default 4 µsec)

DEPA: the preamplifier is switched from transmit to observe mode (default 2 µsec)

Normally, the default values, which have been set during the installation of your spectrometer, can be used. Each subdelay has a maximum of DE - 1 µsec. On Avance-AQS, the DE2 does not exist.

In most pulse programs, data sampling is performed by the go statement that automatically triggers the actions mentioned above after the corresponding pre-scan subdelay. If, however, data sampling is performed by the adc statement, these actions must explicitly be specified in the pulse program. Each action can be performed by a statement with the same name, in lower case letters, as the corresponding pre-scan subdelay. For example, the receiver gate can be opened with the derx statement. You can type edpul zgadc to look at an example of a pulse program using the adc statement. For more information on this topic
The prescan subdelays only play a role for digitally filtered data (DIGMOD = digital or digital homodecoupling). For DIGMOD = analog, the parameter DE has a different purpose. It is used to achieve a near zero first order phase correction of the spectrum. In this case, it does not consist of subdelays.

INPUT AND OUTPUT FILES

<xwhome>/conf/instr/<instrum>/

scon - spectrometer constants

SEE ALSO

cf, config
edsolv

NAME
edsolv - edit solvent table

DESCRIPTION
The command **edsolv** opens the solvent table. This table contains one line for each solvent and shows the solvent name, a short description and a reference number. A typical line looks like:

\[
\text{Acetic - Acetic-Acid-D}_4 \ [02]
\]

Furthermore, the solvent table contains the following buttons:

**Add/Change**

Appends an empty line in which you can add a new solvent. Please enter the solvent name, a short description (optionally) and a unique reference number. All existing lines are put in **edit** mode and can be changed. Make sure that each reference number is only used once.

**Delete**

Puts all lines in **delete** mode. If you click a entry now, it will be deleted.

**Save**

Closes the table, saving all changes.

**Abort**

Closes the table, discarding all changes.

Before you start an experiment, you must set the parameter **SOLVENT** to an entry from the solvent table. If you do this from **eda**, you can click the arrow button to the right of this parameter and select an entry from the solvent list.

**edsolv** can also be executed as a part of the XWIN-NMR configuration suite (command **config**).

INPUT FILES

```
<xwhome>/exp/stan/nmr/lists/

solvents.all - complete Bruker solvent list (input for first **edsolv**)
```
solvents - user solvent list (input for second or later edsolv)

OUTPUT FILES
<xwhome>/exp/stan/nmr/lists/
solvents - user solvent list

SEE ALSO
ednuc, edhead, edlock, edprosol
edsp

NAME

edsp - set up nuclei and spectrometer routing

DESCRIPTION

The command edsp allows you to set up the nuclei and the spectrometer routing for the current experiment. edsp and edasp differ in only respect:

- edasp reads the irradiation frequencies offsets OFSH1, OFSX1, OFSX2 etc. from the current dataset.
- edsp reads the irradiation frequencies offsets OFSH1, OFSX1, OFSX2 etc. that were stored by the previous edsp or edasp.

As such, edsp allows you to transfer the frequency offset for a certain nucleus from one dataset to another. For example:

DATASET 1

```plaintext
rpar PROTON all
edasp or edsp →
BF1 500.130 MHz NUC1
SFO1 500.135 Mhz F1
OFSH1 5000.00 Hz 1H
SAVE
```

DATASET 2

```plaintext
rpar PROTON all
edsp →
BF1 125.757 MHz NUC1
SFO1 125.758 Mhz F1
OFSH1 1000.00 Hz 13C
BF1 500.130 MHz NUC2
SFO1 500.135 Mhz F2
OFSH1 5000.00 Hz 1H
```

The irradiation frequencies SFO1, SFO2 etc. are automatically adjusted to the corresponding frequency offsets.
The command *edsp* is also part of the spectrometer configuration. It must be executed only once, after the installation of XWIN-NMR. In this case, you only need to set the following switches:

*Preferred preamplifier*

toggle between selective and unselective Preamplifier module

*Preferred output for 19F*

toggle between the 19F and X Switchbox output for 19F nucleus

and click *SAVE* to store them.

The *Preferred preamplifier* determines the default preamplifier module (selective or unselective) for X-nuclei. The *Preferred output for 19F* determines the default output of the switchbox (X or 19F) for 19F.

*edsp* should be executed before *expinstall* which installs the standard parameter sets. *expinstall* reads the values of Preferred preamplifier and Preferred output for 19F, as they were set by *edsp*, and stores the default routing parameters accordingly.

**INPUT AND OUTPUT PARAMETERS**

see *edasp*

**INPUT AND OUTPUT FILES**

see *edasp*

**SEE ALSO**

*edasp, config, expinstall*
expinstall

NAME

expinstall - install pulse programs, AU programs, parameter sets etc.

DESCRIPTION

The command `expinstall` installs pulse programs, AU programs, parameter sets and various other resources for spectrometer usage. It must be performed once after the installation of XWIN-NMR and after `cf` has been done. cf and expinstall are typically performed as a part of the `config` configuration suite.

`expinstall` first prompts you for the NMR Superuser password. After it has been entered correctly, you see a list of spectrometer types. The spectrometer type you have defined with `cf` is highlighted. You can simply click `Proceed`, unless you have a reason to choose a different type of spectrometer. `expinstall` will then offer you a list of tasks which can be selected or deselected. For routine spectroscopy, you can accept the default selection and click `Proceed` to continue. If the task `Convert Standard Parameter Sets` was selected, you will be prompted for some information about the spectrometer. Once this has been entered, `expinstall` will start to execute the selected tasks. The full list of tasks is:

- Install pulse programs
  These are used for all experiments.
- Install Bruker library AU programs
  Performing this task makes Bruker AU programs available for editing (`edau`) and compilation (`xau` or `cplbruk`).
- Recompile User AU programs
  AU programs must be (re)compiled after the installation of a new XWIN-NMR version because the installation has removed the AU binaries. `expinstall` only compiles User AU programs, not Bruker AU programs. The latter can be compiled with `compileall` or `cplbruk all`.
- Install CPD programs
  These are used for composite pulse decoupling experiments.
- Install gradient files
  These are used for gradient experiments.
• Install Library shape files
  These are used for selective excitation experiments.

• Convert standard parameter sets
  Bruker standard parameter sets, as they are delivered with the NMR Suite, were prepared at various field strengths. `expinstall` converts them to your spectrometer frequency. This includes the parameters BFx, Ox, SFOx and SW as well as the offsets of the shaped pulses (parameter SPOFFS). Note that for 2D (3D), the SW in F1 (F2 and F1) is kept and the increment IN0 (IN0 and IN10) is adjusted.

• Install standard scaling region files
  These contain the regions in which the reference peak for vertical scaling is searched by commands like `plot, li, lipp, pp*`. 

• Enable Define Statements in Pulse programs
  Define statements are pulse program statements like:

  ```
  ;; d11=30m
  ```

  at the beginning of a pulse program. In this form they are not active because lines starting with a `;' character are treated as comment. `expinstall` removes all occurrences `;';;`, thereby enabling the defined statements. Normal comment lines are not affected because they contain a single `;' only.

The NMR Suite is delivered with a set of pulse programs, CPD programs, gradient files, shape files and scaling region files for each spectrometer type (Avance, AMX, ARX etc.). `expinstall` installs the set which is needed on your spectrometer type.

If the task *Convert Standard Parameter Sets* is selected, `expinstall` will prompt you for the following information:

• Select type of digitizer:
  Click the digitizer that you want to store in the acquisition parameter DIGTYP in all parameter sets.

• Select acquisition mode:
  Click the acquisition mode that you want to store in the acquisition parameter AQ_mod in all parameter sets

• Enter default pre-scan-delay DE:
  Enter the value that you want to store in the acquisition parameter DE in all parameter sets. Normally, you can accept the default value.
Select printer:
Click the printer that you want to store in the output (edo) parameter CURPRIN in all parameter sets. This printer will be used by commands like lpa and lpp.

Select plotter:
Click the printer that you want to store in the output (edo) parameter CURPLOT in all parameter sets. This printer will be used by commands like view and plot.

Enter paper format:
Enter A4, A3, A or B. The entered value will effect various plot (edg) parameters like CX, CY and DHEI in all parameter sets. If you enter any value other than A4, A3, A or B, the file:

<xwhome>/exp/stan/nmr/lists/plotconvpar

is interpreted for the paper format ¹. This file is delivered with XWIN-NMR and you can change it for your purpose from the Windows Explorer or from a UNIX shell.

INPUT PARAMETERS
If the task Convert standard parameter sets is selected, expinstall uses the following input parameters:

set by the user with edsp:

DEFRSEL - preferred preamplifier (default routing)
DEF19F - preferred output for 19F (default routing)

from the parameter sets as delivered with XWIN-NMR:

BF1 - BF4 - basic frequencies for channel f1 to f4
SFO1- SFO4 - irradiation (carrier) frequencies for channels f1 to f4
IN0 - increment for delay D0 (2D and 3D parameter sets only)
IN10 - increment for delay D10 (3D parameter sets only)
SW - spectral width in ppm
SPOFFS[0-7] - shaped pulse frequency offset

¹ Note that the file plotconvpar.A3 is used for A3 and B and plotconvpar.A4 for A4 and A.
OUTPUT PARAMETERS

If the task *Convert standard parameter sets* is selected, **expinstall** stores the following parameters in the parameter sets:

- **BF1 - BF4** - basic frequencies for channel f1 to f4
- **SFO1 - SFO4** - irradiation (carrier) frequencies for channels f1 to f4
- **SF** - spectral reference frequency
- **IN0** - increment for delay D0 (2D and 3D parameter sets only)
- **IN10** - increment for delay D10 (3D parameter sets only)
- **SW** - spectral width in ppm
- **SPOFFS[0-7]** - shaped pulse frequency offset
- **DIGTYP** - digitizer type
- **DR** - digital resolution
- **DIGMOD** - digitizer mode
- **DECIM** - decimation factor of the digital filter
- **DE** - prescan delay
- **FCUCHAN** - routing between logical frequency channels and FCU’s
- **RSEL** - routing between FCU’s and amplifiers
- **SWIBOX** - routing between Switchbox inputs and Switchbox outputs
- **PRECHAN** - routing between Switchbox outputs and Preamplifier modules
- **HPMOD** - routing between high power amplifiers and Preamplifier modules

INPUT FILES

- `<xwhome>/conf/instr/<instrum>/specpar` - routing parameters
- `<xwhome>/prog/au/src.exam/*` - Bruker AU programs (source files)
- `<xwhome>/exp/stan/nmr/au/src/*` - AU programs (source files)
- `<xwhome>/exp/stan/nmr/par.avance/*` - Bruker parameter sets for Avance
- `<xwhome>/exp/stan/nmr/par.300/*` - Bruker parameter sets for A*X
- `<xwhome>/exp/stan/nmr/pp.dexam/*` - pulse programs for Avance
- `<xwhome>/exp/stan/nmr/pp.exam/*` - pulse programs for AMX
- `<xwhome>/exp/stan/nmr/cpd.dexam/*` - CPD programs for Avance
- `<xwhome>/exp/stan/nmr/cpd.exam/*` - CPD programs for AMX
- `<xwhome>/exp/stan/nmr/gp.dexam/*` - gradient programs for Avance
<xwhome>/exp/stan/nmr/gp.exam/* - gradient programs for AMX
<xwhome>/exp/stan/nmr/wave.dexam/* - shape files for Avance
<xwhome>/exp/stan/nmr/wave.exam/* - shape files for AMX
<xwhome>/exp/stan/nmr/scl.exam/* - scaling region files for Avance/AMX

Depending on the spectrometer type and/or application, expinstall uses various other input folders/files using the extensions:

- .rexam - high resolution on ARX
- .solids - solid state on AMX/ASX
- .imag - micro imaging on AMX
- .tomo - tomography
- .dsolids - solid state on Avance
- .dimag - micro imaging on Avance

OUTPUT FILES

- <xwhome>/exp/stan/nmr/au/src/* - Bruker AU programs (source files)
- <xwhome>/prog/au/bin/* - AU programs (binary executables)
- <xwhome>/exp/stan/nmr/par/* - parameter sets for your spectrometer
- <xwhome>/exp/stan/nmr/pp/* - pulse programs for your spectrometer
- <xwhome>/exp/stan/nmr/cpd/* - CPD programs for your spectrometer
- <xwhome>/exp/stan/nmr/gp/* - CPD programs for your spectrometer
- <xwhome>/exp/stan/nmr/wave/* - shape files for your spectrometer
- <xwhome>/exp/stan/nmr/scl/* - scaling region files for your spectrometer

SEE ALSO

cf, config, cplbruk, cpluser, compileall, rpar, wpar,
Chapter 4

Lock commands

This chapter describes the commands which are involved in locking the magnetic field. Avance spectrometers use a digital lock that is provided by the BSMS unit. Locking the magnetic field is done by measuring the signal of a lock nucleus and adjusting the magnetic field whenever its frequency shifts. Common lock nuclei are $^2\text{H}$ and $^{19}\text{F}$. 
edlock

NAME
edlock - edit the lock table

DESCRIPTION
The command edlock opens the lock table; a dialog box in which the lock parameters can be set. It must be executed once for each probehead and each lock nucleus. The lock parameters can be determined from the BSMS keyboard or from the BSMS display (command bsmsdisp).

Before you run edlock, you must define the current probehead with the command edhead. Furthermore, you must define the lock nucleus by setting the parameter LOCNUC. This can be done with eda or by entering locnuc on the command line. In most experiments, the lock nucleus is deuterium. As such, LOCNUC is set to 2H in most Bruker standard parameter sets (see rpar).

When edlock is executed for the first time on a certain probehead, a default lock table, which is delivered with XWIN-NMR, is opened.

The first line of the lock table shows the lock nucleus and the current probehead. The second line shows the lock frequency, the field value (H0) and the basic spectrometer frequency. The latter must be specified when the spectrometer is configured with cf or config. The lock frequency is automatically calculated from the basic spectrometer frequency.

The main part of the lock table shows a list of solvents and, for each solvent, the lock parameters. Most lock parameters are used for locking the magnetic field during the acquisition. Others, however, are used for referencing the spectrum after the acquisition has finished.

Lock parameters used to lock the magnetic field:

LPower - Lock power; power used to irradiate the lock nucleus (-60 to 0 dB)
LGain - Loop gain; lock regulator gain (-80 to 0 dB)
LTime - Loop time; lock regulator time constant (0.001 - 1.0 seconds)
LFilt - Loop filter, lock regulator cut-off frequency of the lowpass filter (1 - 200 Hz)
LPhase - Lock phase; the phase of the lock signal
Nucleus - Observe nucleus
Distance - Chemical shift of the lock nucleus (irradiation frequency offset)

These parameters are interpreted by the commands lock and lopo.

**Lock parameters used to reference the spectrum (**sref**):**
Ref. - chemical shift of the reference signal (default 0)
Width - width of the region where the reference signal is searched
RShift - reference shift for default calibration

At the bottom of the lock table, the following buttons/fields are available:

- **SAVE** - saves the current values and closes the dialog box
- **BSMS-FIELD** - reads the field value (H0) from the BSMS unit
- **NUCLEUS** - selects an observe nucleus for each solvent. This is equivalent to clicking the Nucl. button on one solvent and selecting new.
- **NEW SOLVENT** - adds an extra solvent entry to the list. The currently selected (highlighted) entry is copied and the solvent field can be edited. If no entry is highlighted at the time you click NEW SOLVENT, the last entry will be copied.
- **DELETE** - switches to delete mode. If you click on a solvent now, its entry will be deleted. If you click on the nucleus button of a particular solvent, the currently selected nucleus is deleted for that solvent.
- **ABORT** - closes the lock table discarding all changes
- **LOADSTAN** - loads the standard (default) values for all parameters. These are the same values which are loaded when edlock is executed for the first time.
- **+/- POWER** - in this field you can enter the number that should be added to the lock power (LPower) of all solvents. A positive number increases the lock power, a negative number decreases it.
- **LIST** - prints the lock parameters on the device specified by the edo parameter CURPRIN
- **COPY_VALUE** automatically copies the value of the selected parameter to all solvents
The loop gain, loop time and loop filter can also be set with the XWIN-NMR commands `lgain`, `ltime` and `lfilter`, respectively. Furthermore, they can also be set from the BSMS keyboard menu. This menu can be entered by simultaneously pressing the two keys indicated with `MENU`.

The lock phase can be adjusted from the BSMS keyboard while observing the lock sweep on the lock display (`lockdisp`).

Note the difference between loop gain which can be set in `edlock` or with `lgain` and lock gain which can be set on the BSMS keyboard.

The AU program `loopadj`, automatically optimizes the lock phase, lock gain, loop gain, loop filter and loop time. Note that `loopadj` optimizes these parameters for best long-term stability, but not for best lineshape, resolution or homogeneity (for more information type `edau loopadj` and look at the header of the AU program).

The Lock Power should be about 6 dB below the value where the lock signal starts to saturate. Saturation can be observed by increasing the lock power while observing the lock signal. When the signal no longer increases or starts to decrease, it is saturated.

In ICON-NMR automation, the lock parameters are read from the lock table and used as they are.

`edlock` can also be executed as a part of the XWIN-NMR configuration suite (command `config`).

For information on how to determine the lock parameters click `Help → Other topics → Avance Users Guide`. Furthermore, you can refer to the spectrometer hardware documentation. It can be viewed by inserting the BASH CDROM and clicking `Help → Other topics → BASH spectrometer documentation`.

**INPUT AND OUTPUT PARAMETERS**

see DESCRIPTION above

**INPUT FILES**

<exphome>/exp/stan/nmr/lists/

- `2Hlock` - 2H lock parameters (input for first `edlock` on current probe)
- `19Flock` - 19F lock parameters (input for first `edlock` on current probe)
INPUT AND OUTPUT FILES

<xwhome>/conf/instr/<instrum>/
  2Hlock - 2H lock parameters
  19Flock - 19F lock parameters

<xwhome>/conf/instr/<instrum>/prosol/<probeID>/<solvent>/
  bmspar - solvent and probehead dependent lock parameters

SEE ALSO

lock, lopo, lopoi, edhead, lockdisp, lgain, ltime, lfilter
**lgain, ltime, lfilter**

**NAME**

- lgain - set the lock regulator loop gain
- ltime - set the lock regulator loop time
- lfilter - set the lock regulator loop filter

**SYNTAX**

- lgain [<gain>]
- ltime [<time>]
- lfilter [<filter>]

**DESCRIPTION**

The command `lgain` allows you to set the loop gain, a lock regulator parameter. It takes one argument; a loop gain value between -80 and 0 dB. This value is only used when the lock-in process is done from the BSMS keyboard; i.e. by pressing Lock On/Off or Autolock. When lock-in is done with the XWIN-NMR command `lock`, the loop gain is set to the `edlock` parameter `LGain`.

`ltime` and `lfilter` work like `lgain`, except that they set the regulator parameters loop time and loop filter, respectively.

The AU program `loopadj` automatically optimizes lock gain, lock phase, loop time, loop gain and loop filter.

The regulator (loop) parameters can also be set from the BSMS keyboard menu. This can be opened by simultaneously pressing the two keys indicated with `MENU`.

For information on how to determine the lock parameters click Help → Other topics → Avance Users Guide. Furthermore, you can refer to the spectrometer hardware documentation. This can be viewed by inserting the BASH CDROM and clicking Help → Other topics → BASH spectrometer documentation.

**USAGE IN AU PROGRAMS**

- LTIME(value)
- LGAIN(value)
- LFILTER(value)
SEE ALSO
lock, lopo, lopoi, edlock
**lock**

**NAME**

lock - lock the magnetic field

**SYNTAX**

`lock [ <solvent> | -acqu | -noauto ]`

**DESCRIPTION**

The command `lock` performs the automatic lock-in procedure. It takes one argument and can be used in the following ways:

- **`lock`**
  opens a dialog box with a list of solvents. When you select a solvent, it reads the lock parameters for that solvent and performs an auto lock-in accordingly.

- **`lock <solvent>`**
  reads the lock parameters for the specified solvent and performs an auto lock-in accordingly.

- **`lock -acqu`**
  reads the lock parameters for the solvent defined by the acquisition parameter SOLVENT and perform an auto lock-in accordingly.

- **`lock -noauto`**
  reads the lock parameters for the solvent defined by the acquisition parameter SOLVENT and performs a lock-in (not auto lock-in, see below) procedure.

**lock** reads the lock parameters from the lock table which has been set up with the command `edlock`. (see table 4.1).

The auto lock-in procedure involves the following steps:

1. Irradiation of the lock nucleus with frequency *Lock Freq + Distance*
2. Acquisition of the reflected lock signal
3. Fourier transform and magnitude calculation of the acquired FID
4. Determination of the position of the lock signal in the spectrum.
5. Adjusting the Field such that the lock signal is exactly on resonance.
6. Optimization the lock power, lock gain and lock phase.
Note that the lock irradiation frequency ($\text{Lockfreq} + \text{Distance}$) is solvent dependent. The value of Distance is the chemical shift of the lock nucleus in the current solvent. As such, the irradiation frequency is approximately on resonance and lock needs to make only minimum field adjustments. The advantage of this procedure is that the signal of the reference substance (e.g. TMS) appears at approximately the same position for each solvent. This is the difference between the BSMS lock unit and the SCM lock unit. The latter use the same lock irradiation frequency for each solvent and shift the field to put the lock signal on resonance. Note that all Avance and some AMX/ARX spectrometers are equipped with a BSMS unit.

The command `lock -noauto` simply reads the lock parameters and performs a lock-in accordingly. It does not adjust the field, nor does it optimize any lock parameters. `lock -noauto` is typically used for samples with multiple lock nuclei or mixed solvents. The advantage is that you are sure to lock-in on the lock nucleus that corresponds to the lock parameters whereas the auto lock-in procedure would use the nucleus with the strongest signal.

`lock` reads the regulator parameters loop gain, loop time and loop filter from the lock table. However, these are only used after lock-in has been performed, i.e. after the `lock` command has finished. During the lock-in process fixed regulator values are used.

<table>
<thead>
<tr>
<th>Lock parameters</th>
<th>Description</th>
<th>BSMS keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>field (H0)</td>
<td>FIELD</td>
</tr>
<tr>
<td>LPower</td>
<td>lock power</td>
<td>LOCK POWER</td>
</tr>
<tr>
<td>LPhase</td>
<td>lock phase</td>
<td>LOCK PHASE</td>
</tr>
<tr>
<td></td>
<td>- lock gain</td>
<td>LOCK GAIN</td>
</tr>
<tr>
<td>LGain</td>
<td>loop gain</td>
<td>Menu a</td>
</tr>
<tr>
<td>Ltime</td>
<td>loop time</td>
<td>Menu a</td>
</tr>
<tr>
<td>LFilt</td>
<td>loop filter</td>
<td>Menu a</td>
</tr>
<tr>
<td>Distance</td>
<td>lock freq shift</td>
<td>LOCK SHIFT</td>
</tr>
</tbody>
</table>

Table 4.1

a. Can be modified by simultaneously pressing the buttons indicated with `MENU`
The lock signal can be viewed in the lock display window which can be opened with the command `lockdisp` (see the description of this command).

The lock-in procedure can also be performed from the BSMS keyboard by pressing the **Autolock** or **Lock On/Off** key. In that case the lock parameter values that are currently stored on the BSMS unit are used. These can be modified from the BSMS keyboard as indicated in table 4.1 or read from the lock table with the command `lopo`. As such,

\[lopo \rightarrow \text{Autolock} \] is equivalent to \[lock\]

\[lopo \rightarrow \text{Lock On/Off} \] is equivalent to \[lock \ -\text{noauto}\]

For information on how to determine the lock parameters click **Help → Other topics → Avance Users Guide**. Furthermore, you can refer to the spectrometer hardware documentation. This can be viewed by inserting the BASH CDROM and clicking **Help → Other topics → BASH spectrometer documentation**.

**INPUT PARAMETERS**

set by the user with `eda` or by typing `solvent` etc.:

- SOLVENT - sample solvent (input for `lock -acqu` and `lock -auto`)
- LOCNUC - lock nucleus

set by the user with `edlock`:

- see table 4.1

**INPUT FILES**

- `<du>/data/<user>/nmr/<name>/<expno>/acqu` - acquisition parameters
- `<xwhome>/conf/instr/probehead` - current probehead as defined with `edhead`
- `<xwhome>/conf/instr/<instrum>/2Hlock` - lock table for nucleus 2H
- `<xwhome>/conf/instr/<instrum>/19Flock` - lock table for nucleus 19F
- `<xwhome>/conf/instr/<instrum>/prosol/<probeID>/<solvent>/bsmspar` - solvent and probehead dependent lock parameters
USAGE IN AU PROGRAMS

LOCK
executes the command `lock -acqu`.

SEE ALSO
edlock, lopo, lopoi, lockdisp, lgain, ltime, lfilter
lockdisp

NAME
lockdisp - open the lock display window

DESCRIPTION
The command `lockdisp` opens the lock display window in which the lock signal is shown. The lock signal is the NMR signal of the lock nucleus which is usually 2H.

The lock display can be used in two different ways:

1. When the field is unlocked.
   In this case the lock frequency is swept and lock signal shows a pattern of wiggles with a maximum intensity at the resonance frequency. This pattern can be used to set the field value and lock phase. The field value can be adjusted from the BSMS keyboard until the maximum lock signal lies at the center of the lock display window. The lock phase can be adjusted until the intensity is about the same on both sides of the center.

2. When the field is locked.
   In this case the lock frequency is kept at the resonance position of the lock nucleus and is only adjusted in responds to changes in the magnetic field. The lock signal is a horizontal line in the upper part of the lock display window. Furthermore, the position of this line can be used for shimming the magnet. When the homogeneity of the field improves, the lock signal increases, i.e. the line moves upward.

The lock display window offers the following buttons:

`mode`
toggles between two color modes. In one mode, forward and backward sweep have the same color. In the other mode, they have different colors.

`store`
prompts you for a filename to save the current size and position of the lock display window and the current `grid` and `mode` settings. The `read` button allows you to read previously saved settings. `lockdisp` starts up with standard settings which are stored in the file `default`. If this file does not exist, it start up with program internal default settings.
read
prompts you for the name of a lock display file which has previously been stored with store. After reading in this file, the lock display window is adjusted accordingly.

quit
closes the lock display window

INPUT AND OUTPUT FILES
<xwhome>/exp/stan/nmr/loc_win/

default - current lock display settings

SEE ALSO
lock, edlock
lopo, lopoi

NAME
lopo - set the lock parameters
lopoi - set the lock parameters interactively

DESCRIPTION
The command lopo reads the lock parameters from edlock table for the solvent defined by the acquisition parameter SOLVENT. As such, the lock power, loop gain, loop time, loop filter, lock phase and frequency shift are set to the lock table values of Lpower, LGain, LTime, LFilt, LPhase and Distance, respectively. These values are set on the BSMS unit without performing lock-in.

lopo is useful if you want to observe the lock signal first. The lock-in procedure can then be performed by pressing the Lock On/Off or Autolock key on the BSMS keyboard. Note that

lopo → Autolock is equivalent to lock -acqu
lopo → Lock On/Off is equivalent to lock -noauto

The command lopoi works like lopo, except it does not interpret the parameter SOLVENT. lopoi shows a list of available solvents from which you can select one. It then sets the lock parameters according to the edlock table.

INPUT PARAMETERS
set by the user with eda or by typing solvent etc.:

SOLVENT - sample solvent
LOCNUC - lock nucleus

set by the user with edlock:

see table 4.1

INPUT FILES
<du>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters
<xwhome>/conf/instr/
probehead - current probehead as defined by `edhead`

```
<xwhome>/conf/instr/<instrum>/
```

- `2Hlock` - lock table for nucleus 2H
- `19Flock` - lock table for nucleus 19F

```
<xwhome>/conf/instr/<instrum>/prosol/<probeID>/<solvent>/
```

- `bsmspar` - solvent and probehead dependent lock parameters

**USAGE IN AU PROGRAMS**

- `LOPO`

**SEE ALSO**

- `lock`, `edlock`, `lockdisp`, `lgain`, `ltime`, `lfilter`
Lock commands
Chapter 5

Shim commands

This chapter describes the commands which are involved in shimming the magnet. Shimming can be started with reading an appropriate shim set for the current sample and then optimizing the shim from the BSMS keyboard. In automation, the optimization is performed by an automatic shimming procedure. Furthermore, if you are using a gradient probehead, you can perform gradient shimming.
**NAME**

autoshim - autoshim switching

**DESCRIPTION**

The command `autoshim` controls the autoshim function of the BSMS unit. It takes one argument and can be used as follows:

- **autoshim on**
  turn autoshimming on
- **autoshim off**
  turn autoshimming off

Entering `autoshim` on the command line has the same effect as pressing the AUTOSHIM key on the BSMS keyboard. The shims for which the step size is set to a value greater than 0 are optimized. It is typically used in automation.

**USAGE IN AU PROGRAMS**

- AUTOSHIM_ON
- AUTOSHIM_OFF

**SEE ALSO**

- tune, edtune, rsh, wsh, setsh, vish, delsh
edtune

NAME
edtune - edit tune file

SYNTAX
edtune [<name>]

DESCRIPTION
The command *edtune* allows you to edit an existing tune file or create a new one. Tune files are used by the *tune* command that performs automatic shimming.

*edtune* takes one argument and can be used as follows:

*edtune*
Shows a list of existing tune files. You can click an entry to edit the corresponding file or you can enter a name in the field *Type New Name*. In the latter case, an empty file will be opened and can be set up as a new tune file.

*edtune* <name>
Edits the specified tune file. If the specified file does not exist, an error message will appear.

The format of a tune file is described for the *tune* command. Two example files, *example* and *example_bsms* are delivered with XWIN-NMR.

INPUT FILES
<xwhome>/exp/stan/nmr/lists/group/

- example - standard tune file for spectrometers with a SCM unit
- example_bsms - standard tune file for spectrometers with a BSMS unit
- my_tunefile - user defined tune file

SEE ALSO
tune, rsh, wsh, setsh, vish, delsh, gradshim
NAME
rsh - read a set of shim values

SYNTAX
rsh [<name>]

DESCRIPTION
The command rsh reads a set of shim values to the shim unit. rsh without arguments opens a dialog box with a list of available shim sets. When you click on a shim set, its values are loaded to the shim unit. rsh can also be entered with a shim file as an argument.

After reading a shim file, it is usually necessary to optimize the shims, especially the Z and Z² shim. You can do that from the BSMS keyboard or from the BSMS display (command bsmsdisp).

rsh switches the autoshim function of the BSMS unit off. If you press the AUTOSHIM key on the BSMS keyboard or enter autoshim on, the shims will be continuously optimized during the experiment.

If you specify an argument, then it may contain wildcards; for example:

rsh a* lists all shim files beginning with a
rsh [m-z]* lists all shim files beginning with m,n,...,z

Shim files can be stored with the command wsh and viewed with vish. Single shims can be set with setsh.

INPUT FILES
<xwhome>/exp/stan/nmr/lists/bsms/

  shim files

USAGE IN AU PROGRAMS
RSH(name)
SEE ALSO

wsh, setsh, vish, delsh, edtune, tune, gradshim
**setsh**

**NAME**

setsh - set a single shim

**SYNTAX**

setsh [name] [value]

**DESCRIPTION**

The command *setsh* allows you to set single shims. It takes two arguments and can be used in one of the following ways:

- **setsh**
  prompts you for a shim and a value and then sets the specified shim accordingly

- **setsh <shim>**
  prompts you for a value and then sets the specified shim accordingly

- **setsh <shim> <value>**
  sets the specified shim to the specified value

Entire shim sets can be read to the shim unit with *rsh*, stored with *wsh* and viewed with *vish*.

**USAGE IN AU PROGRAMS**

SETSH(shim, value)

**SEE ALSO**

rsh, wsh, vish, delsh, edtune, tune, gradshim
tune

NAME

tune - perform automatic shimming of the magnet

SYNTAX

tune [ <tunefile> | .sx ]

DESCRIPTION

The command **tune** shims the magnet in an automatic procedure according a shim definition file. This file is called the tune file and can be set up with the command **edtune**.

The command **tune** takes one argument and can be used in one of the following ways:

- **tune**
  displays a list of available tune files. When you click an entry, the corresponding tune file is interpreted and auto shimming is performed accordingly.

- **tune <tunefile>**
  performs auto shimming according to the specified tune file.

- **tune .sx**
  performs auto shimming according to the tune file as it is specified for the current probehead. This tune file can be setup from the **edprosol** dialog box by clicking **File → Edit Tunefile**

A example tune file is delivered with XWIN-NMR. You can use this as it is or modify it to your needs and store it under a different name. The statements you can use in a tune file are listed below. Note that some of these statements are settings whereas others are commands.

**Settings in a tune file:**

- **USE_FIDAREA**
  Flag indicating to use the area under the FID envelope as a criterion for field homogeneity.

- **USE_LOCKLEVEL**
Flag indicating to use the lock level as a criterion for field homogeneity.

**LOCKD<algorithm> n**

The number of measurements used for determining the current lock level. The measured values are averaged to suppress the effects of the noise on the lock level. Only used when USE_LOCKLEVEL is defined.

**MAXLOCK m**

The maximum lock level. Can be used to keep the lock signal from moving out of the display during the shimming procedure. The lock level is displayed at the XWIN-NMR status line while tune is running.

**DELAY n**

The time (in seconds) between adjusting a shim and reading the new lock level. In the example tune file, DELAY is set to one second which is usually enough for the lock level to settle.

**SET <shim> w c**

Set the maximum step size (width) and the convergence limit for the SIMPLEX command. These parameters can be set for each shim separately. An example is:

```plaintext
SET Z1 20 3
```

**TIMES m**

Loop structure; all statements within the loop will be executed m times. Nested loops are possible to a depth of five.

**Commands in a tune file**

**ROTATION ON WAIT**

Switches the sample rotation on using the spin rate currently set on the BSMS unit.

**ROTATION OFF WAIT**

Switches the sample rotation off.
**RSH, RSH <filename>**

Reads a shim file. If an argument is specified, RSH will read the corresponding shim file. If not, it will read the shim file with the name of the solvent defined by the acquisition parameter SOLVENT.

**Z s i, Z2 s i, ..., XY s i**

Optimizes single shims. These commands take two arguments:

- \textit{s} = step size; the shim increment used as long as the lock level increases
- \textit{i} = iterations; the maximum number of steps after passing the maximum

A shim is first changed \textit{s} units in one direction. If this increases the lock level, the shim is changed again \textit{s} units in the same direction. This is repeated until a shim change decreases the lock level. Then the direction of change is reversed and the step size is reduced. This process is continued until one of the following criteria has been met:

- the lock level has not changed significantly during the last step
- the maximum number of iterations (i) has been performed
- the step size has been reduced to one

Examples of shim commands are:

- Z 10 3
- Z2 10 3
- Z3 10 3

**SIMPLEX <shim1 shim2 etc.>**

Optimizes the specified shims according to the simplex algorithm which can be used for lock level and FID area shimming. SIMPLEX uses the step size and convergence limit defined by the SET statement (see above). The simplex algorithm is described in the example file (see INPUT FILES below).

**AUTOSHIM ON <shim1=m, shim2=n, ...>**

Switches on the automatic shimming function on the shim unit after the tune command has finished. This command allows you to adjust the shims continuously during the entire experiment. Only the shims that are specified as arguments to the AUTOSHIM ON command will be optimized. For each shim, you can specify the step size used for auto shimming. If you do not specify the step size, the default value of 5 is used. An example of this command is:
Shim commands

AUTOSHIM ON Z1=2 Z2

Since this command becomes effective after the tune command has finished, it can be specified anywhere in the tune file.

AUTOSHIM OFF

Switches off automatic shimming on the shim unit. It makes sure that automatic shimming is switched off when it was switched on before, either from the last executed tune file or manually from the BSMS keyboard. Note that it would not make sense to use AUTOSHIM ON and AUTOSHIM OFF within one tune file.

LOCKPHASE s i

Optimize the lock phase. This command takes two arguments:

s = step size
i = iterations; the maximum number of steps

As an alternative to the automatic shimming with tune, you can optimize the shims manually from the BSMS keyboard. If the shims are far away from the optimum, you can read a standard shim set with the command rsh and then do manual shimming.

An alternative to the simplex procedure in tune is the AU program simplex.

INPUT FILES

<xwhome>/exp/stan/nmr/lists/group/
example - tune file for BSMS (XWIN-NMR 3.1 and newer)¹
example - tune file for SCM/BSN18 (XWIN-NMR 3.0 and older)
example_bsms - tune file for BSMS (XWIN-NMR 3.0 and older)

<xwhome>/conf/instr/<instrum>/prosol/<probeID>/
tunefile - tune file for the current probehead (input for tune .sx)

USAGE IN AU PROGRAMS

TUNE(tunefile)

¹. Note that all Avance spectrometers have BSMS. Some AMX/ARX spectrometers have BSMS, other have SCM/BSN18.
TUNESX
  executes the command \texttt{tune \ .sx}

\textbf{SEE ALSO}
  edtune, gradshim, rsh, wsh, setsh, vish, delsh
**vish**

**NAME**

vish - view a shim file

**SYNTAX**

vish [<name>]

**DESCRIPTION**

The command `vish` allows you to view a shim file. It takes one argument and can be used in one of the following ways:

- **vish**
  opens a dialog box with a list of available shim files. When you click a shim file, it is opened for viewing.

- **vish <name>**
  opens the specified shim file for viewing

If you specify an argument, then it may contain wildcards; for example:

- **vish tol*** lists all shim files beginning with `tol`
- **vish [m-z]*** lists all shim files beginning with `m, n, ..., z`

Shim files can be stored with `wsh` and read to the shim unit with `rsh`. Single shims can be set with `setsh`.

**INPUT FILES**

- `<xwhome>/exp/stan/nmr/lists/bsms/`
- shim files

**SEE ALSO**

rsh, wsh, setsh, delsh, edtune, tune, gradshim
wsh

NAME
wsh - write a set of shim values

SYNTAX
wsh [<name>]

DESCRIPTION
The command wsh writes the shim values which are currently installed on the shim unit to a shim file. It takes one argument and can be used in one of the following ways:

wsh
opens a dialog box with a list of currently available shim files. Existing shim files can be overwritten or a new name can be entered.

wsh <name>
writes the current shim values to a file with the specified name. The name of a shim file can be freely chosen.

If you specify an argument, then it may contain wildcards; for example:

wsh tol*
lists all shim files beginning with tol
wsh [m-z]*
lists all shim files beginning with m,n,....z

Shim files can be read with the command rsh and viewed with vish. Single shims can be set with setsh.

OUTPUT FILES
<xwhome>/exp/stan/nmr/lists/bsms/
shim files

USAGE IN AU PROGRAMS
WSH(name)

SEE ALSO
rsh, setsh, vish, delsh, edtune, tune, gradshim
Chapter 6

Probehead commands

This chapter describes the commands which are involved in probehead handling. This involves selecting the current probehead, the tuning and matching procedure and sample insert and eject.
atma

NAME
atma - automatic tuning and matching of ATM probeheads

USAGE
atma [exact | course] [high]
Type atma ? for a complete list of options.

DESCRIPTION
The command atma performs tuning and matching of an ATM probehead. It will automatically perform the following steps:
1. Stop the sample rotation if it is on.
2. Read the nucleus with the lowest frequency as it was set up with edasp.
3. Determine the optimum sweep width and number of steps.
4. Tune and match the probehead.
5. Repeat step 3 to 4 for all other nuclei which were set up with edasp in the order of increasing frequency.
6. Turn on the sample rotation if it was on before atma was started

The command atma can be used with various options, for example:

atma exact will determine the optimum tuning and matching more precisely then atma without an argument and will therefore be slower.
atma course will determine the optimum tuning and matching less precisely then atma without an argument will therefore be faster.
atma high will start with the nucleus with the highest frequency, and tune and match the probehead for each nucleus in the order of decreasing frequency.

Type atma ? for a complete list of options.

On ATM probeheads, atma can be used instead of the wobb. These two commands differ in the following respects:
• \textit{atma} is fully automatic whereas \textit{wobb} requires the user to perform the tuning and matching manually.

• \textit{atma} automatically determines the optimal sweep width and number of steps whereas \textit{wobb} uses the values of WBSW and WBST, respectively.

• \textit{wobb} must be terminated with \textit{stop} or \textit{halt} whereas \textit{atma} automatically finishes when optimum tuning and matching is reached. If you want to interrupt \textit{atma}, you can do that with the command \textit{kill}.

Automatic tuning and matching is not only convenient, it also allows you to tune and match the probehead during automaton. In ICON-NMR, you can choose to do that before each experiment, after each sample change or after each solvent change.

\textit{atma} is supported with XWIN-NMR 2.6 and later.

For more information on the tuning and matching process, see \textit{wobb}.

For more information on the command \textit{atma} and ATM probeheads, see Help \rightarrow Other topics \rightarrow Automatic Tuning and Matching.

\textbf{INPUT PARAMETERS}

NUC1 - NUC4 - nuclei as defined with \textit{edasp}

\textbf{INPUT FILES}

<du>/data/<user>/nmr/<name>/<expno>/
  acqu - acquisition parameters

<xwhome>/conf/instr/<instrum>/
  nuclei - nuclei table

<xwhome>/prog/wobble/
  acqu_go4 - wobble parameters
  Pulsprog_X - wobble pulse program

\textbf{SEE ALSO}

atmm, wobb
atmm

NAME
atmm - manual tuning and matching of ATM probeheads

USAGE
atmm [manWbsw]
Type atmm ? for a complete list of options.

DESCRIPTION
The command atmm is a manual tuning and matching procedure for ATM probeheads. It is not needed very often because ATM probes are designed for automatic tuning and matching with atma. Sometimes, however, the probeheads resonance frequency is so far away from the optimum that atma would take very long to finish or would fail. In practice, this only occurs for certain nuclei at broadband probeheads. In that case, atmm allows you to manually tune and match the probehead for that nucleus.

atmm performs the following steps:

1. It reads the nucleus with the lowest frequency as it was set up with edasp.
2. It determines the optimum sweep width and number of steps.
3. It shows the reflected power (tuning/matching curve) in the XWIN-NMR acquisition data field.
4. It opens the atmm control window from where you can:
   • Select the nucleus for which you want to tune and match the probehead. By default, the nucleus with the lowest frequency is selected.
   • Perform course tuning/matching on broadband probeheads. This is the equivalent of setting the sliders on a non ATM probehead to predefined numbers.
   • Perform fine tuning/matching while observing the curve in the XWIN-NMR acquisition data field. This is the equivalent of turning the knobs or moving the sliders on a non ATM probehead. See wobb for a description on how to reach the optimum tuning and matching.
• Click *File → Quit* to finish the tuning/matching process.

`atmm` can be used with various options. For example, `atmm manWbsw` does not determine the sweep width and number of steps automatically but interprets the parameters WBSW and WBST, respectively. `atmm ?` will show you a complete list of options.

The difference between `atmm` and `wobb` is that:

• `atmm` can only be used on ATM probeheads.

• `atmm` automatically determines the optimum sweep width and number of steps whereas `wobb` uses the values of WBSW and WBST, respectively.

• `atmm` allows you to optimize tuning and matching from XWIN-NMR whereas `wobb` requires you to turn the knobs (or move the sliders) on the probehead.

`atmm` is supported with XWIN-NMR 2.6 and later.

For more information on the tuning and matching process, see `wobb`.

For more information on the command `atmm` and ATM probeheads, see *Help → Other topics → Automatic Tuning and Matching*.

**INPUT PARAMETERS**

NUC1 - NUC4 - nuclei as defined with `edasp`
WBSW - sweep width (only used by `atmm Manwbsw`)
WBST - number of steps (only used by `atmm Manwbsw`)

**INPUT FILES**

<du>/data/<user>/nmr/<name>/<expno>/
   acqu - acquisition parameters

<xwhome>/prog/wobble/
   acqu_go4 - wobble parameters
   Pulsprog_X - wobble pulse program

**SEE ALSO**

`atma`, `wobb`
edhead

NAME
edhead - edit probehead table

DESCRIPTION
The command edhead opens the probehead table. Each entry in this table contains a probehead name and reference number. A typical entry is:

5 mm Dual 13C/1H [03]

The entry which is defined as the current probehead, is highlighted.

The probehead table has a menu Probe in the upper left corner that offers the following commands:

New Probe
The probehead parameter editor will be opened where you can define a new probehead. You can do that by setting the probehead parameters (see below). The name of the new probe will be the combination:

Sample diameter  Probe Type  Coil Nuclei  Part number  Serial number

Note that the Part number and Serial Number are only part of newly defined probes, not of the probes in the standard list delivered with XWIN-NMR. The reference number of a new probe will be the first unused number available. This usually the number of the last entry plus one.

Copy Probe
The current probehead will be copied to a new probehead with the same name. The new probe is added at the end of the list. The reference number will be the first unused number available. This usually the number of the last entry plus one.

Delete Probe
The current probehead will be deleted. Its reference number will be unused until a new probehead is defined.

1. If a probe was deleted and left an unused reference number, this is assigned to the new probe.
**Define as Current Probe**

The highlighted entry will be defined as current probehead. If no entry is highlighted, an error message will appear. If the highlighted probehead has not been defined before, you will be prompted with the question:

*Do you want to create the probe parameters?*

If you click *No*, no probehead parameters will be stored but the highlighted entry will still be defined as current probehead. If you click *Yes*, the probehead parameter editor will be opened (see below).

**Edit Probe parameters**

When you click this button, a dialog box with various probehead parameters will appear (see below).

**Exit**

Close the probehead table, saving all changes.

The menu entries *Define as current probe, Edit probe parameters* and *Exit* are also available as buttons at the bottom of the edhead dialog box.

The probehead parameter editor displays four groups of parameters:

*Production parameters* like:
  
  - Probe type
  - Part number
  - Serial number
  
*Sample parameters* like:
  
  - Sample diameter
  - Sample depth

*Temperature parameters* like:
  
  - Type of sensor
  - Lowest allowed temperature
  - Highest allowed temperature

*Coils parameters* like:
  
  - Number of coils
Gas compensation
Inside coil nuclei
Outside coil nuclei

History:
A text field where any information about the probe can be entered

Some probeheads have an additional parameter group, e.g.:

Broadband probes: Tuning and Matching parameters
Flow probes: Probe flow parameters

Note the probe parameters are just information for the user. They are not required for the acquisition and they are not interpreted by any XWIN-NMR command.

The current probehead as defined with edhead, is interpreted by the commands edprosol, edlock, lock, lopo and setpre as well as during ICON-NMR automation. At the end of an acquisition the current probehead is stored as the acquisition status parameter PROBHD (see dpa).

edhead can also be executed as a part of the XWIN-NMR configuration suite (command config).

INPUT FILES
<xwhome>/exp/stan/nmr/lists/
probeheads.all - default probehead list (input of first time edhead)
<xwhome>/prog/tcl/xwish3_scripts
edhead - Tcl/Tk script that is started by edhead

INPUT AND OUTPUT FILES
<xwhome>/exp/stan/nmr/lists/
probeheads - probehead list (input of 2nd and later edhead and output)
<xwhome>/conf/instr/
probehead - current probeheads name and reference number
<xwhome>/conf/instr/probeheads
<part #>_<serial #>_<reference #>.par - probe parameters
SEE ALSO

cf, atma, atmm, wobb
ej, ij

NAME

ej - eject the sample from the magnet
ij - insert the sample into the magnet

DESCRIPTION

The command ej ejects the sample from the magnet. It switches on the air flow and keeps it on until it is explicitly switched off, for example with ij.

The command ij inserts the sample into the magnet. This command is used when the magnet air flow is on and the sample is floating on top of it. ij gradually reduces the air flow to zero so that the sample is lowered into the magnet.

As an alternative to the command ej and ij, you can also press the LIFT ON/OFF button on the BSMS keyboard.

The SAMPLE DOWN indicator in the shimming panel of the BSMS keyboard is lit when the sample is positioned correctly in the probe. The SAMPLE UP indicator is lit when the sample has reached the top of the magnet. The SAMPLE MISSING indicator is lit if the sample is somehow positioned between the magnet top and the probehead, either moving up or down or being stuck. The latter can happen, for instance, when the air flow is too high.

USAGE IN AUTOMATION

EJ
IJ

SEE ALSO

ro
**RO**

**NAME**

ro - switch the sample rotation on or off

**SYNTAX**

ro [ acqu | off | off wait ]

**DESCRIPTION**

The command ro switches the sample rotation on or off. It takes two arguments and can be used as follows:

- **ro**
  
  Allows you to set the spin rate and switch the spinning on. ro first prompts you for the following information:
  
  *Spinning on*: enter yes to switch the spinning on or no if you only want to set the spin rate.
  
  *Spinning rate*: enter the demand spin rate

- **ro on**
  
  Switches the sample rotation on with the spin rate currently set on the BSMS keyboard (visible when you press the SPIN RATE key).

- **ro acqu**
  
  Sets the spin rate to the value of the acquisition parameter RO, then switches rotation on and waits for 60 seconds. If spin rate has not been reached within that time an error message appears.

- **ro off**
  
  Switches the sample rotation off.

- **ro off wait**
  
  Switches the sample rotation off and waits until the rotation has reached zero. During the waiting time the BSMS unit cannot be accessed by other commands.

As an alternative to the command ro, you can press the SPIN ON/OFF, and SPIN RATE keys on the BSMS keyboard or BSMS display (command bsmsdisp)
**INPUT PARAMETERS**

RO - sample rotation frequency (input for *ro acqu*)

**INPUT FILES**

<du>/data/<user>/nmr/<name>/<expno>/

`acqu` - acquisition parameters

**USAGE IN AU PROGRAMS**

ROT

executes the command *ro acqu*.

ROTOFF

executes the command *ro off wait*.

**SEE ALSO**

ij, ej
wobb

NAME
wobb - manual tuning and matching of the probehead

USAGE
wobb [high][ext50][raw][f1|f2]

DESCRIPTION
The command *wobb* allows you to manually tune and match the probehead. An NMR probehead must be tuned and matched because it is a resonance circuit. If its resonance frequency and impedance are the same as the transmitter frequency and impedance, respectively, the full transmitter power is transferred to the probehead. However, if either or both are different, part of the transmitter power is reflected by the probehead. This results in a longer 90° pulse or, for a given pulse length, a smaller flip angle. Note that a multi nuclear probehead has a resonance circuit for each nucleus and each nucleus must be tuned and matched separately.

The command *wobb* is normally used without argument. It can, however, be used with arguments. For example:

- **wobb high**
  starts with the nucleus with the highest frequency and continues in the order of decreasing frequency.

- **wobb ext50**
  uses an external 50 ohm resistor as a reference.

- **wobb f1**
  starts with frequency channel f1. It continues with the next higher frequency or, if the argument *high* is also used, with the next lower frequency.

- **wobb f2**
  starts with frequency channel f2. It continues with the next higher frequency or, if the argument *high* is also used, with the next lower frequency.

The *wobb* command allows you to optimize both the probeheads resonance frequency (tuning) and impedance (matching). It sends a low power RF signal to the probe and sweeps that signal over a certain frequency range. The number of
steps (frequencies) within that range is defined by the acquisition parameter WBST. The width of the frequency range is defined by WBSW. The center frequency depends on the nucleus; SFO1 for NUC1, SFO2 for NUC2 etc. The deviation of the probe impedance from the nominal 50 ohm is shown as function of the frequency in the XWIN-NMR data field. This is the so called wobble curve. At the probeheads resonance frequency, the curve shows a dip, the minimum reflected power. Tuning the probehead means adjusting its resonance frequency until it reaches SFO1. Matching the probehead means adjusting its impedance until the reflected power reaches zero.

The entire wobble procedure involves the following steps:

1. Stop the sample rotation if this is on, for example with `ro off`, or by pressing the SPIN ON/OFF button on the BSMS keyboard.
2. Setup the nucleus or nuclei for the current experiment with `edasp`. This will automatically set the parameters SFO1, SFO2 etc.
3. Click `Acquire -> Observe fid window` or enter `acqu` to switch to the XWIN-NMR acquisition menu. If, however, tuning and matching is observed on the preamplifier, this step can be skipped. (see below).
4. Enter `wobb`. The wobble curve will appear in the XWIN-NMR data field showing a dip at a certain frequency. At the center of the data field, you will see a vertical line. If you do not see the dip, it probably lies outside of the data field. In that case, you should click `wobb-SW` or enter `wbchan` to increase the sweep width. You can do this while `wobb` is running.
5. When the dip is visible, you can start tuning and matching as follows:
   - turn the tuning knob until the dip lies across the vertical line
   - turn the matching knob until the dip has reached a minimum. Matching influences tuning, so the dip probably moves away from the center.
   - turn the tuning knob until the dip lies at the center again. Tuning influences matching, so the dip probably moves up again.
   - turn the matching knob until the dip reaches a minimum again
   - continue this process until the dip lies exactly across the vertical line and reaches the x-axis.
6. In case of a multi nuclei experiment, you have to switch to the next the
nucleus. Note that wobb automatically starts with the nucleus with the lowest basic frequency. You can switch to the nucleus with the next higher frequency in two possible ways:

- press Channel Select at the HPPR. This will automatically select the nucleus with the next higher frequency.
- click wobb-SW or enter wbchan in XWIN-NMR. Answer the question "Do you want to change the nucleus" with yes.

Repeat step 5 for the current nucleus.

7. If your experiment involves more than two nuclei, repeat step 6 for each further nucleus.

8. Click stop or enter stop on the command line to finish the wobble procedure.

A probehead has a tuning knob (labelled T) and matching knob (labelled M) for each resonance circuit. Most probeheads have two, one for 1H and one for X-nuclei. When the tuning knob reaches the end of its range before the probehead is properly tuned, you should turn it to the middle of its range, adjust matching, then tuning, then matching etc. A similar procedure can be used if the matching knob reaches the end of its range.

The process of tuning and matching can also be followed on the HPPR preamplifier. Some people find that more convenient and it is necessary when the computer screen is not visible from the position of the probehead. The horizontal row of LED’s indicates tuning, the vertical row indicates matching. When you turn the tuning or matching knob at the probehead, you will see how the number of lit LED’s changes. The probehead is perfectly tuned when only one LED (a green one) is lit. The same holds for matching. In practice, proper tuning and matching means that only green LED’s are lit. If the LED update seems to be very slow, this might be caused by the time consuming update of the wobble curve in the XWIN-NMR acquisition display. In that case, you can simply click return to switch to the processing menu (main menu).

Broadband probeheads usually have sliders for tuning and matching rather than turning knobs. These have the advantage that their positions are numbered. The default slider positions for each nucleus are usually written on cards that are kept with the probehead. When wobbling is started with these default values, only some fine tuning and matching is required.

The probehead resonance frequency and impedance is dependent on the sample.
This can be a problem in automation, where several samples are measured but the probehead is only matched and tuned on one of them. Bruker ATM probeheads support automatic tuning and matching which can be preformed on every sample during automation (see description of the commands atmm and atma).

**INPUT PARAMETERS**

set by the user with `eda` or by typing `wbst, wbsw` etc.:
- **WBST** - number of wobble steps
- **WBSW** - wobble sweep width

set by the user with `edasp` or `eda` → NUCLEI:
- **NUC1** - **NUC4** - the nuclei for which the probehead is tuned and matched
- **SFO1** - **SFO4** - irradiation frequency

**INPUT FILES**

- `<du>/data/<user>/nmr/<name>/<expno>/ acqu`
  - acquisition parameters
- `<xwhome>/prog/wobble/ acqu_go4`
  - wobble parameters
- `Pulsprog_X` - wobble pulse program

**SEE ALSO**

- `atma`, `atmm`, `edasp`
Chapter 7

Parameter handling commands

This chapter describes commands which are involved in parameter handling. This involves the setting of acquisition parameters, probehead/solvent dependent parameters and nuclei assignment. Furthermore, the usage of predefined parameters sets is discussed.
ased, as

NAME
ased - edit the acquisition parameters used in the current pulse program
as - same as ased but prompts the user for each parameter

DESCRIPTION
The command ased opens a dialog box in which you can set the acquisition parameters which are used for the current experiment. This means that ased shows much less parameters then eda which shows all acquisition parameters.

ased shows three types of parameters, namely parameters that are:
- used in all experiments like NS, TD etc.
- defined by edasp like NUC1, SFO1, NUC2, SFO2 etc.
- interpreted by the current pulse program, e.g. D[1], P[1], PL[1] etc.

ased compiles and interprets the pulse program defined by PULPROG. For pulses, delays and constants, the parameter description in the right column of the ased window is taken from the comment section at the end of the pulse program.

as works like ased except that it prompts the user for each parameter.

INPUT AND OUTPUT PARAMETERS
for all experiments:
- PULPROG - pulse program used for the acquisition
- TD - time domain; number of raw data points
- NS - number of scans
- DS - number of dummy scans
- SWH - spectral width in Hz
- AQ - acquisition time in seconds
- RG - receiver gain
- DW - dwell time
- DE - pre-scan delay

for each frequency channel defined with edasp:
- NUCx - nucleus for channel x
SFOx - irradiation frequency for channel x

all delays, pulse lengths, power levels etc. defined in the pulse program, e.g.:

D[1] - relaxation delay
P[1] - 90° pulse length
PL[1] - power level for pulse
PCPD[1] - CPD pulse length

INPUT FILES

<xwhome>/exp/stan/nmr/lists/pp/

the pulse program defined by PULPROG

<du>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters

OUTPUT FILES

<du>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters

SEE ALSO

eda, edcpul
**dpa**

**NAME**

dpa - display the acquisition status parameters

**DESCRIPTION**

The command **dpa** displays the acquisition status parameters. These are set by acquisition commands and represent the status of the raw data.

The **dpa** dialog box offers the following buttons/fields:

- **Done**
  closes the **dpa** window or, on 2D or 3D data, go to the next dimension

- **1-Col**
  changes to one column display mode. In this mode a short description is shown for each parameter.

- **Parameter**
  allows you to search for a parameter. Just enter the parameters name (or a part of it) and hit the **Enter** key. The **dpa** window will scroll to the parameters position. If nothing happens, the parameter does not exist or is on the currently displayed page.

- **Next**
  selects the next parameter which starts with the string in the **Parameter** field

Acquisition status parameters can also be viewed by entering their names on the command line. For example:

On a 1D dataset:

```
1s ns
```

displays the acquisition status parameter NS

On a 2D dataset:

```
2s td
```

displays the F2 acquisition status parameter TD

```
1s td
```

displays the F1 acquisition status parameter TD
On a 3D dataset, the preposition $3s$ can be used for the F3 dimension.

The NMR Superuser can change the $dpa$ dialog box, for example remove parameters which are not used. This can be done from the Windows Explorer or from a UNIX shell by editing the file normdp (see below).

**INPUT FILES**

<xwhome>/exp/stan/nmr/form/acqu.l/
   normdp - format file for $dpa$

On 2D and 3D data the directories acqu2.l and acqu3.l contain a normdp file for the indirect dimensions.

<du>/data/<user>/<name>/nmr/<expno>/
   acqus - acquisition status parameters

On 2D and 3D data the files acqu2s and acqu3s are used for the indirect dimensions, respectively (see also chapter 2.3).

**SEE ALSO**

edac, lpa, dp, dpc, dpo, dpp, dpg, dpgx
eda

NAME

eda - edit acquisition parameters

DESCRIPTION

The command eda opens a dialog box in which you can set all acquisition parameters. This dialog box offers the following buttons/fields:

- **Save**
  saves all parameters

- **1-Col**
  changes to one column display mode. In this mode a short description is shown for each parameter.

- **Parameter**
  allows you to search for a parameter. Just enter the parameters name (or a part of it) and hit the **Enter** key. The eda window will scroll to parameters position and select it. Note that the parameter might be on the current page.

- **Next**
  selects the next parameter which starts with the string in the **Parameter** field.

- **Cancel**
  leaves eda without saving any changes

The disadvantage of eda is that it shows many parameters, most of which do not have to be changed for a standard experiment. Generally, it is more convenient to use aed to set the acquisition parameters. This command only shows the parameters which are actually used for the current experiment.

Apart from using eda or aed, you can also set acquisition parameters by entering there names on the command line, e.g.:

```plaintext
ns
```

prompts you to enter the number of scans.

```plaintext
ns 1000
```

sets the number of scans to 1000

For 2D datasets, eda shows one column of parameters for the F2 dimension and
one for the F1 dimension. The **I-Col** button is not available. Note that most parameters are not dimension specific and, as such, appear for the F2 dimension only. 2D parameters can also be set from the command line, e.g.:

- **td 4k**
  - sets the F2 time domain to 4k

- **2 td 4k**
  - sets the F2 time domain to 4k (same as **td 4k**)

- **1 td 4k**
  - sets the F1 time domain to 4k

For 3D dataset, **eda** shows an extra column for the third dimension.

The NMR Superuser can change the **eda** dialog box, for example remove parameter which are not used. This can be done from the Windows Explorer or from a UNIX shell by editing the file **acqu.e** (see below).

**INPUT AND OUTPUT PARAMETERS**

All acquisition parameters.

**INPUT FILES**

- `<xwhome>/exp/stan/nmr/form/`  
  - **acqu.e** - format file for **eda**

**INPUT AND OUTPUT FILES**

- `<du>/data/<user>/<name>/nmr/<expno>/`  
  - **acqu** - acquisition parameters for the acquisition (direct) dimension
  - **acqu2** - acquisition parameters for F1 indirect dimension (2D) or F2 (3D)
  - **acqu3** - acquisition parameters for the F1 dimension (3D)

**SEE ALSO**

- ased, dpa
edasp

NAME

edasp - set up nuclei and spectrometer routing

DESCRIPTION

The command edasp allows you to set up the nuclei and the spectrometer routing for the current experiment. It opens the routing table showing the current nuclei selection and amplifier routing. Here you can specify the nucleus or nuclei to be used for the experiment. For the f1 logical frequency channel, you can click the NUC1 button and select a nucleus from the appearing list. The basic frequency, BF1, is automatically set. Then you can specify the frequency offset; OFSH1 for 1H or OFSX1 for X nuclei. The irradiation frequency SFO1 is automatically calculated as the sum of the basic frequency and frequency offset. Note that the parameters NUC1, BF1 and SFO1 also appear in eda but cannot be set from there. However, the frequency offset (OFSH1 or OFSX1) appears in eda as O1 and can be set from there. In a multi nuclear experiment, you can set up the parameters for channel f2, f3 etc. in the same way as described for f1.

The routing table also shows the spectrometer routing. The hardware elements which have been detected when the spectrometer was configured (with cf or config) will appear in this list. When you select a nucleus for a certain channel, the default routing is automatically set. Normally, this can be left as it is. Only in very special cases it is useful to change it. The routing table consists of the following stages:

Channel---FCU---Amplifier---Swibox/I ---Swibox/O ---Preamplifier

You can set up the routing by connecting an element from one stage to an element of the next stage. A connection can be installed or removed by clicking the two elements involved. The routing must follow following rules:

a) Between the logical frequency channels and FCU’s any combination is allowed but only one to one.

b) An FCU can be connected to one amplifier only but an amplifier can be connected to multiple FCU’s. Furthermore, FCU1 can only be connected to the first three amplifiers and FCU2 can only be connected to the first four amplifiers.
c) The first four Amplifiers are automatically connected to Switchbox input in a fixed way. These connections cannot be changed.

d) Between the Switchbox input and Switchbox output, any connection is allowed but only one to one.

e) Between the Switchbox output and the Preamplifier modules, any connection is allowed but only one to one. Make sure that the cables are connected accordingly.

f) The output of the fifth and sixth amplifier must be connected directly to the Preamplifier modules. Any combination is allowed but only one to one and only to Preamplifier modules which are not connected to a Switchbox output.

Avance spectrometers which are used for solid state experiments usually contain high power amplifiers with two output stages:

- a low power output: typically 150 W for 1H or 300 W for X nuclei.
- a high power output: typically 1000 W for 1H or X nuclei

The second output appears as an extra stage in the routing table to the right of the switchbox. If you use the second output stage, the switchbox is always bypassed.

If you make a routing connection which is not allowed, you will get a message that it is illegal. You must remove it before you can save the routing table. Some connections are allowed but not recommended. In that case, you only get a warning.

Two extra switches are available to control the routing:

- **Preferred preamplifier**
  
  toggle between selective and unselective Preamplifier module

- **Preferred output for 19F**
  
  toggle between the 19F and X Switchbox output for 19F nucleus

When you change these settings, you must click the DEFAULT button to make them effective.

At the bottom of the NUCLEI table you will find the following buttons:

- **SAVE** - save the routing table and quit

- **SWITCH F1/F2** - exchange the F1 and F2 nucleus including the frequency
and frequency offset

SWITCH F1/F3 - exchange the F1 and F3 nucleus including the frequency and frequency offset

DEFAULT - set the default amplifier routing for the current nuclei

CANCEL - quit without saving any changes

PARAM - shows the routing parameters

In a 2D dataset, NUCLEI has a different functions in the two dimensions. In F2, it works like in 1D experiments; it opens the routing table. In F1, it opens the nuclei list and allows you to select the nucleus for this dimension. The same principle holds for 3D data; in F3, NUCLEI opens the routing table, in F2 and F1 it opens the nuclei list.

The spectrometer routing is stored under the current dataset in the acquisition parameters FCUCHAN, RSEL, SWIBOX, PRECHAN and HPMOD (see the description of these parameters). These can be viewed by clicking the PARAM button in the routing table. Note that these parameters appear in eda and can be set from there. This, however is not very common as setting them from the routing table is much more convenient. In Bruker parameter sets (see rpar), the routing parameters have been set according to the configured hardware. This corresponds to the routing that will be set by clicking the default button in the routing table.

However, you only need to set the following switches:

- **Preferred preamplifier**
  - toggle between selective and unselective Preamplifier module

- **Preferred output for 19F**
  - toggle between the 19F and X Switchbox output for 19F nucleus

and click SAVE to store them.

The **Preferred preamplifier** determines the default preamplifier module (selective or unselective) for X-nuclei. The **Preferred output for 19F** determines the default output of the switchbox (X or 19F) for 19F.

In XWIN-NMR 3.1 and newer, the connections between the Switchbox output and the Preamplifier modules are fixed; they cannot be changed. However, if you start edasp with the argument setpreamp, you can change these connections or remove them all by clicking CLEAR ALL. If you make any changes here, you
must make sure that the cables at the spectrometer are connected accordingly.

INPUT AND OUTPUT PARAMETERS

set from **edasp** by setting *Preferred preamplifier*:

- **DEFRSEL** - preferred preamplifier (default routing)

set from **edasp** by setting *Preferred output for 19F*:

- **DEF19F** - preferred output for 19F (default routing)

set graphically from **edasp** by connecting routing elements:

- **FCUCHAN** - logical frequency channel - FCU connections
- **RSEL** - FCU - amplifier connections
- **SWIBOX** - Switchbox input - Switchbox output connections
- **PRECHAN** - Switchbox output - Preamplifier module connections
- **HPMOD** - high power amplifier - Preamplifier module connections

INPUT AND OUTPUT FILES

- `<du>/data/<user>/<name>/nmr/<expno>/acqu` - acquisition parameters
- `<xwhome>/conf/instr/<INSTRUM>/specpar` - routing parameters

SEE ALSO

- edsp, eda, cf, config, expinstall
getprosol

NAME

getprosol - get probehead and solvent dependent parameters

DESCRIPTION

The command `getprosol` reads the probehead and solvent dependent parameters (the prosol parameters) and copies them to the corresponding acquisition parameters. The relations between the prosol and acquisition parameters are shown in table 7.1. These are the default relations which apply to most standard high resolution experiments. Protein, DNA/RNA and LC-NMR experiments require different relations which are defined in the files `triple`, `triple_na` and `lcnmr`, respectively (see INPUT FILES). To use relations other than default, the so called relations file must be specified in the pulse program. You can do that by editing the pulse program (with `edpul` or `edcpul`) and adding the line:

```
/* relations <filename> */
```

before the actual pulse sequence. Note that the `/* */` characters are obligatory! To look at an example, you can enter `edpul lc2` or `edpul zgesgp`. Note that the file `default`, for default relations can, but does not need to be specified in the pulse program.

`getprosol` replaces the command `gpro` and the AU program `pulsesort` which were used in XWIN-NMR versions older than 3.0.
<table>
<thead>
<tr>
<th>Description</th>
<th>edprosol</th>
<th>eda</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 90° hard pulse length</td>
<td>P90[F1]</td>
<td>P[0], P[1]</td>
</tr>
<tr>
<td>F1 180° hard pulse length</td>
<td>P90[F1]*2</td>
<td>P[2]</td>
</tr>
<tr>
<td>F2 90° hard pulse length</td>
<td>P90[F2]</td>
<td>P[3]</td>
</tr>
<tr>
<td>F2 180° hard pulse length</td>
<td>P90[F2]*2</td>
<td>P[4]</td>
</tr>
<tr>
<td>F1 Tocsy spin lock 60° pulse length</td>
<td>PTOC[F1]*0.66</td>
<td>P[5]</td>
</tr>
<tr>
<td>F1 Tocsy spin lock 90° pulse length</td>
<td>PTOC[F1]</td>
<td>P[6]</td>
</tr>
<tr>
<td>F1 Tocsy spin lock 180° pulse length</td>
<td>PTOC[F1]*2</td>
<td>P[7]</td>
</tr>
<tr>
<td>F1 Roesy spin lock pulse length</td>
<td>PROE[F1]</td>
<td>P[15]</td>
</tr>
<tr>
<td>Gradient 1 pulse length</td>
<td>P_grad1</td>
<td>P[16]</td>
</tr>
<tr>
<td>F1 Tocsy trim pulse length</td>
<td>P_mlev</td>
<td>P[17]</td>
</tr>
<tr>
<td>Gradient 2 pulse length</td>
<td>P_grad2</td>
<td>P[19]</td>
</tr>
<tr>
<td>F3 90° hard pulse length</td>
<td>P90[F3]</td>
<td>P[21]</td>
</tr>
<tr>
<td>F3 90° hard pulse length</td>
<td>P90[F3]*2</td>
<td>P[22]</td>
</tr>
<tr>
<td>F1 HSQC trim pulse length</td>
<td>P_hsqc</td>
<td>P[28]</td>
</tr>
<tr>
<td>F2 Roesy spin lock pulse length</td>
<td>PROE[F2]</td>
<td>P[31]</td>
</tr>
<tr>
<td>F1 90° hard pulse power level</td>
<td>PL90[F1]</td>
<td>PL[1]</td>
</tr>
<tr>
<td>F2 90° hard pulse power level</td>
<td>PL90[F2]</td>
<td>PL[2]</td>
</tr>
<tr>
<td>F3 90° hard pulse power level</td>
<td>PL90[F3]</td>
<td>PL[3]</td>
</tr>
<tr>
<td>F1 Tocsy spin lock power level</td>
<td>PLTOC[F1]</td>
<td>PL[10]</td>
</tr>
<tr>
<td>F1 Roesy spin lock power level</td>
<td>PLROE[F1]</td>
<td>PL[11]</td>
</tr>
<tr>
<td>F2 CPD power level</td>
<td>PLCPDP[F2]</td>
<td>PL[12]</td>
</tr>
<tr>
<td>F2 Second CPD (bilev) power level</td>
<td>PLCPD2[F2]</td>
<td>PL[13]</td>
</tr>
<tr>
<td>F3 CPD power level</td>
<td>PLCPDP[F3]</td>
<td>PL[16]</td>
</tr>
<tr>
<td>F2 Homodecoupling power level</td>
<td>PLHD[F2]</td>
<td>PL[24]</td>
</tr>
<tr>
<td>Gradient recovery delay</td>
<td>D_grad</td>
<td>D[16]</td>
</tr>
<tr>
<td>F2 CPD pulse length</td>
<td>PCPDP[F2]</td>
<td>PCPD[2]</td>
</tr>
<tr>
<td>F2 CPD pulse length</td>
<td>PCPDP[F3]</td>
<td>PCPD[3]</td>
</tr>
</tbody>
</table>

**Table 7.1** Default relations between prosol and acquisition parameters
INPUT AND OUTPUT PARAMETERS

see table 7.1

INPUT FILES

<xwhome>/conf/instr/<instrum>/prosol/relations

default - relations file for most experiments
triple - relations file for Protein experiments
triple_na - relations file for DNA experiments
lcnmr - relations file for LC-NMR

<xwhome>/conf/instr/<instrum>/prosol/<probeID>/<solvent>
nucleus.channel.amplifier - prosol parameters

OUTPUT FILES

<du>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters
relations - copy of the input relations file

SEE ALSO

edprosol, eda
rpar

NAME

rpar - read a parameter set

SYNTAX

rpar [<name> [type]]

DESCRIPTION

The command rpar reads a parameter set to the current dataset. It takes two arguments and can be used as follows:

- **rpar**
  shows a list of existing parameter sets. When you click on a parameter set, you will get a list of parameter types available in that set. You can select one or more parameter types and then click Copy to copy them to the current dataset. Alternatively, you can click Copy All to copy all parameter types.

- **rpar <name>**
  shows a list of parameter types available in the parameter set <name>. You can select one or more parameter types and then click Copy to copy them to the current dataset. Alternatively, you can click Copy All to copy all parameter types.

- **rpar <name> <type>**
  copies the parameter type <type> of the parameter set <name>

The Cancel button in the rpar dialog box allows you to quit without reading any parameters.

The following parameter types exist:

- **acqu** - acquisition parameters
- **proc** - processing parameters
- **plot** - graphics and plot parameters
- **outd** - output device parameters
- **title** - plot title (user defined parameter sets only)
- **level** - 2D or 3D contour levels (user defined parameter sets only)
Parameter handling commands

- *all* - all of the above parameter types

**rpar** only reads those parameter types which are selected and which exist in the specified parameter set.

Bruker parameter sets are delivered with XWIN-NMR and installed with the command **expinstall**. They all contain the parameter types *acqu*, *proc*, *plot* and *outd*.

User defined parameter sets can be created with **wpar** and contain the parameter types that were selected during creation. These include the types *acqu*, *proc*, *plot*, *outd*, *title* and, for 2D or 3D data, *level*.

**rpar** allows you to read parameters sets of various dimensionalities: 1D, 2D, etc. If the dimensionality of the current dataset and the parameter set you want to read are the same, e.g. both 1D, the dataset parameter files are overwritten. If the current dataset contains data (raw and/or processed data), these are kept. Furthermore, the status parameters are kept so you still have a consistent dataset. However, as soon as you process the data, the new processing parameters are used, the processed data files are overwritten and the processing status parameters are updated. When you start an acquisition, the new acquisition parameters are used, the raw data are overwritten and the acquisition status parameters are updated. If the current dataset is 1D, contains data (raw and/or processed) and you read a 2D parameter set, **rpar** will warn you that the current data will be deleted and ask you whether or not you want to continue. However, this warning will not appear if you enter the command with two arguments, i.e.:

```
rpar <name> <type>
```

In that case, data files of a different dimensionality are simply deleted. The reason is that is that **rpar** with two arguments is used in automation.

After reading a parameter set with **rpar**, you can modify parameters of the various types with the commands:

- **eda** - acquisition parameters
- **edp** - processing parameters
- **edg** and **edgx** - plot parameters
- **edo** - output device parameters
- **edlev** - contour levels
- **setti** - plot title
The first argument of `rpar` may contain wildcards, for example:

- `rpar C*` shows all parameter sets beginning with the letter C
- `rpar [H-Z]*` shows all parameter sets beginning with a letter between H and Z.

**INPUT FILES**

```
<xwhome>/exp/stan/nmr/par/<1D parameter set>/
acqu - acquisition parameters (parameter type acqu)
proc - processing parameters (parameter type proc)
meta - plot parameters (parameter type plot)
meta.ext - extended plot parameters (parameter type plot)
outd - output device parameters (parameter type outd)
title - plot title (parameter type title)
```

```
<xwhome>/exp/stan/nmr/par/<2D parameter set>/
acqu - F2 acquisition parameters (parameter type acqu)
acqu2 - F1 acquisition parameters (parameter type acqu)
proc - F2 processing parameters (parameter type proc)
proc2 - F1 processing parameters (parameter type proc)
meta - plot parameters (parameter type plot)
meta.ext - extended plot parameters (parameter type plot)
outd - output device parameters (parameter type outd)
title - plot title (parameter type title)
level - 2D contour levels (parameter type level)
```

3D parameter sets also contain the files `acqu3` and `proc3` for the third dimension but do not contain the file `meta.ext`.
User defined parameter sets may also contain the files `title` (1D and 2D) and `level` (2D and 3D).

**OUTPUT FILES**

```
<du>/data/<user>/nmr/<1D data name>/<expno>/
acqu - acquisition parameters (parameter type acqu)
```

```
<du>/data/<user>/nmr/<1D data name>/<expno>/pdata/<procno>/
proc - processing parameters (parameter type proc)
meta - plot parameters (parameter type plot)
meta.ext - extended plot parameters (parameter type plot)
```
outd - output device parameters (parameter type outd)
title - plot title (parameter type title)

<du>/data/<user>/nmr/<2D data name>/<expno>/
acqu - F2 acquisition parameters (parameter type acqu)
acqu2 - F1 acquisition parameters (parameter type acqu)

<du>/data/<user>/nmr/<2D data name>/<expno>/pdata/<procno>/
proc - F2 processing parameters (parameter type proc)
proc2 - F1 processing parameters (parameter type proc)
meta - plot parameters (parameter type plot)
meta.ext - extended plot parameters (parameter type plot)
outd - output device parameters (parameter type outd)
title - plot title (parameter type title)
level - 2D contour levels (parameter type level)

3D data also contain the files acqu3 and proc3 for the third dimension but do not contain the file meta.ext.

USAGE IN AU PROGRAMS
RPAR(name, type)

SEE ALSO
wpar, dirpar, delpar, renpar, expinstall
wpar

NAME

wpar - write a parameter set

SYNTAX

wpar [name] [<type>]

DESCRIPTION

The command wpar stores the parameters of the current dataset in a parameter set. This parameter set is then available for general usage and can be read to any dataset with rpar.

wpar allows you to overwrite an existing parameter set or to enter a new name. It takes two arguments and can be used in one of the following ways:

wpar

opens a dialog box with a list of existing parameter sets. You can click one of them, or enter a name in the field Type New Name. A new dialog box will then open showing a list of parameter types. If you chose an existing parameter set, the existing parameter types in it are highlighted. You can select/deselect parameter types by clicking their entries. Then you can click Copy to store the highlighted types. Alternatively, you can click Copy All to store all types.

wpar <name>

shows a list of parameter types. If you specified an existing parameter set, the existing parameter types in it are highlighted. You can select/deselect parameter types by clicking their entries. You can then click Copy to store the highlighted types. Alternatively, you can click Copy All to store all types.

wpar <name> <type>

stores parameters of type <type> to parameter set <name>. If <type> already exists in <name>, it is overwritten.

The Cancel button in the wpar dialog box allows you to quit without storing any parameters.

The following parameter types exist:

- acqu - acquisition parameters
Parameter handling commands

- **proc** - processing parameters
- **plot** - graphics and plot parameters
- **outd** - output device parameters
- **title** - plot title
- **level** - 2D or 3D contour levels
- **all** - all of the above parameter types

**wpar** is often used as part of the following sequence:

1. Define a new dataset with **edc** or **new**.
2. Enter **rpar** to read a Bruker parameter set which defines the experiment you want to do.
3. Modify the acquisition parameters (with **eda**) to your preference and run the acquisition.
4. Modify processing parameters (with **edp**) to your preference and process the data.
5. Modify the plot parameters (with **edg**) to your preference, set the output device parameters (with **edo**) and plot the dataset.
6. Store the parameters with **wpar** for general usage.

The first argument of **wpar** may contain wildcards, for example:

- **wpar C*** lists all parameter sets which begin with the letter C
- **wpar [H-Z]*** lists all parameter sets which begin with a letter between H and Z.

### INPUT FILES

```
<du>/data/<user>/nmr/<1D data name>/<expno>/
```

- **acqu** - acquisition parameters (parameter type **acqu**)

```
<du>/data/<user>/nmr/<1D data name>/<expno>/pdata/<procno>/
```

- **proc** - processing parameters (parameter type **proc**)
- **meta** - plot parameters (parameter type **plot**)
- **meta.ext** - extended plot parameters (parameter type **plot**)
- **outd** - output device parameters (parameter type **outd**)

1. Alternatively, you can use XWIN-plot whose layout is not part of the parameter set.
<du>/data/<user>/nmr/<2D data name>/<expno>/
  acqu - F2 acquisition parameters (parameter type acqu)
  acqu2 - F1 acquisition parameters (parameter type acqu)

<du>/data/<user>/nmr/<2D data name>/<expno>/pdata/<procno>/
  proc - F2 processing parameters (parameter type proc)
  proc2 - F1 processing parameters (parameter type proc)
  meta - plot parameters (parameter type plot)
  meta.ext - extended plot parameters (parameter type plot)
  outd - output device parameters (parameter type outd)

3D data also contain the files acqu3 and proc3 for the third dimension but do not contain the file meta.ext. Note that only the files whose parameter type has been selected within wpar are input files.

OUTPUT FILES

<xwhome>/exp/stan/nmr/par/<1D parameter set>/
  acqu - acquisition parameters (parameter type acqu)
  proc - processing parameter (parameter type proc)
  meta - plot parameters (parameter type plot)
  meta.ext - extended plot parameters (parameter type plot)
  outd - output device parameters (parameter type outd)
  title - plot title (parameter type title)

<xwhome>/exp/stan/nmr/par/<2D parameter set>/
  acqu - F2 acquisition parameters (parameter type acqu)
  acqu2- F1 acquisition parameters (parameter type acqu)
  proc - F2 processing parameters (parameter type proc)
  proc2 - F1 processing parameters (parameter type proc)
  meta - plot parameters (parameter type plot)
  meta.ext - extended plot parameters (parameter type plot)
  outd - output device parameters (parameter type outd)
  title - plot title (parameter type title)
  level - 2D contour levels (parameter type level)

3D parameter sets also contain the files acqu3 and proc3 for the third dimension but do not contain the file meta.ext and title. Note that only the files whose parameter type has been selected within wpar are output files.
Parameter handling commands

USAGE IN AU PROGRAMS
WPAR(name, type)

SEE ALSO
rpar, dirpar, delpar, renpar, expinstall
Chapter 8

Pulse and AU program commands

This chapter describes commands for the setup of pulse programs, gradient programs, CPP programs and AU programs. Furthermore, it describes the setup of various lists which can be used in acquisition like variable pulse or variable delay lists.
edau

NAME
edau - create or edit AU programs

SYNTAX
edau [<name>]

DESCRIPTION
The command edau allows you to list, create or edit AU programs. When used without argument, a two column list appears with the Bruker AU programs on the right side and the user defined AU programs on the left side. When you click a Bruker AU program, it is shown in view mode which means it cannot be modified. When you click a user defined AU program, it is opened with an editor and can be modified. When you close the view window or editor, you are prompted for one of the following options:

(c)ompile - compile the AU program
(b)ack - go back to displaying the list of AU programs
(q)uit - quit without compiling the AU program

When you choose c for compilation (the default option), the AU program will be compiled using a C compiler. After successful compilation, the AU program can be executed by typing its name.

When edau is entered with an argument, the specified AU program will be opened. This allows you to write a new AU program or modify an existing one. The argument may contain wildcards, e.g. edau a* displays a list of all AU programs starting with a.

Bruker AU programs must be installed once with expinstall before they can be opened with edau. The installation must be repeated when a new version of XWIN-NMR is installed. By default, Bruker AU programs are opened in view mode, which means they cannot be modified. However, if you enter edau and click the Edit button, the NMR Superuser password is requested and the program switches to Edit mode. When you now click a Bruker AU program, it will be opened with an editor and can be modified. Nevertheless, we recommend to leave the Bruker AU programs unchanged. If you want a modified version, just create a new AU program, read in the Bruker AU program, modify it to your
needs and store it.

*edau* uses the editor which is defined in the XWIN-NMR User Interface. If you want to use a different editor, type *setres* and modify the entry *Editor*.

For details on writing, compiling, and executing AU programs please refer to the AU reference manual (click *Help → Other topics → Writing AU programs*).

**INPUT FILES**

<xwhome>/exp/stan/nmr/au/src/

AU program source files

If the AU program is compiled (*c* option of *edau*):

/<xwhome>/exp/stan/nmr/au/

  *makeau* - AU compilation script
  *vorspann* - C language definition file
  *submacro* - preprocessor replacing macros and includes

<xwhome>/prog/include/

  *aucmd.h* - AU macro definition file

/<xwhome>/prog/include/inc

AU program includes

**OUTPUT FILES**

<xwhome>/exp/stan/nmr/au/src/

AU program source files

If the AU program is compiled (*c* option of *edau*):

<xwhome>/prog/au/bin/

AU program executable binary files

**SEE ALSO**

expinstall, comepileall, cpluser, cplbruk, delau, renau
edcgp

NAME

edcgp - edit current gradient program

SYNTAX

edcgp [<name>]

DESCRIPTION

The command edcgp allows you to create or edit the current gradient program. The current gradient program is defined as the gradient program of the foreground dataset as defined by the acquisition parameter GRDPROG.

edcgp takes one argument and can be used as follows:

- edcgp
  open the current gradient program

- edcgp <name>
  open the gradient program <name> and make it the current gradient program.

If you specify an argument, then it may contain wildcards; for example:

- edcgp SIN*
  lists all gradient programs beginning with SIN

- edcgp [m-z]*
  lists all gradient programs beginning with m,n,...,z

INPUT PARAMETERS

to be set with eda or by typing grdprog:

GRDPROG - the current gradient program (input of edcgp)

OUTPUT PARAMETERS

can be viewed with eda or by typing grdprog:

GRDPROG - the current gradient program (output of edcgp <name>)

INPUT FILES

<xwhome>/exp/stan/nmr/lists/gp/*
gradient programs
<du>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters

OUTPUT FILES
<du>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters

SEE ALSO
edgp
edcpd

NAME

edcpd - edit composite pulse decoupling (CPD) programs

SYNTAX

edcpd [ <name> ]

DESCRIPTION

The command edcpd allows you to list, create or edit CPD programs. If you enter edcpd without arguments, a list of all CPD programs is displayed. The list includes both the Bruker and the user defined CPD programs. When you click on a CPD program, it is opened with an editor. Alternatively, or you can enter a name in the field "Type New Name" to create a new CPD program. The Print button allows you to print the list of CPD programs.

If you enter the command with an argument, e.g. edcpd <name>, the CPD program <name> is opened or, if it does not exist, it is created. The argument may contain wildcards; e.g. edcpd a* displays a list of all CPD programs which start with a.

Bruker CPD programs must be installed with expinstall before they can be opened with edcpd.

edcpd uses the editor which is defined in the XWIN-NMR User Interface. You can change it by typing setres and specify it in the field Editor.

INPUT AND OUTPUT FILES

<xwhome>/exp/stan/nmr/lists/cpd/*

Bruker and user defined CPD programs

SEE ALSO

expinstall
edcpul

NAME

edcpul - edit the current pulse program

SYNTAX

edcpul [ <name> ]

DESCRIPTION

The command edcpul allows you to create or edit the current pulse program. The current pulse program is defined as the pulse program of the foreground dataset as defined by the acquisition parameter PULPROG.

edcpul takes one argument and can be used as follows:

- edcpul  
  opens the current pulse program
- edcpul <name>
  opens the pulse program <name> and makes it the current pulse program.

Bruker pulse programs are opened in view mode which means they cannot be modified. User defined pulse programs are opened with an editor and can be modified.

If you specify an argument, then it may contain wildcards; for example:

  edcpul cos*  lists all pulse programs beginning with cos
  edcpul [m-z]*  lists all pulse programs beginning with m,n,...,z

INPUT PARAMETERS

to be set with eda or by typing pulprog:

  PULPROG - the current pulse program (input of edcpul)

OUTPUT PARAMETERS

can be viewed with eda or by typing pulprog:

  PULPROG - the current pulse program (output of edcpul <name>)
INPUT FILES
<xwhome>/exp/stan/nmr/lists/pp
  Bruker and user defined pulse programs
<du>/data/<user>/nmr/<name>/<expno>/
  acqu - acquisition parameters

OUTPUT FILES
<du>/data/<user>/nmr/<name>/<expno>/
  acqu - acquisition parameters (output of edcput <name>)

SEE ALSO
  edpul, edcdp, edgp
edgp

NAME
edgp - edit gradient programs

SYNTAX
edgp [<name>]

DESCRIPTION
The command edgp allows you to list, create or edit gradient programs. If you enter edgp without arguments, a list of all gradient programs is displayed. This list includes both the Bruker and the user defined gradient programs. When you click a gradient program it will be opened with an editor. Alternatively, you can enter a name in the field "Type New Name" to create a new gradient program. The Print button allows you to print the list of gradient programs.

If you enter the command with an argument, i.e. edgp <name>, the gradient program <name> is opened or, if it does not exist, it is created. The argument may contain wildcards, e.g. edgp a* displays a list of all gradient programs which start with a.

Bruker gradient programs must be installed with expinstall before they can be opened with edgp.

edgp uses the editor which is defined in the XWIN-NMR User Interface. You can change it by typing setres and specify it in the field Editor.

INPUT AND OUTPUT FILES
<xwhome>/exp/stan/nmr/lists/gp/*
gradient programs

SEE ALSO
edcpul, edpul, edcgp, expinstall
edlist

NAME
edlist - edit various lists

SYNTAX
edlist [<type> [name]]

DESCRIPTION
The command edlist allows you to list, create or edit various lists like delay lists, pulse lists and frequency lists. Most of these lists are used during acquisition. edlist can be used in one of the following ways:

- edlist - displays all lists types
- edist <type> - displays all entries of the list type <type>
- edlist <type> <name> - creates/edits the list <name> of type <type>

The second argument may contain wildcards, e.g. edlist vd a* displays all variable delay lists which start with a.

A variable delay list can be set up and used as follows:

- create a variable delay list with edlist
- set the acquisition parameter VDLIST to the name of that list
- specify the vd statement in the pulse program

Other lists can be used in a similar way. At the end of this description we will discuss an alternative way to use lists, circumventing the acquisition parameter.

All lists that can be used by during acquisition are displayed in table 8.1. They typically contains one value per line and the number of lines is unlimited. The type of the list that is interpreted is determined by the type of pulse program statement. The list name is determined by an acquisition parameter.

Delay lists

Delay lists contain any number of delay values with the corresponding units, e.g.:

10m
2s
where \( m = \) milliseconds and \( s = \) seconds. They are interpreted by the pulse program statements:

- **vd** - read value from the current position in the delay list
- **ivd** - increment the delay list position to the next value
- **vdidx** - set the index to position \( n \) in the delay list

**Pulse lists**

Pulse lists contain any number of pulse length values with the corresponding units, e.g.:

- \( 10\mu \)
- \( 20m \)

where \( \mu = \) microseconds and \( m = \) milliseconds. They are interpreted by the pulse program statements:

<table>
<thead>
<tr>
<th>list type</th>
<th>description</th>
<th>defined by parameter</th>
<th>read by pulse progr. statements</th>
</tr>
</thead>
<tbody>
<tr>
<td>( vd )</td>
<td>delay list</td>
<td>VDLIST</td>
<td>vd, ivd, vdidx</td>
</tr>
<tr>
<td>( vp )</td>
<td>pulse list</td>
<td>VPLIST</td>
<td>vp, ivp, vpidx</td>
</tr>
<tr>
<td>( fl )</td>
<td>frequency list (Avance)</td>
<td>FQ1LIST, FQ2LIST etc.</td>
<td>fql, fq2, fq3 etc.</td>
</tr>
<tr>
<td>( f1, f2, f3 )</td>
<td>frequency list (A*X)</td>
<td>F1LIST, F2LIST etc.</td>
<td>o1, o2, o3</td>
</tr>
<tr>
<td>( vc )</td>
<td>counter list</td>
<td>VCLIST</td>
<td>loto x times c, ivc</td>
</tr>
<tr>
<td>( va )</td>
<td>amplitude list</td>
<td>VALIST</td>
<td>define list&lt;power&gt;</td>
</tr>
<tr>
<td>( ds )</td>
<td>dataset list</td>
<td>DSLIST</td>
<td>wr #n, wr ##, ifp, dfp, rfp</td>
</tr>
<tr>
<td>( vt )</td>
<td>temperature list</td>
<td>VTLIST</td>
<td>RVTLIST, VT, IVTLIST, DVTLIST*</td>
</tr>
<tr>
<td>( masr )</td>
<td>MAS spin rate list</td>
<td></td>
<td>AU prog multimas</td>
</tr>
<tr>
<td>( wave )</td>
<td>Shaped pulse list</td>
<td>SP07</td>
<td>sp1, sp2 etc.</td>
</tr>
</tbody>
</table>

Table 8.1 Lists used in acquisition

a. Note that these are AU program macros rather than pulse program statements

where \( m = \) milliseconds and \( s = \) seconds. They are interpreted by the pulse program statements:

- **vd** - read value from the current position in the delay list
- **ivd** - increment the delay list position to the next value
- **vdidx** - set the index to position \( n \) in the delay list

**Pulse lists**

Pulse lists contain any number of pulse length values with the corresponding units, e.g.:

- \( 10\mu \)
- \( 20m \)
vp - read value from the current position in the pulse list
ivp - increment the pulse list position to the next value
vpidx - set the index to position n in the pulse list

A variable pulse list can only be used for hard pulses, not for shaped pulses.

**Frequency lists**

Frequency lists contain the irradiation frequency preceded by the letter O on the first line (optional) and any number of frequency offset values on subsequent lines, e.g.:

```
O 500.13
3000
3150
3200
```

They are interpreted by pulse program statements like:

```
30μ fql:f1
```

read the current value from the list defined by FQ1LIST to channel f1

```
d1 fq2:f1
```

read the current value from the list defined by FQ2LIST to channel f1

```
d11 fq3:f2
```

read the current value from the list defined by FQ3LIST to channel f2

Note that the fql, fq2 etc. statements must be specified with a delay. In contrast to the vd and vp statements, they automatically increment the current position in the list to the next value.

In the above example, the offset values in the list are added to the frequency specified on the first line, independent of the channel. If, however, the first line would be omitted, the offset values in the list are added to the values of SFO1, SFO2 etc. for the respective channels.

**Counter lists**

A variable counter list contains any number of loop counter values, e.g.:

```
4
7
20
```

They are interpreted by the pulse program statement:
lo to x times c
where x is a pulse program label and c is the value at the current position of the counter list

ivc
increment the counter list position to the next value

**Variable amplitude (power) lists**

A variable amplitude list contains any number of power values, e.g.:

-6.0
0.0
3.0
6.0

The entries represent attenuation values in dB.

The usage of a VA list is different from pulse and delays lists. You must define the statement by which a VA list is accessed in the pulse program. Such a statement can have any name, for example the name `vanam` is used in the examples below. The suffixes `.inc`, `.dex` and `.res` can be used to increment, decrement and reset the lists position, respectively. Furthermore, the caret operator (^) allows you to read a list value and increment the list position with one statement. The following pulse program entries illustrate the use of a variable amplitude list:

```plaintext
define list<power> vanam = <$VALIST>
definition of the power list
d1 vanam:f2 vanam.dec
set the power to the current value of the list and decrement the index
d1 vanam[2]:f3
set the power to the second value of the list
"vanam.idx = vanam.idx + 3"
increment the list index by 3
d1 vanam^:f4
set power to the current value of the list increment the index
```

As an alternative to using a list defined by the parameter `VALIST`, you can explicitly define a variable amplitude (power) list filename or even the list values in the pulse program. The following examples illustrates such defini-
tions:

```plaintext
define list<power> vanam=<my_filename>
define list<power> vanam={10 30 50 70}
```

Note that the second definition does not require a list file.

Note that variable amplitude lists can only be accessed using define statements as described above. The statement `va` does not exist. More information on using variable amplitude lists can be found in the chapter on Pulse Programs in the Complete Acquisition Manual).

**Dataset lists**

A dataset list contains any number of dataset definition, e.g.:

```plaintext
sucrose 1 1 C:\ guest new
sucrose 2 1 C:\ guest new
fructose 1 1 D:\ guest old
```

where the option `new/old` is used to delete/keep a possibly existing dataset.

They are interpreted by the pulse program statements:

```plaintext
wr #n  # write the data to the dataset defined at the position n of the dataset list
wr ##  # write the data to the dataset defined at the current position of the dataset list
ifp   # increment the position in the dataset list
dfp   # increment the position in the dataset list
rfp   # reset the position in the dataset list to the first entry
```

**Temperature lists**

A variable temperature list contains any number of temperature values (in Kelvin), e.g.:

```plaintext
300
320
```
Temperature lists are interpreted by the AU program macros:

RVTLIST
open the temperature list defined by VTLLIST

VT
read value from the current position in the temperature list and set the temperature unit accordingly

IVTLIST
increment the current position in the temperature list to the next value

DVTLIST
decrement the current position in the temperature list to the previous value

Note that temperature lists are only interpreted by AU program macros, not by pulse program statements.

Shaped pulse lists

A shaped pulse list is a JCAMP files that defines a shaped pulse. It contains a JCAMP header and a list of relative power values (X) and phase values (Y). An example of a shaped pulse list is:

```
##TITLE= /u/exp/stan/nmr/lists/wave/Crp60comp.4
##JCAMP-DX= 5.00 Bruker JCAMP library
##DATA TYPE= Shape Data
##ORIGIN= Bruker Analytik GmbH
##OWNER= <demo>
##DATE= 99/02/09
##TIME= 19:06:33
##MINX= 0.000000e+00
##MAXX= 1.000000e+02
##MINY= 1.110700e-01
##MAXY= 3.599617e+02
##$SHAPE_EXMODE= Adiabatic
##$SHAPE_TOTROT= 1.800000e+02
##$SHAPE_BWFAC= 0.000000e+00
##$SHAPE_INTEGFAC= 1.564030e-01
##$SHAPE_MODE= 0
##NPOINTS= 4000
```
## XYPOINTS = (XY, XY)

<table>
<thead>
<tr>
<th>XYPOINTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000000e+00, 1.833010e+02</td>
</tr>
<tr>
<td>7.893400e-01, 1.779120e+02</td>
</tr>
<tr>
<td>1.578620e+00, 1.725340e+02</td>
</tr>
<tr>
<td>2.367810e+00, 1.671660e+02</td>
</tr>
<tr>
<td>3.156850e+00, 1.618090e+02</td>
</tr>
<tr>
<td>3.945700e+00, 1.564630e+02</td>
</tr>
<tr>
<td>4.734300e+00, 1.511280e+02</td>
</tr>
<tr>
<td>5.522600e+00, 1.458040e+02</td>
</tr>
<tr>
<td>6.310560e+00, 1.404900e+02</td>
</tr>
<tr>
<td>7.098130e+00, 1.351870e+02</td>
</tr>
<tr>
<td>7.885250e+00, 1.298950e+02</td>
</tr>
<tr>
<td>8.671890e+00, 1.246140e+02</td>
</tr>
<tr>
<td>9.457980e+00, 1.193440e+02</td>
</tr>
</tbody>
</table>

Shaped pulse lists are interpreted by a pulse program statement like:

```
p13:sp2:f1
```

which executes a shaped pulse with length P13 on channel f1, using the pulse defined by second entry (sp2) in the table defined by the acquisition parameter SP07.

**Masr lists**

MASR lists contain any number of MAS spin rate values, e.g.:

- 3000
- 3500
- 4000
- 4500

They are interpreted by the AU program `multimas`. This AU program will ask you if you want to use a list or enter the start and increment value interactively. If you choose the former (default), it will offer you the available MASR lists.

There are alternative ways of defining and using lists in acquisition. Rather than using a predefined statements like `vci`, you can define your own statement in the pulse program to access a certain list. For example, the statements:
define list<delay> vdnam = <$VDLIST>
define list<delay> vdfil = <my_file>
define list<delay> vdval = {0.1 0.2 0.3 0.4}

allows you to use the statements vdnam, vdfil and vdval to read a value from a delay list. The use of lists via define statements is fully described above for the variable amplitude lists. More information on user defined lists can be found in the chapter on Pulse Programs in the Complete Acquisition Manual).

The edlist command also shows various files which are programs rather than lists of values, for example pulse programs, CPD programs, gradient programs and macros. These, however, are normally opened with the dedicated commands edpul, edcpd, edgp and edmac rather than with edlist.

INPUT AND OUTPUT FILES
<xwhome>/exp/stan/nmr/lists

   pp - pulse programs
cpd - CPD programs
gp - gradient programs
wave - shaped pulse lists
preemp - preemphasis lists
ds - variable dataset lists
va - variable amplitude (power) lists
vc - variable counter lists
vd - variable delay lists
vp - variable pulse lists
vt - variable temperature lists
f1 - variable frequency lists
f2, f3 - variable frequency lists (A*X spectrometers only)
mac - XWIN-NMR macros
roi - 2D integral ranges
scl - scaling region files
masr - MAS spin rate list

SEE ALSO
edmisc, edpul, edcpd, edgp, edmac
edpul

NAME
edpul - edit a pulse program

SYNTAX
edpul [<name>]

DESCRIPTION
The command edpul allows you to list, edit or create pulse programs.

edpul without arguments opens a dialog box with two columns of pulse programs. The right column shows the Bruker pulse programs, the left column the user defined pulse programs. When you click a Bruker pulse program, it is opened in view mode which means it cannot be changed. When you click a user defined pulse program, it is opened with an editor and can be modified. Instead of opening an existing pulse program, you can enter a name in the field "Type New Name" to create a new one.

The edpul dialog box also contains a button Edit which allows you to switch to Edit-mode and modify Bruker pulse programs. Be careful: they are overwritten when you install a new version of XWIN-NMR. Therefore, if you want to modify a Bruker pulse program you should store it under a new name.

edpul <name> opens the pulse program <name>. If <name> does not exist, an empty file is created and opened with an editor.

If you specify an argument, then it may contain wildcards; for example:

edpul cos* lists all pulse programs beginning with cos
edpul [m-z]* lists all pulse programs beginning with m,n,...,z

Bruker pulse programs must be installed with expinstall before they can be opened with edpul.

edpul uses the editor which is defined in the XWIN-NMR User Interface. If you want to use a different editor, type setres and modify the entry Editor.

INPUT FILES
<xwhome>/exp/stan/nmr/lists/pp/*
Bruker and user defined pulse programs

OUTPUT FILES

<xwhome>/exp/stan/nmr/lists/pp/*

user defined pulse programs

SEE ALSO

edcpul, edcpd, edgp, edcgp, expinstall, edlist
Chapter 9

Acquisition commands

This chapter describes all commands involved in data acquisition. This includes parameter optimization, the actual data acquisition and stopping a running experiment. Most experiments which involve a single acquisition are started with the command `zg` and run until they are finished. Other experiments involve multiple acquisitions executed with an AU program or with ICON-NMR.
NAME

acqu - switch to the acquisition menu

DESCRIPTION

The command `acqu` switches XWIN-NMR to the acquisition menu. This is the menu where the raw data (FID) is displayed. Typing `acqu` is equivalent to clicking `Acquire → Observe fid window`. This command can only be applied from the processing menu (main menu).

In principle, an acquisition can be started from the main menu simply by typing `zg` or running an acquisition AU program like `au_zg`. Furthermore, all acquisition commands are available under the `Acquire` menu item. Nevertheless, there are several reasons to switch to the acquisition menu first:

- to tune and match the probe by optimizing the wobble curve in the acquisition data field (command `wobb`)
- to adjust acquisition parameters interactively by observing the effect on a single scan FID (command `gs`)
- to observe the accumulation of the FID during acquisition (command `zg`)

If a long term acquisition has been started and is no longer observed, it is recommended to switch back to the processing menu by clicking `return`.

SEE ALSO

wob, rga, gs, zg
butselnmr

NAME

butselnmr - easy acquisition interface for selective experiments

DESCRIPTION

The command **butselnmr** opens an icon box from which you can run 1D selective NMR experiments. It is easy to use interface that is especially meant for the novice or occasional users.

The icon box contains buttons for the following actions:

1. **Create New Dataset**
   Allows you to define a new dataset and switches the display to that dataset (executes the XWIN-NMR command `edc`).

2. **Lock**
   Allows you to select the solvent and then performs the auto lock-in (executes the XWIN-NMR command `lock`).

3. **Tune/Match Probe**
   Switches to the acquisition menu and allows you to tune and match the probehead (executes the XWIN-NMR command `wobb`).

4. **Automatic Shimming**
   Performs shimming according to the tune file defined for the current probehead (executes the XWIN-NMR command `tune .sx`).

5. **routine PROTON/def. regions**
   Runs a 1D proton experiment performing the following steps:
   - prompts the user for the experiment number (EXPNO)
   - executes the XWIN-NMR command `rpar PROTON all` to read the PROTON parameter set
   - executes the XWIN-NMR command `getprosol` to read the probe and solvent dependent parameters
   - shows the experiment time and allows the user to actually start the acquisition (by clicking OK) or stop (by clicking Cancel). In the latter case,

---

1. A probehead dependent tune file can be defined from the `edprosol` dialog box.
the dataset has been created and the acquisition can be started at a later time, for example with `xaua`.

- selects the region for selective excitation and stores it as `reg` file.

`selective pulse calib.`

this button allows you to determine the 90° selective pulse

`selective excitation, sel.ext. with gradients` etc.

these buttons allow you to perform selective experiments

`User defined #1, User defined #2`

these button allow you to perform user defined eperiments. It executes the AU program `User_au_1` that must be setup by the user.

6. **Processing**

Processes multiple FIDs that are stored in a series of contiguous experiments numbers (EXPNO’s). It prompts you for the first EXPNO and the number of EXPNO’s and then performs the command `efp(em, ft, pk)` on each EXPNO. Note that `butselnmr` actually runs the AU program `multiefp` to perform this task.

7. **Plot**

Plots the current data by executing the XWIN-NMR command `plot`.

8. **Continue**

If the acquisition hangs for some reason, clicking this button continues with the next experiment.

9. **Exit**

Exits the `butselnmr` window

For each button a help text is available that appears when you move the cursor over the buttons.

**INPUT FOLDERS**

```
<xwhome>/exp/stan/nmr/par/

PROTON/* - routine proton experiment

<xwhome>/prog/au/bin/

butselau - butselnmr AU program binary executable
butsel90 - AU program to determine the 90° selective pulse (executable)
multiefp - AU program to process a series of 1D data (executable)
```
<xwhome>/exp/stan/nmr/au/src/

butselau - butselnmr AU program source
butsel90 - AU program to determine the 90° selective pulse (source)
multiefp - AU program to process a series of 1D data (source)

<xwhome>/prog/tcl/xwish3_scripts

butselnmr - Tcl/Tk script that is started by \textit{butselnmr}

\textbf{SEE ALSO}

buttonnnmr
**buttonnmr**

**NAME**

buttonnmr - easy acquisition interface for common experiments

**DESCRIPTION**

The command `buttonnmr` opens an icon box from which you can run common 1D and 2D NMR experiments. It is an easy to use interface that is especially meant for the novice or occasional users.

At the top of the window, the field `Xnucleus` allows you to select the X-nucleus you want to measure. This feature exists for XWIN-NMR 3.1 and newer. For earlier versions, X-nuclei measurements are restricted to 13C.

The icon box offers you buttons for the following actions:

1. **Create New Dataset**
   - Allows you to define a new dataset and switches the display to that dataset (executes the XWIN-NMR command `edc`).

2. **Lock**
   - Allows you to select the solvent and then performs the auto lock-in (executes the XWIN-NMR command `lock`).

3. **Tune/Match Probe**
   - Switches to the acquisition menu and allows you to tune and match the probehead (executes the XWIN-NMR command `wobb`).

4. **Automatic Shimming**
   - Performs shimming according to the tune file defined for the current probe head 1 (executes the XWIN-NMR command `tune .sx`).

5. **routine PROTON**
   - Runs a 1D proton experiment performing the following steps:
     - prompts the user for the experiment number (EXPNO)
     - executes the XWIN-NMR command `rpar PROTON all` to read the PROTON parameter set

---

1. A probehead dependent tune file can be defined from the `edprosol` dialog box.
executes the XWIN-NMR command `getprosol` to read the probe and solvent dependent parameters

- shows the experiment time and allows the user to actually start the acquisition (by clicking **OK**) or stop (by clicking **Cancel**). In the latter case, the dataset has been created and the acquisition can be started at a later time, for example with `xaua`.

6. **X nucleus without 1Hdec.**, **X nucleus 1Hdec. with NOE**, etc.
   these buttons allow you to perform the Bruker standard experiments that corresponds to the button name and the X-nucleus defined at the top of the window (XWIN-NMR 3.1 and newer).

   *routine 13C, DEPT90 13C*, etc.
   these buttons allow you to perform the 13C experiment that corresponds to the button name (XWIN-NMR 3.0 and older).

7. **User defined #1**
   these button allow you to perform a user defined experiment. It executes the AU program `User_au_1`. You can create this AU program with the command `edau User_au_1`. In the same way, you can activate the button `User defined #2`.

8. **Processing**
   Processes the raw data. For a 1D experiment, this involves the command sequence `ef,apk` and `abs`, for a 2D experiment the command `xfb` (for more information on these commands see the Processing Reference Manual).

9. **Plot**
   Plots the data by executing the XWIN-NMR command `plot`.

10. **Continue**
    If the acquisition hangs for some reason, clicking this button continues with the next experiment.

11. **Exit**
    Exits the `buttonnmr` window

For each button a help text is available that appears when you move the cursor over the buttons.

**INPUT FOLDERS**

```
<xwhome>/exp/stan/nmr/par/
```
Acquisition commands

PROTON/* - routine proton experiment
C13CPD/* - routine 13C experiment
C13DEPT90/* - DEPT90 13C experiment
C13DEPT135/* - DEPT135 13C experiment
COSY90SW/* - COSY experiment
NOESYPH9SW/* - NOESY experiment
MLEVPHSW/* - COSY experiment
COSYGPSW/* - gradient COSY experiment
INVBPH9SW/* - HMQC experiment
INV4LPLRNDSW/* - HMBC experiment
INV4ETGPSW/* - gradient HMQC experiment
INV4GPLPLRNDSW/* - gradient HMBC experiment

<xwhome>/prog/au/bin/

buttonau - buttonnmr AU program (binary)

<xwhome>/exp/stan/nmr/au/src/

buttonau - buttonnmr AU program (source)

<xwhome>/prog/tcl/xwish3_scripts

buttonnmr - Tcl/Tk script that is started by buttonnmr

SEE ALSO
butselnmr
expt

NAME
expt - display the experiment time

DESCRIPTION
The command `expt` calculates and displays the experiment time for the current data set. If this exceeds the time you have available, you can reduce the number of scans (parameter NS) until the experiment time is acceptable.

For 2D and 3D experiments, `expt` also compares the file size of the raw data with the available disk space.

INPUT PARAMETERS
- NS - number of scans
- AQ - acquisition time in seconds

SEE ALSO
- zg, gs
go

NAME

go - perform an acquisition and add to existing data

DESCRIPTION

The command go starts an acquisition on the current dataset adding to possibly existing raw data. It works like zg, except that it does not overwrite existing data. If raw data already exist, go will add the new data to them. This is, for example, useful if the signal to noise of your spectrum is too low and you want to acquire additional scans. If no data exist, go has the same results as zg.

If you have stopped an acquisition with halt or stop you can, in principle, continue it with go. Note, however, that the acquisition might have been stopped in the middle of a phase cycle and go starts a new phase cycle. Therefore, if you want to be able to stop and continue an acquisition, we recommend to use the commands suspend and resume (see the description of these commands).

In XWIN-NMR 3.0 and older, the command go can only be used on 1D data. In XWIN-NMR 3.1 and newer, it can also be used in 2D and 3D experiments. Note that if you enter halt or stop during a 2D or 3D acquisition it might stop in the middle of a second or third dimension increment (see above). However, this problem only occurs when you use the wr statement to write the data to disk. In XWIN-NMR 3.1 and newer, you can use the mc statement instead. In that case, the go command continues a 2D or 3D acquisition at the position where it was stopped. Caution: if you increment or decrement any pulses, delays or phases within the acquisition loop, you must do that within one of the mc arguments F1PH, F1QF etc., for example:

d1 mc #1 to 1 F1PH(id0, ip1)

Most acquisitions are started with zg and run until they have finished. As such, the command go is not used very often. It is, however, used in some Bruker AU programs like noediff, noemult, deptcyc and multicyc.

Note the difference between the XWIN-NMR command go and the pulse program statement go (See pulse programming manual).
INPUT AND OUTPUT PARAMETERS
see zg

INPUT AND OUTPUT FILES
see zg

USAGE IN AU PROGRAMS
GO

SEE ALSO
zg, suspend, resume
**gs**

**NAME**

`gs` - go setup; interactive parameter optimization during acquisition

**DESCRIPTION**

The command `gs` allows you to adjust parameters interactively during an acquisition. The FID display is continuously updated showing the effect of each parameter change.

`gs` repeatedly executes the current pulse program but only up to the first `go=n` or `rcyc=n` statement. Therefore, `gs`:

- does not accumulate data
- does not interpret the phase list
- does not write data to disk

In order to see the effect of the parameter changes on the FID, you must first go to the acquisition menu. You can do that by clicking *Acquire → Observe fid window* or by entering `acqu` on the command line. The command `gs` will open a dialog box with a set of acquisition parameters. If you do not see the dialog box, it is probably iconified and you must first click its icon.

The dialog box only shows the parameters which are typically set during `gs` like irradiation frequencies, pulse lengths and power levels. By default, the irradiation frequency offset is selected for adjustment. A slider is available for each nucleus which has been set with `edasp`. You can adjust the frequency offset O1 by putting the cursor on its slider, pressing the left mouse button and moving the mouse. Alternatively, you can increase/decrease the value by clicking or pressing to the left/right of the slider. Other parameters can be changed in the same way. The following parameters can be changed from the `gs` dialog box:

- SFO1 - SFO8 - irradiation frequency for channel f1-f8
- O1 - O8 - irradiation frequency offset for channel f1-f8
- PL[0-31] - power levels
- SP[0-31] - shape power
- AMP[0-31] - amplitude (XWIN-NMR 3.1 and newer)
- PHCOR[0-31] - reference phases
- RG - receiver gain
P[0-31] - pulse lengths
D[0-31] - delays

Note that moving the RG slider causes an exponential change in the receiver gain. Therefore, it is often necessary to decrease the sensitivity before changing RG. The effect of changing RG will be shown immediately in the FID display. For all other parameters in the above list, the effect of a change will be shown after one or two scans.

The GS dialog box also contains the following buttons:
- **sens*10** - increase the sensitivity of the sliders by a factor of ten
- **sens/10** - decrease the sensitivity of the sliders by a factor of ten
- **save** - save the parameter that was changed last
- **save all** - save all changes
- **reset** - reset the parameter that was changed last
- **reset all** - reset all changes
- **stop acquisition** - stop the acquisition and leave the gs dialog box

As an alternative to moving sliders, you can also change parameters from the XWIN-NMR command line while gs is running. If you change a parameter from the above list, the slider value will be automatically updated and the effect will be shown in the FID display. For all other parameters, the effect of a change will not be shown. The entered value is, however, stored and becomes effective when a new acquisition command is executed (for example with gs, zg or rga).

**INPUT AND OUTPUT PARAMETERS**

See the parameter list above.

**INPUT AND OUTPUT FILES**

<du>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters

**SEE ALSO**

zg, go, rga
**halt**

**NAME**

halt - halt the acquisition after the current scan

**DESCRIPTION**

The command `halt` stops the acquisition after the current scan and writes the data to disk. It is the regular command to stop a running acquisition. Note that `halt` does not complete the current phase cycle.

If, for some reason, a running or hanging acquisition cannot be stopped with `halt`, you can try the `stop` command. If that does not work either, you can use `kill`. This command will show all active processes and you can click the `go` module to stop the acquisition.

**OUTPUT PARAMETERS**

all acquisition parameters

**OUTPUT FILES**

In a 1D dataset:

```
<du>/data/<user>/nmr/<name>/<expno>/
  fid - raw data
  acqus - acquisition parameters
```

In a 2D dataset:

```
<du>/data/<user>/nmr/<name>/<expno>/
  ser - raw data
  acqus - F2 acquisition status parameters
  acqu2s - F1 acquisition status parameters
```

In a 3D dataset:

```
<du>/data/<user>/nmr/<name>/<expno>/
  ser - raw data
  acqus - F3 acquisition status parameters
  acqu2s - F2 acquisition status parameters
```
acqu3s - F1 acquisition status parameters

SEE ALSO
stop, zg, go, rga, wobb
iconnmr

NAME

iconnmr - user interface for routine spectroscopy and automation

DESCRIPTION

The command **iconnmr** starts the an icon driven user interface ICON-NMR for routine spectroscopy and automation. ICON-NMR can also be started from the desktop. It is fully described the ICON-NMR manual. The online version of this manual can opened by clicking **Help** from the ICON-NMR window.
NAME

ii - initialize interface

DESCRIPTION

The command ii initializes the spectrometer interface. It tries to access all hardware parts of the spectrometer which are needed for the current experiment and loads the acquisition parameters.

ii must be executed once when the spectrometer has been switched off.

INPUT PARAMETERS

all acquisition parameters

USAGE IN AU PROGRAMS

II

SEE ALSO

zg
popt

NAME
popt - parameter optimization

DESCRIPTION
The command popt allows you to optimize acquisition parameters like pulses and delays. Before you start an optimization, you must run one acquisition with acquisition parameters as they are (not optimized) and process the data. On the resulting spectrum, you must define the spectral range (a peak or group of peaks) to be used for optimization. You can do that by clicking the left mouse button in the data field to put the cursor on the spectrum and then click the middle mouse button on both side of the desired region. The Xwin-NMR display will automatically be adjusted to show the selected region only. You must now store this region by entered dpl1 and answer each question by hitting the Enter key.

The popt dialog box allows you to create an entry for each parameter you want to optimize. By default, it shows only one entry; more parameters can be added by clicking the button Add parameter. Furthermore the following fields are offered:

- **On/Off**
  Only parameters which are switched On will be optimized

- **Parameter**
  the parameter to be optimized. If a parameter is not checked, it will be stored as comment in the optimization protocol.

- **OPTIMUM**
  the optimization criterion (see below)

- **STARTVAL**
  the first value of the parameter

- **ENDVAL**
  the last value of the parameter (empty for INC ≠ 0 and VARMOD = LIN)

- **NEXP**
  number of experiments (empty for INC ≠ 0 and VARMOD = LIN)

- **VARMOD**
parameter variation mode: linear or logarithmic

INC
parameter increment value

The optimization criterion OPTIMUM can take the following values:

- POSMAX - the maximum value of a positive peak
- NEGMAX - the maximum value of a negative peak
- MAGMAX - the maximum magnitude value of a peak
- MAGMIN - the minimum magnitude value of a peak
- INTMAX - the maximum value of an integral
- INTMIN - the minimum value of an integral
- ZERO - zero intensity of a peak

At the bottom of the dialog box you will find the following buttons:

Start optimize: start the optimization for all checked parameters

Halt optimize: stop the optimization

Read protocol: open a text file with the optimization result

Add parameter: add a parameter entry

Read parameter file: read an external popt setup file (e.g. from another dataset)

SAVE: save the current optimization setup

RESTORE: restore the last saved optimization setup

Update data set: update popt setup after changing to a different dataset

EXIT: exit the popt dialog box

Clicking the button Start optimize will start the optimization process. Note that it runs on the current dataset. For each parameter, a series of acquisitions will be performed. The result of this is a series of spectra (actually spectral regions) that are displayed in one screen and show the optimum parameter value. They are stored as one processed data file under the current dataset name and experiment number but under a different processing number. For the first parameter that is optimized this is PROCNO 999, for the second parameter PROCNO 998 etc. As such, you must start popt on a dataset with PROCNO < 900. The result will also be stored in the so called protocol file (see OUTPUT PARAMETERS)

At the top of the dialog box you will find the following check buttons:
Store as 2D data (ser file)
If checked, the result of the optimization (a series of 1D spectra) will be stored as a 2D dataset in EXPNO 899. However, if the source dataset PROCNO is greater than 100, the EXPNO of the destination 2D data will be PROCNO - 100.

Run optimization in background
If checked, the foreground dataset will remain the same during the optimization. If it is not checked, the XWIN-NMR display will change to PROCNO 999 where the optimization result is displayed.

The AU program specified in AUNM will be executed
If checked, the AU program defined by AUNM will be executed instead of the command zg.

If you want to rerun an optimization, you must first return to the starting PROCNO.

The command popt replaces the AU programs paropt, paroptlin, paroptlog and parray, which were used in XWIN-NMR versions older than 3.0.

INPUT FILES
<du>/data/<user>/nmr/<name>/<expno>/
  acqu - acquisition parameters
  popt.array - parameter optimization setup (input of RESTORE)
  popt.protocol - parameter optimization result (input of Read protocol)
<du>/data/<user>/nmr/<name>/<expno>/pdata/<procno>/
  proc - processing parameters
<xwhome>/prog/tcl/xwish3_scripts
  popt - Tcl/Tk script that is started by popt
<xwhome>/prog/au/bin/
  poptau - AU program that runs the optimization (executable)
  popthalt - AU program that halts the current optimization (executable)
<xwhome>/exp/stan/nmr/au/src/
  poptau - AU program that runs the optimization (source)
popthalt - AU program that halts the current optimization (source)

OUTPUT FILES
<du>/data/<user>/nmr/<name>/expno/pdata/999
   1r - processed data containing the optimization result of the first parameter
<du>/data/<user>/nmr/<name>/expno/pdata/998
   1r - processed data containing the optimization result of the 2nd parameter
<du>/data/<user>/nmr/<name>/expno/
   popt.array - parameter optimization setup (output of SAVE)
   popt.protocol - parameter optimization result (output of Start optimize)
<du>/data/<user>/nmr/<name>/899/
   ser - 2D raw data containing the optimization result

SEE ALSO
gs
resume

NAME

resume - resume a suspended acquisition

DESCRIPTION

The command `resume` resumes an acquisition that has been suspended.

An acquisition can be suspended with the command `suspend`. When this is entered the acquisition holds as soon as the pulse program statement `suspend` or `calcsuspend` is encountered. If the pulse program does not contain such a statement, `suspend` has no effect. Alternatively, an acquisition can be suspended with the pulse program statement `autosuspend` or `calcautosuspend`. They automatically hold the acquisition, without user interaction. The command `resume` continues acquisition that was suspended, either automatically or with the command `suspend`.

For more information on the `suspend` pulse program statements click:

Help → Other Topics → Writing pulse programs

A resumed acquisition does not start with dummy scans. This can be a problem if the recycle delay is shorter than 4 times the T1 value of the measured nucleus.

Note that the suspend information is temporarily stored on the spectrometer FCU, not on disk. As soon as you enter `stop` or `halt`, or switch of the spectrometer, the suspend information is lost and the acquisition cannot be resumed.

SEE ALSO

suspend, zg, go
rga

NAME
rga - automatic receiver gain optimization

DESCRIPTION
The command rga automatically optimizes the receiver gain. It performs an acquisition with varying receiver gain and finally sets this just below the value where no overflow occurs. In fact, rga repeatedly executes the current pulse program but only up to the first go=n or rcyc=n statement.

If you already know the proper value for the receiver gain, you can simply set RG in eda or by typing rg on the command line.

OUTPUT PARAMETERS
can be viewed with eda or by typing rg:

RG - receiver gain

USAGE IN AUTOMATION
RGA

SEE ALSO
gs, zg, go
**stop**

**NAME**

*stop* - stop the acquisition immediately

**DESCRIPTION**

The command *stop* stops the acquisition immediately without writing the data to disk. Note that in most 1D experiments, the data are only written at the end of the acquisition and using *stop* would cause a complete loss of data. As such, it is used in case of emergency. Further, it can be used to stop the command *gs*. To stop a normal acquisition the *halt* command is used.

Instead of entering *stop* on the command line, you can also click the *stop* button.

If, for some reason, a running or hanging acquisition cannot be stopped with *halt* or *stop*, you can use *kill*. This command will show all active processes and you can click the *go* module to stop the acquisition.

**SEE ALSO**

*halt, zg, go, rga, wobb*
suspend

NAME
suspend - suspend a running acquisition

DESCRIPTITION
The command suspend allows you to hold a running acquisition. When it is entered, the acquisition holds as soon as the pulse program statement suspend or calcsuspend is encountered. If the pulse program does not contain such a statement, suspend has no effect. Alternatively, an acquisition can be suspended with the pulse program statement autosuspend or calcautosuspend. They automatically hold the acquisition, without user interaction. The command resume continues acquisition that was suspended, either automatically or with the command suspend.

Note that the suspend information is temporarily stored on the spectrometer FCU, not on disk. As soon as you enter stop or halt, or switch of the spectrometer, this information is lost and the acquisition cannot be resumed.

Standard Bruker pulse programs do not contain any suspend statements. Therefore, suspend can only be used with user defined pulse programs which contain a suspend statement at a certain position.

SEE ALSO
resume, zg, go
NAME

tr - transfer data to disk during the acquisition

DESCRIPTITION

The command **tr** transfers (writes) data to disk during a 1D acquisition. This is, for example, useful if you want to do a Fourier transform and view the spectrum before the acquisition has finished. Another reason to use **tr** is to save the currently acquired scans of a long term acquisition. This avoids losing all data in case of a power loss.

OUTPUT FILES

<du>/data/<user>/nmr/<name>/<expno>/

  * fid - 1D raw data
  * acqus - acquisition status parameters

SEE ALSO

zg, go
**xau, xaua, xaup**

**NAME**

- **xau** - execute an AU program
- **xaua** - execute the AU program specified with AUNM
- **xaup** - execute the AU program specified with AUNMP

**SYNTAX**

- **xau [<name>]**
- **xaua**
- **xaup**

**DESCRIPTION**

The command **xau** allows you to execute an AU program. It is not used very often because AU programs are normally executed simply by entering their names. The command **xau** is needed in the following cases:

- the AU program has not been compiled yet
- an XWIN-NMR command with the same name exists
- to call an Au program from an AU program (using the macro XAU)

Note that usually AU programs have already been compiled with **edau, compileall, cplbruk** or **cpluser**. Furthermore, it is not recommended to give an AU program the same name as an XWIN-NMR command. Before you start writing a new AU program, just type in the name you want to give it to find out if this name is already in use.

AU programs can be executed in three different ways:

```
xau
```

a list of all AU programs appears, you can click one to execute it

```
xau <name>
```

compiles the AU program <name> (if it is not compiled yet) and executes it

```
<name>
```

executes the AU program <name> (if it is compiled)

Furthermore, you can use the commands **xaua** and **xaup** to execute AU programs. These commands take no argument but execute the AU program which
is specified by the parameters AUNM and AUNMP, respectively. In all Bruker parameter sets, these parameters are set to relevant Bruker AU programs. For example, in the parameter set PROTON, AUNM = au_zg and AUNMP = proc_1d. When parameter sets are used in automation (ICON-NMR), the AU programs specified by AUNM and AUNMP perform the acquisition and the processing, respectively.

AU programs run in background and several of them can run simultaneously. You can use the command `follow` to see which AU programs and which part within each AU program are currently running. The command `kill` can be used to stop a running (or hanging) AU program.

For details on writing, compiling, and executing AU programs please refer to the XWIN-NMR AU reference manual (click Help → Other topics → Writing AU programs).

**INPUT PARAMETERS**

set by the user with `eda` or by typing `aunm`:

AUNM - acquisition AU program name for `xaua`

set by the user with `edp` or by typing `aunmp`:

AUNMP - processing AU program name for `xaup`

**INPUT FILES**

<xwhome>/exp/stan/nmr/au/src/

AU program source files (only input if the AU program is not compiled yet)

<xwhome>/prog/au/bin/

AU program binary executables

<du>/data/<user>/<name>/nmr/<expno>/

acqu - acquisition parameters (input file for `xaua`)

<du>/data/<user>/<name>/nmr/<expno>/pdata/<procno>/

proc - processing parameters (input file for `xaup`)

**USAGE IN AU PROGRAMS**

XAU(name)
XAUA
XAUP
XAUPW
XAUPW waits until the AU program has finished before the next statement is executed whereas XAUP doesn’t. XAUA works like XAUPW in this respect.

SEE ALSO
edau, delau, renau, expinstall, compileall, cplbruk, cpluser
NAME

zg - zero go: perform an acquisition

DESCRIPTION

The command zg performs an acquisition on the current dataset, overwriting possibly existing data. This involves the following sequence of actions:

1. Read the acquisition parameters
2. Compile the pulse program defined by the acquisition parameter PUL-PROG
3. Execute the pulse program. For most pulse programs this involves:
   - the acquisition of DS dummy scans
   - the acquisition of NS real scans, accumulating the data
   - storing the accumulated data to disk
4. Update the acquisition status parameters

Before you can start an acquisition with zg, you will normally have to prepare the experiment. This typically involves the following command sequence:

edhead - define the current probehead
edprosol - define the probehead and solvent dependent parameters
edc or new - define a new dataset and make it the current dataset
wobb or atma - tune and match the probehead (atma only for ATM probes)
lockdisp - open the lock display window
lock - lock the magnetic field
rsh or gradshim - read shim values or use gradient shimming
rpar - read a standard parameter set for the experiment you want to do
getprosol - get the probehead and solvent dependent parameters
edasp - set up nuclei (NUC1, NUC2 etc.) and the spectrometer routing
ased or eda - adjust the acquisition parameters to your needs
**zg** - acquire the data

They type of experiment is mainly determined by the pulse program. A simple 1D Bruker pulse program is **zg**, which contains the following lines:

```
1 ze ; zero memory, reset scan counter and phase lists, enable dummy scans, label 1
2 d1 ; relaxation delay with length D1, label 2
   pl ph1 ; pulse with length P1 and phase ph1
   go=2 ph31 ; sample TD points with phase ph31, loop to 2
                ; times NS+DS
   wr #0 ; write the data to the current dataset
exit ; end of the pulse program
ph1=0 2 2 0 1 3 3 1 ; phase program (list) used for the RF pulse
ph31=0 2 2 0 1 3 3 1 ; phase program (list) used for the receiver
```

The RF pulse **p1** is executed on the default channel (f1) with the default power level (PL1). The loop to label 2 will be performed NS times to accumulate this number of scans. The **wr** statement lies outside of this loop which means the data are only written to disk once, at the end of the experiment.

After **zg** has been started, you can observe the running acquisition in the acquisition menu. You can go there by clicking **Acquire → Observe fid window** or by entering **acqu** on the command line. Here the FID is displayed and continuously updated. Furthermore, an information window will appear showing the current scan, the total number of scans and the residual experiment time. You can go to the acquisition menu before or after you enter the command **zg**.

The purpose of dummy scans is to reach steady state conditions concerning T1 relaxation. This is necessary whenever the recycle delay of the experiment is shorter than 4 times the T1 value of the measured nucleus. Furthermore, dummy scans can be used to establish a stable temperature. This is especially important in decoupling experiments where the irradiation high power increases the sample temperature. The number of dummy scans is determined by the acquisition parameter DS. In the pulse program, the **ze** statement explicitly enables the **go** statement to perform dummy scans. The **zd** statement disables the execution of dummy scans.

In most 1D experiments, the acquired data are written to disk only once, at the end of the experiment. You can, however, use the command **tr** to write data to disk while the acquisition is running. This is, for example, useful if you want to
Acquisition commands

Do a Fourier transform and view the spectrum after a few scans. Another reason to use \texttt{tr} is to save the currently acquired scans of a long term experiment. This avoids losing all data in case of a power loss. In multidimensional experiments, the \texttt{wr} statement is part of a loop, and as such, is executed for each increment in the indirect dimension(s). Note that in XWIN-NMR 3.0 or later, Bruker 2D and 3D pulse program do not contain a \texttt{wr} statement. It has been replaced by the \texttt{mc} statement which performs both the disk write and loop back function.

\texttt{zg} allows you to perform 1D or multidimensional acquisition. The dimensionality of the data is determined by the pulse program. If this contains an \texttt{if} and/or \texttt{st} statement, \texttt{zg} assumes a 2D or 3D dataset. Furthermore, if the pulse program contains a nested loop with loop counters \texttt{td1} and \texttt{td2}, \texttt{zg} assumes a 3D dataset. Finally, the acquisition parameter PARMODE is evaluated. If the value of PARMODE is not consistent with the pulse program, \texttt{zg} will display a warning but allow you to continue the acquisition. 1D data are stored in a file named \texttt{fid} under the experiment number (\texttt{expno}) of the current dataset. 2D and 3D data are stored in a file named \texttt{ser} in the same directory. At the time of this writing, XWIN-NMR supports 1D, 2D and 3D datasets. However, the pulse program is not limited to 3D and allows you to acquire data in 4 or more dimensions. The resulting raw data (the \texttt{ser} file) can be processed by third party software that supports 4 or more dimensions. The parameters for the fourth and higher dimensions must be created manually.

Normally, an acquisition will run until it has finished. If, however, you want to interrupt it, you can do that with the command \texttt{halt}. This will finish the current scan, write the data to disk and then stop the acquisition. Note that \texttt{halt} finishes the current scan but not the current phase cycle. The command \texttt{stop} immediately stops the acquisition. It does not finish the current scan or write the data to disk. Instead of entering \texttt{stop}, you can also click the \texttt{stop} button. If, for some reason, \texttt{halt} and \texttt{stop} do not work, you can use the command \texttt{kill} to stop the acquisition.

When an acquisition has finished but you find out that the signal to noise is insufficient, you can accumulate additional scans. Just set the parameter NS to the number of extra scans and enter \texttt{go}. This command does not overwrite the existing data but adds the extra scans to them. Caution: \texttt{go} works correctly if the previous acquisition has finished normally but should not be used if this has been interrupted with \texttt{halt} or \texttt{stop} (see the description of \texttt{go}).

\texttt{zg} overwrites possibly existing raw data. Each user can configure XWIN-NMR to
get a warning about existing data or not. Enter the command `setres` and set the flag `ZGsafety` to `on` to get a warning. Note the difference between `zg` and `go`. The latter command does not overwrite existing data but adds new data to them.

After a manually performed acquisition has finished, it is normally processed with processing commands like `em, ft, apk` etc. This will automatically switch the display to the processing menu (if it wasn’t already there) and show you the spectrum. Processing commands are described in the Processing Reference Manual.

The command `zg` is automatically executed by AU programs that contain the ZG macro. Examples of these are `au_zg*`, `au_geti*` and `multizg`. Furthermore, `zg` is automatically executed when experiments are started from the automation interfaces ICON-NMR and `buttonnmr`.

Note that an acquisition always runs in background which means that XWIN-NMR can do other tasks simultaneously. You can change the display to a different dataset and process data there. This is actually what happens all the time during an automation sequence performed by ICON-NMR.

XWIN-NMR is supplied with a large number of pulse programs from simple 1D to sophisticated multidimensional experiments. Furthermore, you can write your own pulse programs with the `edpul` command using the Bruker pulse programs as an example. For a detailed description of the pulse program syntax click:

- Help → Other Topics → Writing pulse programs

**INPUT PARAMETERS**

all acquisition parameters as described in chapter 2

**OUTPUT PARAMETERS**

all acquisition status parameters as described in chapter 2

**INPUT FILES**

1D data

```
<du>/data/<user>/nmr/<name>/<expno>/
```

- acqu - acquisition parameters

2D data
Acquisition commands

<du>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters direct dimension (F2)
acqu2 - acquisition parameters indirect dimension (F1)

3D data

<du>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters direct dimension (F3)
acqu2 - acquisition parameters indirect dimension (F2)
acqu3 - acquisition parameters indirect dimension (F1)

All data

<xwhome>/exp/stan/nmr/lists/pp

<PULPROG> - the pulse program defined by PULPROG
<xwhome>/conf/instr/<curinst>/

scon - spectrometer parameters (created with edscon)

OUTPUT FILES

1D data

<du>/data/<user>/nmr/<name>/<expno>/

fid - raw data
acqus - acquisition status parameters

2D data

<du>/data/<user>/nmr/<name>/<expno>/

ser - raw data
acqus - acquisition status parameters direct dimension (F2)
acqu2s - acquisition status parameters indirect dimension (F1)

3D data

<du>/data/<user>/nmr/<name>/<expno>/

ser - raw data
acqus - acquisition status parameters direct dimension (F3)
acqu2s - acquisition status parameters indirect dimension (F2)
acqu3s - acquisition status parameters indirect dimension (F1)
All data

<du>/data/<user>/nmr/<name>/<expno>/

pulseprogram - the precompiled pulse program
scon - spectrometer parameters
cpdprg1 - CPD program (output if a cpd1:f2 statement is used)
cpdprg2 - CPD program (output if a cpd2:f2 statement is used)
.etc.
fq1list - variable frequency list (output if a fq1 statement is used)
fq2list - variable frequency list (output if a fq2 statement is used)
.etc.
spnam1 - shaped pulse definition (output if a sp1 statement is used)
spnam2 - shaped pulse definition (output if a sp2 statement is used)
.etc.
gpnam1 - shaped gradient definition (output if a gp1 statement is used)
gpnam2 - shaped gradient definition (output if a gp2 statement is used)
.etc.
vclist - variable counter list (output if a vc statement is used)
vdlst - variable delay list (output if a vd statement is used)
vplist - variable pulse list (output if a vp statement is used)
dslist - dataset list (output if a wr #n or wr ## statement is used)
cag_par - rotation matrices for gradients used for imaging
grdprog - shaped gradient definition (output if a ngrad statement is used)

USAGE IN AU PROGRAMS

ZG

SEE ALSO

go, gs, rga, wobb, atma, suspend, resume
Chapter 10

Temperature commands

This chapter describes commands which configure, control or monitor the temperature unit. A temperature unit which are delivered with Bruker spectrometers is often referred to as a eurotherm; the make of most units. They are used to warm up or cool down the NMR sample and keep it at a certain temperature during the experiment.
edte

NAME

edte - edit the temperature parameters

DESCRIPTION

The command `edte` opens a dialog box from which the temperature unit can be controlled. The functionality of this window is described in a separate manual that can be opened from the XWIN-NMR window by clicking `Help → Other topics → Temperature regulation` or from the `edte` window by clicking `Help → Edte Users Manual`.

SEE ALSO

`edtg`, `tepar`, `temon`, `teget`, `te2get`, `teset`, `te2set`, `teready`, `te2ready`
edtg

NAME

edtg - edit the temperature parameters for gradient temperature units

DESCRIPTION

The command edtg opens a dialog box from which the gradient temperature unit can be controlled. The functionality of this window is described in a separate manual that can be opened from the edtg window by clicking Help → Edtg Users Manual

SEE ALSO

edte, tepar, temon, teget, te2get, tese, te2set, teready, te2ready
teget, te2get

NAME

tegment - get the temperature from the temperature unit
te2get - get the second temperature from the temperature unit

DESCRIPTION

The command teget gets the temperature from the temperature unit and stores it in the acquisition status parameter TE.

te2get gets the so-called second temperature from a temperature unit with two regulators. The value is stored in the acquisition status parameter TE2. Temperature units with two regulators are, for example, used in BEST NMR where the first regulator controls the sample temperature and the second regulator controls the inlet capillary temperature.

OUTPUT PARAMETERS

TE - demand temperature on the temperature unit
TE2 - demand second temperature on the temperature unit

OUTPUT FILES

<du>/data/<user>/nmr/<name>/<expno>/

acqus - acquisition status parameters

USAGE IN AU PROGRAMS

TEGET
TE2GET

SEE ALSO

edte, tepar, temon, teset, te2set, teready, te2ready
temon

NAME
temon - temperature monitor

DESCRIPTION
The command *temon* opens a temperature monitor window which shows:

- the last measured temperature
- the time the last temperature was measured
- the minimum and maximum temperature since *temon* was started

The *temon* window offers the following buttons:

*Mode* - switches the display mode and shows the maximum and minimum temperature and the time at which they were measured

*Celsius/Kelvin* - switches between Celsius and Kelvin

*LogFile*
opens a new window with the following buttons:

*Write log file ON/OFF*
a radio button which allows you to switch on/off the writing to a log file

*Time Interval*
allows you to set the interval in which the logfile is updated. A list of possible time intervals appears and you must double click a value to select it.

*print log file*
prints the log file to the system default printer

*OK*
closes the LogFile window

*Close* - close the *temon* window

A graphical temperature monitor can be started by clicking:

*Data → Monitor temp. & Output Power*
from the *edte* dialog window.
OUTPUT FILES

<userhome>/xwinnmr-<hostname>/

temon - last measured temperature

<du>/data/<user>/nmr/<name>/<expno>/

temperatureLog - temperatures measured at regular intervals

SEE ALSO

edte, edtg, tepar, teget, te2get, teset, te2set, teready, te2ready
tepar

NAME

  tepar - get a predefined set of temperature unit parameters

SYNTAX

  tepar [<name>]

DESCRIPTION

  The command **tepar** gets a predefined set of temperature unit parameters. These are parameters which have been previously stored from the **edte** window by clicking *File → Save configuration*.

  The command **tepar** takes one argument and can be used in one of the following ways:

  **tepar**
  shows a list of available temperature parameter sets. When you click one, it is loaded to the temperature unit.

  **tepar <name.tcf>**
  loads the temperature parameter set <name> to the temperature unit.

INPUT FILES

  <xwhome>/exp/stan/nmr/lists/eurotherm/tcf/*
    temperature parameter sets

USAGE IN AU PROGRAMS

  TEPAR(filename)

SEE ALSO

  edte, edtg, tenon, teget, te2get, teset, te2set, teready, te2ready
**teready, te2ready**

**NAME**
- `teready` - wait until the temperature set with `teset` has been reached
- `te2ready` - wait until the temperature set with `te2set` has been reached

**SYNTAX**
```
  te-ready <stabilization time> <precision>
  te2-ready <stabilization time> <precision>
```

**DESCRIPTION**
The command `teready` waits until the demand temperature has been within the specified precision range for at least 10 seconds. If this does not happen within the specified stabilization time, `teready` terminates. `teready` is typically executed after setting the target temperature with the command `teset`. For example, the command sequence:

```
teset 320.0
teready 300 0.5
```

sets the temperature to 320.0 K and waits until this has been reached approximately. More precisely, it waits until the temperature has been between 319.5 and 320.5 for at least 10 seconds. After that, `teready` waits another 300 seconds to allow for temperature stabilization of the sample.

The stabilization time (in seconds) and precision (in Kelvin) must be specified as arguments, they are not prompted for if they are omitted.

`te2ready` works like `teready` except that it controls the so-called second temperature on a temperature unit with two regulators. These units are, for example, used in BEST NMR where the first regulator controls the sample temperature and the second regulator controls the inlet capillary temperature.

**USAGE IN AU PROGRAMS**
```
TEREADY(time, precision)
TE2READY(time, precision)
```
SEE ALSO

edte, edtg, tepar, temon, teget, te2get, teset, te2set
teset, te2set

NAME

teset - set the temperature on the temperature unit
te2set - set the second temperature on the temperature unit

SYNTAX

teset [ <temperature> ]
te2set [ <temperature> ]

DESCRIPTION

The command teset sets the temperature on the temperature unit. It takes one argument and can be used as follows:

teset
sets the temperature to the value of the acquisition parameter TE. Before you enter teset without argument you must set TE to the desired temperature, in Kelvin, either from eda or by typing te on the command line.

teset <temperature>
sets the temperature to the specified value.

The command teset is, for example, used in the AU programs au_zgte and multi_zgvt.

te2set works like teset except that it sets the so called second temperature to the value of the acquisition parameter TE2. This value is set on the second regulator of a temperature unit with two regulators. Such units are, for example, used in BEST NMR where the first regulator controls the sample temperature and the second regulator controls the inlet capillary temperature.

INPUT PARAMETERS

TE - demand temperature on the temperature unit (input of teset)
TE2 - demand temperature on the temperature unit (input of te2set)

INPUT FILES

<du>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters

USAGE IN AU PROGRAMS
TESET
TE2SET
VT
  executes the command tset <list_index>

SEE ALSO
  edte, edtg, tepar, teMon, teget, te2get, teready, te2ready
Chapter 11

MAS/Solids commands

This chapter describes commands which are used for solid state experiments. In most of them magic angle spinning is used. As such, most of the commands described here concern the control of the MAS pneumatic unit. Furthermore, commands for controlling the high power control unit (HPCU) are described. Note that this unit is used on Avance-AQX but not on Avance-AQS. On the latter, the HPCU commands are obsolete.
cfmas

NAME

cfmas - configure the MAS pneumatic unit

DESCRIPTION

The command cfmas allows you to configure the MAS pneumatic unit. It will prompt you for the rs232 channel and for the following information:

- **Minimum main pressure** (default 4000 mBar)
- **Insert air on time** (default 10 sec)
- **Eject air on time** (default 10 sec)
- **Sample diameter** (Wide or Normal)
  This actually concerns the type of eject mechanism. For probes with a tilting stator you must enter N(ormal), for probes with a fixed stator W(ide).
- **SpinLock tolerance** (default 5 Hz)
  For solid state MAS, the default value of 5 Hz can be accepted. For HR MAS, a value between 5 and 90 must be entered. The Spinlock tolerance refers to the required precision of the demand spin rate. If, for example, you specify 10 Hz and turn on the spinning, the spin rate will be adjusted until it has reached the demand spin rate plus or minus 10 Hz and stayed there for at least 5 seconds.

**cfmas** can also be executed as a part of the XWIN-NMR configuration suite (command `config`). When a hardware list is used (see `cf`), the MAS unit can be specified there. In that case, the command **cfmas** is not needed because the MAS unit is configured by `cf`.

INPUT AND OUTPUT FILES

- `<xwhome>/conf/Instr/<instrum>/rs232_device/`
  *mas* - serial port for MAS unit
- `<xwhome>/conf/Instr/<instrum>/`
  *mas_params* - MAS parameters
SEE ALSO

cf, config, mas, mascontrol, masr, masi, masg, mash, mase
edhpcu

NAME

edhpcu - edit the acquisition plus HPCU parameters

DESCRIPTION

The command edhpcu opens a dialog window with all acquisition parameters and all HPCU parameters. The former corresponds to the eda parameters. The latter involve the gain parameters HGAIN1 to HGAIN4 and XGAIN1 to XGAIN4 and the tune parameters TUNHIN, TUNHOUT and TUNXOUT.

INPUT AND OUTPUT PARAMETERS

all acquisition parameters and the following HPCU parameters:

HGAIN1 - HGAIN4 - gain level 1- 4 for 1H/19F tube transmitter
XGAIN1 - XGAIN4 - gain level 1- 4 for X nucleus tube transmitter
TUNHIN -1H/19F high power tube transmitter input tuning
TUNHOUT -1H/19F high power tube transmitter output tuning
TUNXOUT - X nucleus high power tube transmitter output tuning

INPUT AND OUTPUT FILES

<du>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters

SEE ALSO

gethpcu, sethpcu, rackpow
ed4ph

NAME

ed4ph - edit the 4-phase modulator parameters

DESCRIPTION

The command ed4ph opens a dialog box where you can set the parameters for the 4-phase modulator. This unit is mainly used for solid state experiments. This allows for a much faster 90° phase switching (+x, +y, -x, -y).

The following parameters are offered:

- FX_AX - F1 channel amplitude of +x
- FX_AMX - F1 channel amplitude of -x
- FX_PY - F1 channel phase of +y
- FX_PMY - F1 channel phase of -y
- FX_AY - F1 channel amplitude of +y
- FX_AMY - F1 channel amplitude of -y
- FX_PMX - F1 channel phase of -x

For the F2 channel, the corresponding parameters are called FH_. For the F3 channel, the corresponding parameters are called FY_. Note that not all spectrometers are equipped with the F3 channel. Furthermore, some spectrometers do have an F3 channel but no 4-phase modulator because the frequency is directly created on the synthesizer.

- RECEPHASE - receiver phase

When you enter a value in any of the above parameters and hit the return key, the entered value is immediately set on the 4-phase modulator.

At the bottom of the dialog box, the following push buttons are available:

- QUIT
  closes the dialog box

- LIST
  unused
**SaveToFile**
allows you to store the current values to disk. A list of existing file appears or you can enter a new filename.

**LoadParFile**
allows you to read a previously stored values from disk. A list of existing file appears.

**ReadAllPar**
unused

The regular way of phase switching, as it occurs in most high resolution experiments, is the use of a phase program like:

```
ph1 = 0 90 180 270
```

The phases are provided by the spectrometer FCU and require a certain time to be set, typically 3μsec. If you replace this phase program by the following one:

```
ph1 = +x +y -x -y
```

the same phase cycle is used but now the phases are provided by the 4-phase modulator. The switching time is now as short as 50nsec.

The 4-phase modulator can be use with or without an HPCU. In the former case, it must be connected to the 4-PH connector of the HPCU. In the latter case, it must be connected to the second rs485 channel of the CCU and must be specified in the hardware list (see also **cf**). Note that spectrometers which are equipped with transistorized amplifiers rather than tube amplifiers are not equipped with (and do not need) an HPCU.

The 4-phase modulator can only be used for hard pulses, not for shaped pulses. On Avance-AQS spectrometers, the 4-phase modulator is not needed and, as such, not supported. The reason is that the frequency generation on the SGU doesn’t cause any phase switching delays.

**OUTPUT FILES**

```
xwhome/exp/stan/nmr/lists/4ph/
```

**SEE ALSO**

`edhpcu`
mas

NAME

mas - open the MAS control window

DESCRIPTION

The command **mas** opens a dialog box where you can set the MAS parameters and control the pneumatic unit. The following entries are available:

**Probe Setup Filename**

shows a list of available MAS parameter files. These are files that have been stored previously from the **mas** window and contain the probehead type.

**Bearing Gas Port**

This button is only used for the older heat exchanger types that use 3 input lines. It allows you to select demand temperature. Possible values are *Ambient* (default), **-70°C** or **-120°C**. After selecting a temperature, this is set on the pneumatic unit.

**Probehead Selection**

a set of toggle buttons that allow you to set the following parameters:

- **Diameter**: sample diameter
- **Probe**: probehead type
- **Type**: magnet type, used to define tilt or no tilt of the stator (*see Insert sample below*)
- **Material**: rotor material
- **User**: unused

Clicking these buttons will toggle between their possible values. Only values that correspond to existing hardware are available. Together, the selected values will determine the algorithms that are used to spin the sample. When you enter **mas**, the current values are read from the MAS pneumatic unit.

**Main Pressure, Bearing Pressure, Drive Pressure, Spin Rate**
Each of these parameters shows three values:

- **Demand**: field showing the current demand value. If you enter a new value, this is set on the pneumatic unit.
- **Actual**: push buttons showing the actual value on the pneumatic unit. Note that they are only updated when clicked. They are, however, continuously updated, if the button *ContinuousUpdate* is highlighted.
- **Maximum**: not implemented.

The parameters are read from the MAS pneumatic unit when you enter the `mas` command. See also *Setting Mode*.

### Setting Mode

The MAS unit can work in two different modes:

- **Manual mode**
  you must enter the *Bearing Pressure* and *Drive Pressure*. The *Spin Rate* will be automatically adjusted.

- **Automatic mode**
  you must enter the *Demand Spin Rate*. The *Drive pressure* and *Bearing Pressure* will be automatically adjusted.

### Spinning

Allows you to switch the spinning on or off. Caution: after entering the *Insert Sample* command (see below), you must wait at least the time specified by *Insert Airtime* before you switch on the spinning.

### Spin Locked

Status flag that indicates whether or not the spin rate is locked. Spin Locked is automatically set to *yes* when the spin rate has reached the demand spin rate within a range of plus or minus 5 Hz and stayed there for more than 5 seconds. Spin Locked only works in Automatic mode.

### StartupProgram

Unused. It is automatically defined by *Probehead Selection* (see above).

### Insert Air Time

 Allows you to modify the Insert Air Time. By default, the value that was set with *cfmas* is used. Note that the value entered here is not stored on
disk. When you exit the mas window, it is set back to the value that was entered with cfmas.

**Eject Air Time**

Allows you to modify the Eject Air Time. By default, the value which was set with cfmas is used. Note that the value entered here is not stored on disk. When you exit the mas window, it is set back to the value that was entered with cfmas.

**Insert sample**

Before you click this button you must insert the spinner into the sample transfer tube. The effect depends on the probehead type. For standard bore probes, which tilt the stator for sample change, a period specified by Insert Airtime is waited and then the stator is tilted back to the magic angle. For probes where the stator is not tilted (all wide bore and some standard bore probes) an air flow through the insert line pushes the spinner into the stator. Standard bore probes that are not tilted are for example, all probes with 2.5 mm diameter and all probes for spectrometer ≥ 700 MHz.

**Eject sample**

ejects the sample from the stator. Before you click this button, you must stop the spinning.

**Continuous Update**

causes the parameters Main Pressure, Bearing Pressure, Drive Pressure and Spin Rate to be continuously updated, i.e. read from the MAS pneumatic unit.

**Save**

saves the current parameters to a Probe Setup Filename

**Edit**

allows you to edit Probe Setup Files

**List**

unused

**Cancel**

exits the mas dialog box.
INPUT FILES

<xwhome>/exp/stan/nmr/lists/mas/
  Probe Setup Files (input of mas \textarrow Probe Setup Filename)
<xwhome>/conf/instr/<instrum>/
  mas\_params - MAS parameters

OUTPUT FILES

<xwhome>/exp/stan/nmr/lists/mas/
  Probe Setup Files (output of mas \textarrow Save)

SEE ALSO

mascontrol, cfmas, masrmon, masr, masi, masg, mash, mase
mascontrol

NAME
mascontrol - open the MAS monitor and control window

DESCRIPTION
The command mascontrol opens a dialog box where you can set the MAS parameters and monitor the MAS pneumatic unit. It can be used as an alternative to the commands mas and masrmon.

mascontrol starts by opening a small window where you can select the probehead. After doing that, a new window appears where the current MAS spin rate is displayed and the following buttons are available:

Mode
When you click this button, the MAS spin rate is shown and new additional buttons will appear:

insert (for wide bore probes and standard bore probes without stator tilt)
Before you click this button, you must insert the spinner into the sample transfer tube. The action of insert depends on the probehead type. For standard bore probes, which tilt the stator for sample change, insert waits a period specified by Insert Airtime and then tilts the stator back to the magic angle. For probes where the stator is not tilted (all wide bore and some standard bore probes), insert causes an air flow through the insert line that pushes the spinner into the stator.

set angle (for standard bore probes with stator tilt)
See insert.

eject
ejects the sample from the probehead. It switches the air flow on for a time which has been defined with cfmas.

start
brings the sample rotation up to the demand spin rate.

stop
stops sample rotation.
When you click this button, a new window appears with the radio button:

**Write log file ON/Write log file OFF**

switches the writing of the log file on/off. The log file is stored under the EXPNO of the dataset where *mascontrol* was started.

and the following push buttons:

**Screen Update**
allows you to set the screen update interval (seconds). A list of possible time intervals appears and you must double click a value to select it.

**Logfile time interval**
allows you to set the interval at which the logfile is updated. A list of possible time intervals appears and you must double click a value to select it.

**Select new probe**
opens a new window with all available probeheads will appear. When you click one, the *mas* dialog window will be opened where you can read a new Probehead Setup Filename or select a new probehead.

**Set new spin rate**
opens a new dialog window where you can change the spin rate.

**Show log file**
shows the MAS log file on the screen.

**Print log file**
prints the log file on the system default printer.

**INPUT AND OUTPUT PARAMETERS**
can be viewed with *dpa* or by typing *ls masr*:

MASR - MAS spin rate

**INPUT FILES**

<xwhome>/prog/tcl/xwish3_scripts/

*mascontrol* - mascontrol Tcl/Tk startup script

<du>/data/<user>/nmr/<name>/<expno>/

*acqu* - acquisition parameters
OUTPUT FILES
<du>/data/<user>/nmr/<name>/<expno>/
  acqus - acquisition status parameters
  masRateLog - spin rate log file

SEE ALSO
  mas, masrmon, cfmas, masr, masi, masg, mash, mase
masr,iasi, masg, mash, mase

NAME

masr - set the spin rate
masi - insert the spinner
masg - start spinning
mash - halt the spinner
mase - eject the spinner

DESCRIPTION

MAS control like sample insert and eject, sample rotation etc. is usually done from one of the MAS control windows (commands mas or mascontrol). It can, however, also be done with the commands described on this page.

masr
Prompts you for the demand spin rate and then sets the specified value on the MAS pneumatic unit. It also sets the acquisition parameter MASR.

masr get
reads the actual spin rate from the pneumatic unit and stores it into the acquisition status parameter MASR.

masr acqu
sets the demand spin rate on the MAS pneumatic unit according to the acquisition parameter MASR.

masi
Before you enter this command you must insert the spinner into the sample transfer tube. The action of masi depends on the probehead type. For standard bore probes, which tilt the stator for sample change, masi waits a period specified by Insert Airtime and then tilts the stator back to the magic angle. For probes where the stator is not tilted (all wide bore and some standard bore probes), masi causes an air flow through the insert line that pushes the spinner into the stator.

masg
Starts the sample rotation according to the demand spin rate.

masg wait shows the values of Lock Status (LoSt), Spin Rate (VA), Driver Pressure (PD) Bearing Pressure (PB), Bearing Sense Pressure (PS). It blocks
all other MAS commands until Lock Status is 1. It is typically used in automation (see the macro MASG below).

**mash**

Stops the sample rotation.

**mash wait** does the same but blocks all other MAS commands until the spin rate has become zero. It is typically used in automation (see the macro MASH below).

**mase**

Ejects the sample from the probehead. It switches the air flow on for a time which has been defined with `cfmas`.

Note that all these commands, except for `masr get`, are ignored when an acquisition is running. No error message is displayed.

More information on MAS is available in some manuals which can be opened from XWIN-NMR by clicking **Help → Other topics**:

→ **Solids Users Manual**

→ **Help → Other topics → SB/MAS Manual**

→ **BASH spectrometer documentation**

Note that the last manual requires the BASH CDROM.

**INPUT PARAMETERS**

MASR - MAS spin rate (input of `masr acqu`)

**OUTPUT PARAMETERS**

MASR - MAS spin rate (acquisition status parameter, output of `masr get`)

MASR - MAS spin rate (acquisition parameter, output of `masr`)

**INPUT FILES**

<du>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters

<xwhome>/conf/instr/<instrum>/

mas_params - MAS parameters (input of `masi` and `mase`)
MAS/Solids commands

### USAGE IN AU PROGRAMS

MASI
MASE

MASR
executes the command `masr acqu`

MASRGET
executes the command `masr get`

MASH
executes the command `mash wait`

MASG(retries)
executes the command `masg wait n`, where $n$ is the number of retries

### SEE ALSO

cfmas, mas, mascontrol, masrmon
masrmon

NAME

masrmon - monitor the MAS spin rate

DESCRIPTION

The command masrmon monitors the MAS spin rate. It opens a dialog box with the following buttons:

LogFile
opens a new window with the following buttons:

Write log file ON/OFF
a radio button which allows you to switch on/off the writing to a log file

Time Interval
allows you to set the interval in which the logfile is updated. A list of possible time intervals appears and you must double click a value to select it.

print log file
prints the log file to the system default printer

OK
closes the LogFile window

Mode
allows you to toggle between the following display modes:

• the mode showing the current spin rate
• the mode showing the current, maximum and minimum spin rate and the times at which they occurred.

Close
closes the MAS monitor window

OUTPUT PARAMETERS

can be viewed with dpa or by typing ls masr:

MASR - MAS spin rate
OUTPUT FILES
<du>/data/<user>/nmr/<name>/<expno>/
    acqus - acquisition status parameters
    masRateLog - spin rate log file

SEE ALSO
    mas, mascontrol, cfmas, masr, masi, masg, mash, mase
rackpow, gethpcu, sethpcu

NAME
rackpow - switches the high power cabinet on/off
gethpcu - reads the gain and I/O tuning values of tube amplifiers from the HPCU
sethpcu - sets the gain and I/O tuning values of tube amplifiers on the HPCU

DESCRIPTION
The command **rackpow** switches the high power cabinet on or off. This is done according to the acquisition parameter POWMOD. For POWMOD = low, it is switched off, for POWMOD = high, it is switched on.

The command **gethpcu** reads the gain from the HPCU and stores them into the acquisition parameters HGAIN1 to HGAIN4, XGAIN1 to XGAIN4. Furthermore, it reads the I/O tuning values of tube amplifiers from the HPCU and stores them into the acquisition parameters TUNHIN, TUNHOUT and TUNXOUT.

The command **sethpcu** sets the gain from the HPCU according to the acquisition parameters HGAIN1 to HGAIN4, XGAIN1 to XGAIN4. Furthermore, it sets the I/O tuning values of tube amplifiers on the HPCU according to the acquisition parameters TUNHIN, TUNHOUT and TUNXOUT.

INPUT AND OUTPUT PARAMETERS
HGAIN1 - HGAIN4 - gain level 1-4 for the 1H/19F tube transmitter
XGAIN1 - XGAIN4 - gain level 1-4 for the X nucleus tube transmitter
TUNHIN - 1H/19F high power tube transmitter input tuning
TUNHOUT - 1H/19F high power tube transmitter output tuning
TUNXOUT - X nucleus high power tube transmitter output tuning

INPUT FILES
<du>/data/<user>/nmr/<name>/<expno>/acqu - acquisition parameters (input for **rackpow** and **sethpcu**)

OUTPUT FILES
<du>/data/<user>/nmr/<name>/<expno>/acqu - acquisition parameters (output of **gethpcu**)
USAGE IN AU PROGRAMS
  RACKPOW
  SETHPCU
  GETHPCU

SEE ALSO
  edhpcu
Chapter 12

Rename and delete commands

This chapter describes XWIN-NMR commands which allow you to rename or delete acquisition related files. These include parameter sets, pulse programs, gradient programs shim sets, AU programs, XWIN-NMR macros and various lists.
delpar, delpul, delgp, delsh, delau, delmac

NAME

delpar - delete parameter sets
delpul - delete pulse programs
delgp - delete gradient programs
delsh - delete shim files
delau - delete AU programs
delmac - delete macros

SYNTAX

delpar [ <name> ]

delpul, delgp, delsh, delau and delmac have the same syntax as delpar

DESCRIPTION

The command delpar displays a list of parameter sets, both Bruker and user defined. Each entry shows the parameter set name and the parameter types in that set. You can mark one or more parameter sets for deletion and then click Execute to actually delete them. Furthermore, you can print the list by clicking the Print button. If you have accidentally removed Bruker parameter sets, you can re-install them with the command expinstall.

The other del* commands mentioned here all work like delpar, deleting the type of files as specified above. Note that delau deletes both the selected AU source files and the corresponding executable files. If you accidentally delete Bruker AU programs, pulse programs or gradient programs, you can re-install them with expinstall. In case of AU programs, you must also compile them with cplbruk or xau.

INPUT FOLDERS

<xwhome>/exp/stan/nmr/par - Bruker and user defined parameter sets
<xwhome>/exp/stan/nmr/lists/pp - Bruker and user defined pulse programs
<xwhome>/exp/stan/nmr/lists/gp - Bruker and user defined gradient programs
<xwhome>/exp/stan/nmr/lists/bsms - shim files
<xwhome>/exp/stan/nmr/lists/mac - Bruker and user defined macros
<xwhome>/exp/stan/nmr/au/src - Bruker and user defined source AU programs
<xwhome>/prog/au/bin - Bruker and user defined binary AU programs
<xwhome>/exp/stan/nmr/lists/mac - Bruker and user defined macros

**USAGE IN AU PROGRAMS**

DELPAR(name)

No AU macros are available for the other `del*` commands.

**SEE ALSO**

dellist
dellist

NAME
dellist - delete various lists

SYNTAX
dellist [<name>]

DESCRIPTION
The command `dellist` displays a list of various lists types. Most of them are used in acquisition, e.g. `vd` lists contain variable delays which are read by the `vd` statement in pulse programs. When you click a list type, the available files of that type appear. You can click individual entries to mark them for deletion or click the button `Select all`. Clicking the `Execute` button deletes all marked entries.

All lists which appear with `dellist` can be printed by clicking the `Print` button.

INPUT FILES
<xwhome>/exp/stan/nmr/lists

- `pp` - pulse programs
- `cpd` - CPD programs
- `gp` - gradient programs
- `ds` - dataset lists
- `vc` - variable counter lists
- `vd` - variable delay lists
- `vp` - variable pulse lists
- `vt` - variable temperature lists
- `f1` - frequency lists
- `f2`, `f3` - frequency lists (A*X spectrometers only)
- `mac` - XWIN-NMR macros
- `roi` - 2D integral ranges
- `scl` - scaling region files
- `masr` - MASR rotation values
SEE ALSO

delpar, delpul, delgp, delsh, delau, delmac
rename, renpar

NAME

renau - rename AU programs
renpar - rename parameter sets

DESCRIPTION

The command renau opens a dialog box with all AU programs, both Bruker and user defined. You can rename one or more AU programs, simply by replacing their names. When you enter a new name and press the Enter key, the AU program is immediately renamed. This counts for both the source and the binary file. The dialog box can be closed by clicking Cancel.

renpar works like renau, except that it allows you to rename parameter sets. Parameter sets are directories, so renpar changes directory names; the names of the parameter files in those directories (acqu, proc, meta, outd) are not affected.

INPUT AND OUTPUT FILES

For renau:

<xwhome>/exp/stan/nmr/au/src/*
<xwhome>/prog/au/bin/*

For renpar:

<xwhome>/exp/stan/nmr/par/*

SEE ALSO

rengp, renlist, renlut, renmac, renpul
renpul, rengp, renlut, renmac

NAME
renpul - rename pulse programs
rengp - rename gradient programs
renlut - rename 2D lookup tables
renmac - rename macros

DESCRIPTION
The command renpul opens a dialog box with all pulse programs, both Bruker and user defined. You can rename one or more pulse programs, simply by replacing their names. When you enter a new name and hit the Enter key, the pulse program is immediately renamed. The dialog box can be closed by clicking Cancel.

In the same way, rengp, renlut and renmac allow you to rename, gradient programs, 2D lookup tables and macros respectively.

INPUT AND OUTPUT FILES
<xwhome>/exp/stan/nmr/lists/ pp/*
pulse programs
<xwhome>/exp/stan/nmr/lists/ gp/*
gradient programs
<xwhome>/exp/stan/nmr/lut/*
2D lookup tables
<xwhome>/exp/stan/nmr/lists/mac/*
XWIN-NMR macros

SEE ALSO
renlist, renau, renpar
rename

NAME
renlist - rename various lists

DESCRIPTION
The command *renlist* displays a list with various lists types, most of which are used in acquisition. When you click a list type, a dialog box appears with the available entries of that type. You can rename one or more entries, simply by replacing their names. When you enter a new name and hit the *Enter* key, the list is immediately renamed. The dialog box can be closed by clicking *Cancel*.

INPUT AND OUTPUT FILES
<xwhome>/exp/stan/nmr/lists/*

SEE ALSO
renau, renpar, rengp, renlut, renmac, repul
Chapter 13

Miscellaneous

This chapter describes XWIN-NMR commands that are somehow acquisition related and have not been described in previous chapters.
pulsdisp

NAME

pulsdisp - open the pulse program display

DESCRIPTION

The command pulsdisp simulates the pulse sequence and shows it in a graphical representation. It uses the pulse program of the current dataset as it is defined by the acquisition parameter PULPROG. The graphical representation includes the pulse program timing, frequencies, phases and power levels.

The pulse program display can be started by entering pulsdisp on the command line or click Windows → Pulse program. First a small window will appear where you can select the length of the simulation and the elements to be displayed. The following fields/buttons are available:

- **Observe Setup**
  - This button to select the elements to be displayed. A new window will appear from which you can select the elements to be displayed. The following check buttons are available:
    - **CHn**
      - select the pulse channels to be displayed
    - **FCUn**
      - select the frequency unit for which you want to display the phases and/or power levels
    - **GCUX, GCUY, GCUZ**
      - select the X, Y and/or Z gradient output to be displayed
    - **RCUGO**
      - select receiver control to be displayed
    - **Receiver**
      - display the receiver status (on/off) and receiver phase
    - **Prog**
      - show the pulse program statement for each time segment
    - **Apply**
      - store the current settings of the Observe Setup window
OK
store the current settings of the Observe Setup window and quit

- **Time/Scans**
  allows you to choose between the display of a certain time interval or a certain number of scans.

- **Start** and **Stop**
  allows you to enter the simulation starting point and end point, respectively. The entered values will be interpreted as time values, if you selected **Time** in the previous step and as scan numbers if you selected **Scans**. You can also specify a negative number to simulate dummy scans. This, however, only works if the acquisition parameter DS is set to a positive value. If you checked one or more FCUn channels in the Observe Setup window, then the value in the **Start** field will be ignored. In that case, the simulation will always start with the first scan (scan 0 or time 0.0).

- **Run simulation**
  starts the simulation. This usually takes a few seconds, depending on the pulse sequence and selected time interval or number of scans. When the simulation is finished, a new window will appear showing the graphical representation of the pulse sequence: the actual pulse program display. This consists of one row for each element that was selected in the Observe Setup window. You will see the exact timing of the entire sequence including the implicit delays that, for example, occur in the statement \( go=n \). The following buttons are available:

  **Setup display**: clicking this button will open a new dialog box that is equivalent to the one opened by **Observe Setup**. It allows you to change the simulation selection, for the current simulation window. It will not affect the selection for possible other simulation windows nor does it affect the selection in the original **Observe Setup** window.

  **Zoom in**
  allows you to investigate the fine details of the pulse sequence. Particularly text labels indicating the length of durations, power levels in db or percent units, phases in degrees, or pulse program text will only appear after you zoom. Note that the timing sequence also shows the so called implicit delays. These are delays which do not appear as such in the pulse program but are introduced by statements like \( go=n \).

  **Zoom out**
allows you to undo the effect of **Zoom in** and get an overview of the entire simulation.

**New display**
allows you to open an extra pulse display window which is a copy of the first one. You can, for example, use one window to zoom in and the other for an overview.

**Kill display**
allows you to close the current pulse display window.

**Print**
allows you to print the current pulse display window. A dialog box will be opened where you can print, print to file, preview the print and setup the printer. Note that, for a long simulation, you might want to use multiple sheets of paper. You can specify this in the **Split to X*Y Pages** field in the **Setup** window.

If you checked one or more FCUn simulations in the Observe Setup window, and the pulse program has many phase changes, the simulation time might take very long. Furthermore, it can happen that the available memory limit is exceeded or the graphics gets too large and will be truncated (an error message will appear if this happens).

- **New Display**
- **Show program**
  show the contents of the pulse program
- **Undo**
  undo the last change
- **Quit**
  quit the pulse program display

The pulse display startup window also offers the following menu:

- **File**
  
  **Quit**
  quite the pulse program display (same as the **Quit** button)
- **View**
  
  **New display**
  **Kill displays**
Align displays

- **Options**

**Scale setup**
allows you to select the time axis scaling mode; *cut* or *logarithmic*. *Cut* scaling will result in a true representation of all duration in the pulse program shorter than the time constant TC. Durations that exceed TC, it will be represented with thick solid lines. TC can be specified in the field *Time constant*. Logarithmic scaling will cause a compressed representation of all durations. Nevertheless, since pulse lengths are usually a in the range of microseconds and delays in the range of milliseconds or seconds, a logarithmic representation can give a better overview.

**Observe setup**
same as the *Observe setup* button described above

**FCU simulator setup**
allows you to select the pulse power units (db, a logarithmic unit, or %, a linear unit).

**Printer setup**
allows you to select the printer and setup the print parameters for printing the pulse program display window.

- **Help**
Pulse program display Quick-Start Guide

If you change acquisition parameters or the pulse program while the pulse program display is open, you must quit and restart it. Just clicking *New display* or even *Run simulation* again will not account for the change.

**INPUT FILES**

<xwhome>/prog/app-defaults

PulseDisplay - pulse program display resources

**SEE ALSO**

spdisp
spdisp

NAME
spdisp - symbolic (graphical) pulse program display

DESCRIPTION
The command spdisp opens a new window with a symbolic pulse program display. It takes one argument and can be used as follows:

spdisp
  displays the pulse program defined by the acquisition parameter PULPROG

spdisp <name>
  displays the pulse program <name>

spdisp starts the pulse program display part of NMR-SIM. The functionality of the program is described in the NMR-SIM manual. This can be opened by clicking Help from the window that is opened by spdisp. spdisp actually starts the AU program showpp, which, in turn, calls the pulse program display of the NMR-SIM program. The following commands are equivalent:

spdisp <name>
showpp <name>
nmrsim -showp <name>

spdisp can only start if the following conditions are met:
  • the Bruker AU programs have been installed (with expinstall)
  • the NMR-SIM program is installed (from the NMR Suite CDROM)

The difference between spdisp and pulsdisp is the following. spdisp gives a graphical representation of the pulse sequence and is well suited for desktop publishing. pulsdisp shows the pulse sequence in much greater detail and is primarily useful for the investigation of new pulse sequences.

INPUT FILES
<xwhome>/exp/stan/nmr/au/
  showpp - AU program started by spdisp (source file)
<xwhome>/prog/au/bin

showpp - AU program started by spdisp (binary file)

SEE ALSO
pulsdisp, nmrsm
edacb

NAME
edacb - edit the Amplifier Control Board parameters

SYNTAX
edacb [<filename>]

DESCRIPTION
The command **edacb** allows you to edit the ACB parameters and load them to the spectrometer hardware. The ACB parameters define the upper limits above which the power is switched off. These limits are used to protect the probehead in case too high power levels or pulse lengths are used. Normally the default limits can be used in which case you do not need to execute **edacb**. Only for special probeheads or transmitters, it might be useful to set sharper limits.

At the top of the dialog box, the current probehead (as defined with **edhead**) is displayed. Below that, the ACB parameters are listed. These are:

- pulse power: pulse power in W(att) or %
- pulse width: pulse length in ms (millisecond) or %
- duty cycle: the (pulse width)/period ratio in %
- reflected power: pulse power not reaching the probe in W(att) or %

where period is defined as the time between the start of two successive pulses. The current values of the ACB parameters are shown for each amplifier (as detected by **cf**). Furthermore, the minimum and maximum allowed values are displayed for each parameter. The pulse power can be entered with the unit W, without unit (same as W) or with the unit %. The latter is interpreted as is the percentage of the nominal power of the amplifier. The pulse width can be entered with the unit ms, without unit (same as ms) or with the unit %. The latter is interpreted as the percentage of the maximum pulse width as specified above the entered value.

Note that the ACB parameters are interdependent. For example, if you decrease the pulse power, you can increase the pulse width or, if you increase the period between the pulses, you can also increase the pulse width.

At the bottom of the dialog box, the following buttons are offered:
Set parameters
Sets the current values on the spectrometer hardware. You are first prompted for the NMR Superuser password.

Save as..
Saves the ACB values to disk, including minimum and maximum values and probehead identification. You are first prompted for the NMR Superuser password. Then a list of existing filenames and you can select one of them. Alternatively, you can enter a new filename.

Load from..
Allows you to read previously saved values from disk. A list of existing files will appear and you can select one of them. If the minimum/maximum values do not match your amplifiers (as detected by cf), or the probehead identification does not match the current probehead (as defined by edhead) you will get a warning. In that case you are prompted to cancel or continue the loading.

Save
Only active after the current values have been saved with Save as... Saves the ACB parameters to the filename displayed in the title bar of the dialog box.

About
Displays information about the edacb version and software support.

Quit
Closes the edacb dialog box discarding all changes.

The command edacb can also be entered with one argument; the name of an ACB parameter file. The values in the file are automatically loaded to the hardware. As such, the command edacb <filename> can also be used in automation.

INPUT AND OUTPUT FILES
/xwhome/conf/instr/<instrum>/acbpar/*
ACB parameters files

SEE ALSO
cf
crpon, crpoff, crplock, crpobs

NAME

crpon - switch the cryo preamplifier on for the lock and observe channel
crpoff - switch the cryo preamplifier off for the lock and observe channel
crpobs - switch the cryo preamplifier on for the observe channel
crplock - switch the cryo preamplifier on for the lock channel

DESCRIPTION

The crp* commands listed above control the internal preamplifier of a cryo-probe. Cryo probeheads operate at a reduced coil and preamplifier temperature which improves the signal to noise with a factor of 4. They are available as Dual or Triple resonance probeheads.

The command crpon switches from the external (HPPR) preamplifier to the internal cryo preamplifier. This happens for both the observe and the lock channel.

The command crpoff switches from the internal cryo preamplifier to the external (HPPR) preamplifier. This happens for both the observe and the lock channel.

The command crplock switches from the external (HPPR) preamplifier to the internal cryo preamplifier. This happens for the lock channel only.

The command crpobs switches from the external (HPPR) preamplifier to the internal cryo preamplifier. This happens for the observe channel only.

SEE ALSO

edhead
getlim1d, getlcosy, getlxhco, getljres, getlinv

NAME

getlim1d - determine the 1D spectral width according to integral ranges
getlcosy - determine the 2D cosy spectral width according to 1D integral ranges
getlxhco - determine the 2D xhco spectral width according to 1D integral ranges
getljres - determine the 2D jres spectral width according to 1D integral ranges
getlinv - determine the 2D invers spectral width according to 1D integral ranges

DESCRIPTION

The getl* commands listed above determine and set the optimum spectral width for the specified experiment types. The optimum spectral width is determined from one or two associated 1D datasets that are defined as the so-called second and third dataset (see edc2). Before the actual experiment is performed, the second (and if necessary the third) dataset must be acquired, Fourier transformed and baseline corrected. The latter processing step implicitly determines the integral ranges. The getl* commands determine the spectral width such that it includes all integral ranges, in other words, all signals.

getl* commands are typically used in automation. They are called from AU programs like au_getlim1d, au_getlcosy, au_getlinv and au_getlxhco. These, in turn are called by ICON-NMR where the preparation and the actual experiment are defined as a so-called ‘composite’ 2D experiment (see ICON-NMR Online help for more information).

getlim1d determines the optimum spectral width on a 1D preparation experiment and then sets the parameter SW on the current 1D dataset accordingly.

getlcosy determines the optimum spectral width on one 1D preparation experiment. Then it sets the F2-SW and F1_SW on the current 2D COSY dataset accordingly.

getlxhco determines the optimum spectral width for F2 and F1 on two different 1D preparation experiments (typically 1H and X). Then it sets the F2-SW and F1-SW on the current 2D XH correlation dataset accordingly.

getljres determines the optimum spectral width on one 1D preparation experiment. Then it sets F2-SW on the current 2D J-resolved dataset in accordingly.
\texttt{getlinv} determines the spectral width on one 1D preparation experiment. Then it sets F2-SW on the current 2D INVERSE dataset accordingly.

Note that F2-SW refers to the acquisition parameter SW in the F2 dimension and F1-SW refers to the same parameter in the F1 dimension.

The first 1D preparation experiment is defined as the so called second dataset. The second 1D preparation experiment is defined as the so called third dataset. Both can be defined with the command \texttt{edc2}.

**OUTPUT PARAMETERS**

SW - spectral width in ppm

**INPUT FILES**

\texttt{<du>/data/<user>/nmr/<name>/<expno>/pdata/<procno>}

- \texttt{intrng} - integral regions
- \texttt{curdat2} - definition of second and third dataset

**OUTPUT FILES**

\texttt{<du>/data/<user>/nmr/<name>/<expno>/}

- \texttt{acqu} - acquisition parameters
- \texttt{acqu2} - F1 acquisition parameters of a 2D dataset

**USAGE IN AU PROGRAMS**

\texttt{GETLIM}

executes the command \texttt{getlim1d}

\texttt{GETLCOSY}

\texttt{GETLXHCO}

\texttt{GETLJRES}

\texttt{GETLINV}
Chapter 14

NMR Suite files

This chapter describes the files which are involved in XWIN-NMR acquisition. For each file, the commands that typically create or modify the file are specified. If no command is specified, the file is delivered with XWIN-NMR and not modified by any command. Furthermore, the commands that typically interpret a file are specified. If no command is specified, the file can usually be read from a UNIX shell or Windows Explorer or is to be used by a external program. Note that the specified commands can be started, manually, from the XWIN-NMR command line or, automatically, from an AU program or ICON-NMR. Files that are created by ICON-NMR are not described here but in the ICON-NMR manual. Note that, for each file, only the most important commands that access the file are mentioned here.

For each file, the file type is specified which has one of the following letters:

- **a** - ascii file. It can be opened by a text editor.
- **j** - JCAMP-DX file. It can be opened with a text editor and interpreted by any software which supports JCAMP-DX.
- **b** - binary file. Data file with consecutive 32-bit integer values.
- **e** - binary executable
- **d** - directory with files and/or sub directories
- **t** - Tcl/Tk script
### 1D data files

<table>
<thead>
<tr>
<th>File</th>
<th>Created or modified by&lt;sup&gt;a&lt;/sup&gt;</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;du&gt;/data/&lt;user&gt;/nmr/&lt;name&gt;/&lt;expno&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>fid</td>
<td>zg, genfid</td>
<td>bc, em, ft</td>
<td>1D raw data (b)</td>
</tr>
<tr>
<td>acqu</td>
<td>rpar, eda</td>
<td>zg</td>
<td>acquisition parameters (j)</td>
</tr>
<tr>
<td>acqus</td>
<td>rpar, zg</td>
<td>dpa, lpa</td>
<td>acquisition status parameters (j)</td>
</tr>
<tr>
<td>audita.txt</td>
<td>zg</td>
<td></td>
<td>acquisition audit trail (j)</td>
</tr>
<tr>
<td>pulse_program</td>
<td>zg</td>
<td></td>
<td>precompiled pulse program (j)</td>
</tr>
<tr>
<td>format.lpa</td>
<td>zg</td>
<td>lpa</td>
<td>acquisition parameter format (a)</td>
</tr>
<tr>
<td>format.temp</td>
<td>zg</td>
<td>plot, view</td>
<td>acquisition parameter format (a)</td>
</tr>
<tr>
<td>relations</td>
<td>getprosol</td>
<td></td>
<td>prosol-acquisition relations (a)</td>
</tr>
<tr>
<td>cpdprg1</td>
<td>zg(cpdl)</td>
<td></td>
<td>CPD program defined by CPDPRG1 (a)</td>
</tr>
<tr>
<td>cpdprg2</td>
<td>zg(cpdl)</td>
<td></td>
<td>CPD program defined by CPDPRG2 (a)</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>scon</td>
<td>zg</td>
<td></td>
<td>copy of the edscgon parameters (j)</td>
</tr>
<tr>
<td>spnam1</td>
<td>zg(sp1)</td>
<td></td>
<td>shaped pulse definition (j)</td>
</tr>
<tr>
<td>spnam2</td>
<td>zg(sp2)</td>
<td></td>
<td>shaped pulse definition (j)</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>fq1list</td>
<td>zg(fq1)</td>
<td></td>
<td>variable frequency list (j)</td>
</tr>
<tr>
<td>fq2list</td>
<td>zg(fq2)</td>
<td></td>
<td>variable frequency list (j)</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>vclist</td>
<td>zg(vc)</td>
<td></td>
<td>variable counter list (a)</td>
</tr>
<tr>
<td>vdlist</td>
<td>zg(vd)</td>
<td></td>
<td>variable delay list (a)</td>
</tr>
<tr>
<td>vplist</td>
<td>zg(vp)</td>
<td></td>
<td>variable pulse list (a)</td>
</tr>
<tr>
<td>vtlist</td>
<td></td>
<td></td>
<td>variable temperature list (a)</td>
</tr>
<tr>
<td>popt.array</td>
<td>popt</td>
<td>popt</td>
<td>parameter optimization setup (a)</td>
</tr>
</tbody>
</table>
1D data files

<table>
<thead>
<tr>
<th>File</th>
<th>Created or modified by(^a)</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>popt.proto-col</td>
<td>popt</td>
<td>popt</td>
<td>parameter optimization result (a)</td>
</tr>
<tr>
<td>masRateLog</td>
<td>masrmon, mascontrol</td>
<td></td>
<td>MAS spin rate log file (j)</td>
</tr>
<tr>
<td>cag_par</td>
<td>zg</td>
<td></td>
<td>gradient rotation matrices</td>
</tr>
</tbody>
</table>

\(^a\) Some files are only created if the corresponding pulse program statement (specified between brackets) is used.

2D data files

<table>
<thead>
<tr>
<th>Filename</th>
<th>Created or updated by</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;du&gt;/data/&lt;user&gt;/nmr/&lt;name&gt;/&lt;expno&gt; ser</td>
<td>zg, genser</td>
<td>xfb, xf2</td>
<td>raw data - series of FIDs (b)</td>
</tr>
<tr>
<td>acqu</td>
<td>rpar, eda</td>
<td>zg</td>
<td>F2 acquisition parameters (j)</td>
</tr>
<tr>
<td>acqu2</td>
<td>rpar, eda</td>
<td>zg</td>
<td>F1 acquisition parameters (j)</td>
</tr>
<tr>
<td>acqus</td>
<td>rpar, zg</td>
<td>dpa</td>
<td>F2 acquisition status parameters (j)</td>
</tr>
<tr>
<td>acqu2s</td>
<td>rpar, zg</td>
<td>dpa</td>
<td>F1 acquisition status parameters (j)</td>
</tr>
</tbody>
</table>

Various lists as specified under 1D data files.
3D data files

<table>
<thead>
<tr>
<th>Filename</th>
<th>Created or modified by</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;du&gt;/data/&lt;user&gt;/nmr/&lt;name&gt;/&lt;expno&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ser</td>
<td>zg</td>
<td>tf3</td>
<td>raw data - series of FIDs (b)</td>
</tr>
<tr>
<td>acqu</td>
<td>rpar, eda</td>
<td>zg</td>
<td>F3 acquisition parameters (j)</td>
</tr>
<tr>
<td>acqu2</td>
<td>rpar, eda</td>
<td>zg</td>
<td>F2 acquisition parameters (j)</td>
</tr>
<tr>
<td>acqu3</td>
<td>rpar, eda</td>
<td>zg</td>
<td>F1 acquisition parameters (j)</td>
</tr>
<tr>
<td>acqus</td>
<td>rpar, zg</td>
<td>dpa</td>
<td>F3 acquisition status parameters (j)</td>
</tr>
<tr>
<td>acqu2s</td>
<td>rpar, zg</td>
<td>dpa</td>
<td>F2 acquisition status parameters (j)</td>
</tr>
<tr>
<td>acqu3s</td>
<td>rpar, zg</td>
<td>dpa</td>
<td>F1 acquisition status parameters (j)</td>
</tr>
</tbody>
</table>

Various lists as specified under 1D data files.

User defined settings

<table>
<thead>
<tr>
<th>File</th>
<th>Created or modified by</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;userhome&gt;/xwinmr/&lt;hostname&gt;/</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>resources</td>
<td>setres</td>
<td>zg, edcpu1, edau, plot</td>
<td>XWIN-NMR resource settings (j)</td>
</tr>
<tr>
<td>default.por</td>
<td>search</td>
<td>search</td>
<td>default portfolio (a)</td>
</tr>
<tr>
<td>autoshim</td>
<td>gradshim</td>
<td></td>
<td>gradient shimming directory (d)</td>
</tr>
<tr>
<td>&lt;xwhome&gt;/prog/curdir/&lt;user&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>history</td>
<td>hist on</td>
<td></td>
<td>history of commands and error messages (a)</td>
</tr>
<tr>
<td>curdat</td>
<td>edc, new</td>
<td>edc, new</td>
<td>currently displayed dataset (j)</td>
</tr>
<tr>
<td>individual_</td>
<td>Help -&gt;</td>
<td>individual</td>
<td>individual user notebook (a)</td>
</tr>
<tr>
<td>user_note</td>
<td>Help -&gt;</td>
<td>individual</td>
<td></td>
</tr>
<tr>
<td>book.txt</td>
<td>Help -&gt;</td>
<td>individual</td>
<td></td>
</tr>
<tr>
<td></td>
<td>user...</td>
<td>user...</td>
<td></td>
</tr>
</tbody>
</table>
## AU Programs

<table>
<thead>
<tr>
<th>Filename</th>
<th>Created or modified by</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;xwhome&gt;/prog/au/src.exam</code></td>
<td></td>
<td><code>expinstall</code></td>
<td>Bruker AU program sources (a)</td>
</tr>
<tr>
<td><code>&lt;xwhome&gt;/prog/au/bin</code></td>
<td></td>
<td><code>expinstall</code></td>
<td>Bruker AU program sources (a)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>compileall</code></td>
<td>User defined AU executables (e)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>cpluser.edau</code></td>
<td>User defined AU executables (e)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>xau</code></td>
<td>User defined AU executables (e)</td>
</tr>
<tr>
<td><code>&lt;xwhome&gt;/prog/include/</code></td>
<td></td>
<td><code>edau</code></td>
<td>AU macro definitions (a)</td>
</tr>
<tr>
<td><code>aucmd.h</code></td>
<td></td>
<td><code>edau</code></td>
<td>AU macro and inclusion files (a)</td>
</tr>
<tr>
<td><code>&lt;xwhome&gt;/prog/include/inc</code></td>
<td></td>
<td><code>edau</code></td>
<td>AU macro and inclusion files (a)</td>
</tr>
<tr>
<td><code>&lt;xwhome&gt;/exp/stan/nmr/au</code></td>
<td></td>
<td><code>expinstall</code></td>
<td>Bruker AU sources (d)</td>
</tr>
<tr>
<td><code>scr</code></td>
<td><code>expinstall</code></td>
<td><code>cplbruk.xau</code></td>
<td>User defined AU sources (d)</td>
</tr>
<tr>
<td><code>vorspann</code></td>
<td><code>edau</code></td>
<td><code>edau</code></td>
<td>C-languages definition file (a)</td>
</tr>
<tr>
<td><code>makeau</code></td>
<td><code>edau</code></td>
<td><code>edau</code></td>
<td>AU compilation script (a)</td>
</tr>
<tr>
<td><code>&lt;xwhome&gt;/exp/stan/nmr/au/src</code></td>
<td></td>
<td><code>expinstall</code></td>
<td>Bruker AU sources (a)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>cplbruk.edau</code></td>
<td>User defined AU sources (a)</td>
</tr>
<tr>
<td></td>
<td><code>edau</code></td>
<td><code>cplbruk.edau</code></td>
<td>User defined AU sources (a)</td>
</tr>
</tbody>
</table>

a. Note that AU programs can be started by entering `xau <name>` or simply `<name>`
## Documentation files

<table>
<thead>
<tr>
<th>Filename</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;xwhome&gt;/prog/docu/english</code></td>
<td></td>
<td>manuals for acquisition, processing, installation, release letter etc. (d)</td>
</tr>
<tr>
<td><code>xwinproc/pdf</code></td>
<td>Help</td>
<td>Avance spectrometer users guide (d)</td>
</tr>
<tr>
<td><code>avance/pdf</code></td>
<td>Help</td>
<td>XWIN-PLOT manuals (d)</td>
</tr>
<tr>
<td><code>xwpman/pdf</code></td>
<td>Help</td>
<td>ICON-NMR manuals (d)</td>
</tr>
</tbody>
</table>

## NMR Suite executables

<table>
<thead>
<tr>
<th>Filename</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;xwhome&gt;/prog/cpr</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>xcpu</code></td>
<td>XWIN-NMR</td>
<td>XWIN-NMR graphics program (e)</td>
</tr>
<tr>
<td><code>cpr</code></td>
<td>XWIN-NMR</td>
<td>XWIN-NMR command interpreter (e)</td>
</tr>
<tr>
<td><code>&lt;xwhome&gt;/prog/mod</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>confed</code></td>
<td>cf</td>
<td>configuration module (e)</td>
</tr>
<tr>
<td><code>edparproc</code></td>
<td>eda, edp</td>
<td>parameter editor module (e)</td>
</tr>
<tr>
<td><code>expinstall</code></td>
<td>expinstall</td>
<td>AU and parameter installation module (e)</td>
</tr>
<tr>
<td><code>go</code></td>
<td>zg, go, wobb</td>
<td>acquisition module (e)</td>
</tr>
<tr>
<td><code>proc1d</code></td>
<td>em, ft, pk</td>
<td>1D processing module (e)</td>
</tr>
<tr>
<td><code>shimcntl</code></td>
<td>lock, rsh</td>
<td>lock and shim module (e)</td>
</tr>
<tr>
<td>..</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

see also Tcl/Tk scripts and AU programs
## Tcl/Tk scripts

<table>
<thead>
<tr>
<th>Filename</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;xwhome&gt;/prog/tcl/xwish3_scripts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>butselnmr</td>
<td>butselnmr</td>
<td>Easy interface for selective experiments (t)</td>
</tr>
<tr>
<td>buttonnmr</td>
<td>buttonnmr</td>
<td>Easy interface for standard experiments (t)</td>
</tr>
<tr>
<td>config</td>
<td>config</td>
<td>Spectrometer configuration (t)</td>
</tr>
<tr>
<td>edhead</td>
<td>edhead</td>
<td>Probehead selection (t)</td>
</tr>
<tr>
<td>edprosol</td>
<td>edprosol</td>
<td>Probehead/Solvent dependent parameter setup (t)</td>
</tr>
<tr>
<td>glp</td>
<td>glp</td>
<td>Program Good Laboratory Practice (t)</td>
</tr>
<tr>
<td>gradshim</td>
<td>gradshim</td>
<td>Gradient shimming (t)</td>
</tr>
<tr>
<td>iconnmr</td>
<td>gradshim</td>
<td>ICON-NMR interface (t)</td>
</tr>
<tr>
<td>mascontrol</td>
<td>mascontrol</td>
<td>MAS control and monitor (t)</td>
</tr>
<tr>
<td>masrmon</td>
<td>masrmon</td>
<td>MAS monitor (t)</td>
</tr>
<tr>
<td>popt</td>
<td>popt</td>
<td>Multiple parameter optimization (t)</td>
</tr>
<tr>
<td>smail</td>
<td>smail</td>
<td>Data transfer by Email (t)</td>
</tr>
<tr>
<td>temon</td>
<td>temon</td>
<td>Temperature monitor (t)</td>
</tr>
</tbody>
</table>
## Spectrometer configuration files

<table>
<thead>
<tr>
<th>Filename</th>
<th>Created or modified by</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;xwhome&gt;/conf/instr/</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>curinst</td>
<td><code>cf</code></td>
<td><code>cf</code></td>
<td>spectrometer name (a)</td>
</tr>
<tr>
<td>patchlev</td>
<td></td>
<td></td>
<td>XWIN-NMR patchlevel (a)</td>
</tr>
<tr>
<td>hardware.exam</td>
<td><code>cf</code></td>
<td><code>makelist</code></td>
<td>example hardware list containing all possible hardware devices (a)</td>
</tr>
<tr>
<td>nmr_user_notebook.txt</td>
<td></td>
<td><code>Help</code></td>
<td>notebook for all NMR users (a)</td>
</tr>
<tr>
<td>system_notebook.txt</td>
<td></td>
<td><code>Help</code></td>
<td>notebook for system administrator (a)</td>
</tr>
<tr>
<td>probehead</td>
<td><code>edhead</code></td>
<td></td>
<td>current probe definition (a)</td>
</tr>
<tr>
<td>probeheads</td>
<td><code>edhead</code></td>
<td><code>edhead</code></td>
<td>probe parameter files (d)</td>
</tr>
<tr>
<td><code>&lt;xwhome&gt;/conf/instr/&lt;instr&gt;</code></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2Hlock</td>
<td><code>edlock</code></td>
<td><code>lock, lopo</code></td>
<td>2H lock table (a)</td>
</tr>
<tr>
<td>bacs_params</td>
<td><code>cfbacs, cf</code></td>
<td></td>
<td>sample changer information (a)</td>
</tr>
<tr>
<td>uxnmr.info</td>
<td><code>cf</code></td>
<td></td>
<td>spectrometer configuration overview (a)</td>
</tr>
<tr>
<td>cortab</td>
<td><code>cortab</code></td>
<td><code>zg</code></td>
<td>amplifier power and phase correction tables (d)</td>
</tr>
<tr>
<td>uxnmr.par</td>
<td><code>cf</code></td>
<td></td>
<td>spectrometer configuration (j)</td>
</tr>
<tr>
<td>nuclei</td>
<td><code>cf, ednuc</code></td>
<td><code>edasp</code></td>
<td>nuclei table (a)</td>
</tr>
<tr>
<td>scon</td>
<td><code>edscon</code></td>
<td><code>zg</code></td>
<td>spectrometer fine tuning settings (j)</td>
</tr>
<tr>
<td>specpar</td>
<td><code>eds, edasp</code></td>
<td><code>zg</code></td>
<td>routing information</td>
</tr>
<tr>
<td>hardware_list</td>
<td><code>cf</code></td>
<td></td>
<td>list of hardware components that are not automatically detected (a)</td>
</tr>
<tr>
<td>mas_params</td>
<td><code>cfmas</code></td>
<td><code>masi, mase</code></td>
<td>information about the MAS unit (a)</td>
</tr>
</tbody>
</table>
### Spectrometer configuration files

<table>
<thead>
<tr>
<th>Filename</th>
<th>Created or modified by</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>prosol</td>
<td>edprosol</td>
<td>getprosol</td>
<td>probe/solvent dependent parameter files (d)</td>
</tr>
<tr>
<td>autoshim</td>
<td>gradshim</td>
<td>gradshim</td>
<td>gradient shimming files (d)</td>
</tr>
<tr>
<td>bbis_bla1</td>
<td>cf</td>
<td>ii, zg</td>
<td>linear amplifier information (a)</td>
</tr>
<tr>
<td>bbis_bla2</td>
<td>cf</td>
<td>ii, zg</td>
<td>linear amplifier information (a)</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>bbis_fcu1</td>
<td>cf</td>
<td>ii, zg</td>
<td>fcu1 information (a)</td>
</tr>
<tr>
<td>bbis_fcu2</td>
<td>cf</td>
<td>ii, zg</td>
<td>fcu2 information (a)</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>bbis_recu</td>
<td>cf</td>
<td>ii, zg</td>
<td>rcu information (a)</td>
</tr>
<tr>
<td>bbis_tcu</td>
<td>cf</td>
<td>ii, zg</td>
<td>tcu information (a)</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>bsmsdisp.calibr</td>
<td>bsmsdisp</td>
<td></td>
<td>BSMS display calibration (a)</td>
</tr>
<tr>
<td>&lt;xwhome&gt;/conf/instr/&lt;curinst&gt;/rs232_device</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>acb</td>
<td>cf</td>
<td>acbdisp</td>
<td>ACB rs232 channel + settings (a)</td>
</tr>
<tr>
<td>bacs</td>
<td>cf, bacs, cf</td>
<td></td>
<td>sample changer rs232 channel (a)</td>
</tr>
<tr>
<td>bsms</td>
<td>cf</td>
<td>lock, rsh</td>
<td>BSMS rs232 channel + settings (a)</td>
</tr>
<tr>
<td>lock</td>
<td>cf</td>
<td>lockdisp</td>
<td>lock display rs232 channel (a)</td>
</tr>
<tr>
<td>preamp1</td>
<td>cf</td>
<td>zg, ii, rga</td>
<td>first HPPR rs232 channel (a)</td>
</tr>
<tr>
<td>preamp2</td>
<td>cf</td>
<td>zg, ii, rga</td>
<td>second HPPR rs232 channel (a)</td>
</tr>
<tr>
<td>..</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>preemp</td>
<td>cf</td>
<td>zg</td>
<td>preemphasis channel + settings (a)</td>
</tr>
<tr>
<td>rx22</td>
<td>cf</td>
<td>zg</td>
<td>RX22 receiver channel + settings (a)</td>
</tr>
<tr>
<td>temp</td>
<td>cf, cfte, cf</td>
<td>edte, teset</td>
<td>temperature unit rs232 channel (a)</td>
</tr>
<tr>
<td>&lt;xwhome&gt;/conf/instr/servtool</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>achttool</td>
<td>NMR-CHECK</td>
<td></td>
<td>ACB service tool (d)</td>
</tr>
</tbody>
</table>
Spectrometer configuration files

<table>
<thead>
<tr>
<th>Filename</th>
<th>Created or modified by</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>bsmstool</td>
<td>NMR-CHECK</td>
<td>NMR-CHECK</td>
<td>BSMS service tool (d)</td>
</tr>
<tr>
<td>gradtool</td>
<td></td>
<td></td>
<td>Gradient service tool (d)</td>
</tr>
<tr>
<td>hpcutool</td>
<td></td>
<td></td>
<td>HPCU service tool (d)</td>
</tr>
<tr>
<td>hpprool</td>
<td>NMR-CHECK</td>
<td>NMR-CHECK</td>
<td>HPPR preamplifier service tool (d)</td>
</tr>
<tr>
<td>rx22tool</td>
<td>NMR-CHECK</td>
<td></td>
<td>Rx22 receiver service tool (d)</td>
</tr>
<tr>
<td>Unitool</td>
<td></td>
<td></td>
<td>Generic service tool for AQS and HPPR II (d)</td>
</tr>
</tbody>
</table>

a. Service tools can be executed from the Windows Command prompt (or UNIX shell) or from NMR-CHECK.
### Format files

<table>
<thead>
<tr>
<th>Filename</th>
<th>Created or modified by</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;xwhome&gt;/exp/stan/nmr/form/</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>acb.e</td>
<td>edacb</td>
<td></td>
<td>acquisition control board parameters (a)</td>
</tr>
<tr>
<td>acqu.e</td>
<td>cf</td>
<td>eda</td>
<td>acquisition parameters (a)</td>
</tr>
<tr>
<td>acqu.e.D</td>
<td>cf</td>
<td></td>
<td>acquisition parameters for Avance (a)</td>
</tr>
<tr>
<td>acqu.e.X</td>
<td>cf</td>
<td></td>
<td>acquisition parameters for AMX with SCM (a)</td>
</tr>
<tr>
<td>acqu.e.R</td>
<td>cf</td>
<td></td>
<td>acquisition parameters for ARX with SCM (a)</td>
</tr>
<tr>
<td>acqu.e.X.B</td>
<td>cf</td>
<td></td>
<td>acquisition parameters for AMX with BSMS (a)</td>
</tr>
<tr>
<td>acqu.e.R.B</td>
<td>cf</td>
<td></td>
<td>acquisition parameters for ARX with BSMS (a)</td>
</tr>
<tr>
<td>curd.e</td>
<td>edc</td>
<td></td>
<td>current data path parameters (a)</td>
</tr>
<tr>
<td>curd2.e</td>
<td>edc2</td>
<td></td>
<td>second data path parameters (a)</td>
</tr>
<tr>
<td>dosy.e</td>
<td>eddosy</td>
<td></td>
<td>dosy parameter (a)</td>
</tr>
<tr>
<td>edp3.e</td>
<td>edp3</td>
<td></td>
<td>F3 processing parameters in 3D (a)</td>
</tr>
<tr>
<td>edp2.e</td>
<td>edp2</td>
<td></td>
<td>F2 processing parameters in 2D/3D (a)</td>
</tr>
<tr>
<td>edp1.e</td>
<td>edp1</td>
<td></td>
<td>F1 processing parameters in 2D/3D (a)</td>
</tr>
<tr>
<td>hpcu.e</td>
<td>cf</td>
<td>edhpcu</td>
<td>acquisition + HPCU parameters (a)</td>
</tr>
<tr>
<td>hpcu.e.D</td>
<td>cf</td>
<td></td>
<td>acqu. + HPCU parameters for Avance (a)</td>
</tr>
<tr>
<td>hpcu.e.X</td>
<td>cf</td>
<td></td>
<td>acqu. + HPCU parameters for AMX - SCM (a)</td>
</tr>
<tr>
<td>hpcu.e.X.B</td>
<td>cf</td>
<td></td>
<td>acqu. + HPCU parameters for AMX - BSMS (a)</td>
</tr>
<tr>
<td>outd.e</td>
<td>edo</td>
<td></td>
<td>output parameters (a)</td>
</tr>
<tr>
<td>proc.e</td>
<td>edp</td>
<td></td>
<td>processing parameters in 1D/2D/3D (a)</td>
</tr>
<tr>
<td>preemp.e</td>
<td>edpre</td>
<td></td>
<td>preemphasis parameters (a)</td>
</tr>
</tbody>
</table>
### Format files

<table>
<thead>
<tr>
<th>Filename</th>
<th>Created or modified by</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>spec.e</td>
<td></td>
<td>edsp, edasp</td>
<td>routing format file on AMX/ARX</td>
</tr>
<tr>
<td>scon.e</td>
<td>cf</td>
<td>edscen</td>
<td>spectrometer constants for your spectrometer (a)</td>
</tr>
<tr>
<td>scon.e.A</td>
<td>cf</td>
<td></td>
<td>spectrometer constants for Avance-AQS (a)</td>
</tr>
<tr>
<td>scon.e.D</td>
<td>cf</td>
<td></td>
<td>spectrometer constants for Avance-AQS (a)</td>
</tr>
<tr>
<td>used_from.e</td>
<td>used_from</td>
<td></td>
<td>source 2D data path parameters (a)</td>
</tr>
<tr>
<td>maxent1d.e</td>
<td>maxed</td>
<td></td>
<td>1D MAXENT parameters (a)</td>
</tr>
<tr>
<td>maxent2d.e</td>
<td>maxed</td>
<td></td>
<td>2D MAXENT parameters (a)</td>
</tr>
<tr>
<td>maxent3d.e</td>
<td>maxed</td>
<td></td>
<td>3D MAXENT parameters (a)</td>
</tr>
<tr>
<td>t1par</td>
<td>t1/t2</td>
<td></td>
<td>T1/T2 relaxation format files (d)</td>
</tr>
<tr>
<td>plot</td>
<td>edx</td>
<td></td>
<td>1D plot parameter format files (d)</td>
</tr>
<tr>
<td>plot2</td>
<td>edx</td>
<td></td>
<td>2D plot parameter format files (d)</td>
</tr>
<tr>
<td>plotw</td>
<td>edgw</td>
<td></td>
<td>stack plot parameter format files (d)</td>
</tr>
<tr>
<td>plotx</td>
<td>edgx</td>
<td></td>
<td>extended plot parameter format files (d)</td>
</tr>
<tr>
<td>acqu.l</td>
<td>dpa, lpa, plot</td>
<td></td>
<td>acqu. status format files for the first dimension of 1D, 2D or 3D data (d)</td>
</tr>
<tr>
<td>acqu2.l</td>
<td>dpa, lpa, plot</td>
<td></td>
<td>acqu. status format files for the second dimension of 2D or 3D data (d)</td>
</tr>
<tr>
<td>acqu3.l</td>
<td>dpa, lpa, plot</td>
<td></td>
<td>acqu. status format files for the third dimension of 3D data (d)</td>
</tr>
<tr>
<td>curd.l</td>
<td>dpc, lpc, plot</td>
<td></td>
<td>current dataset status format files (d)</td>
</tr>
<tr>
<td>outd.l</td>
<td>dpo, lpo, plot</td>
<td></td>
<td>output status parameters (d)</td>
</tr>
<tr>
<td>plot.l</td>
<td>dpo, lpo, plot</td>
<td></td>
<td>1D plot status format files (d)</td>
</tr>
</tbody>
</table>
## Format files

<table>
<thead>
<tr>
<th>Filename</th>
<th>Created or modified by</th>
<th>Interpreted by</th>
<th>Description (file type)</th>
</tr>
</thead>
<tbody>
<tr>
<td>plot2.l</td>
<td>dpo, lpo, plot</td>
<td></td>
<td>2D plot status format files (d)</td>
</tr>
<tr>
<td>proc1.l</td>
<td>dpp, lpp, plot</td>
<td></td>
<td>processing status format files for the first dimension of 1D, 2D or 3D data (d)</td>
</tr>
<tr>
<td>proc2.l</td>
<td>dpp, lpp, plot</td>
<td></td>
<td>processing status format files for the second dimension of 2D or 3D data (d)</td>
</tr>
<tr>
<td>proc3.l</td>
<td>dpp, lpp, plot</td>
<td></td>
<td>processing status format files for the third dimension 3D data (d)</td>
</tr>
<tr>
<td>&lt;xwhome&gt;/exp/stan/nmr/form/acqu.l</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>formased</td>
<td>ased</td>
<td></td>
<td>acquisition parameters used in pulse program (a)</td>
</tr>
<tr>
<td>normdp</td>
<td>dpa</td>
<td></td>
<td>acquisition status parameters to be viewed (a)</td>
</tr>
<tr>
<td>normlp</td>
<td>lpa</td>
<td></td>
<td>acquisition status parameters to be printed (a)</td>
</tr>
<tr>
<td>normpl</td>
<td>plot, view</td>
<td></td>
<td>acquisition status parameters to be plotted (a)</td>
</tr>
<tr>
<td>normdp.D</td>
<td>cf</td>
<td></td>
<td>acquisition status parameters for Avance (a)</td>
</tr>
<tr>
<td>normdp.R</td>
<td>cf</td>
<td></td>
<td>acqu. status parameters for ARX with SCM (a)</td>
</tr>
<tr>
<td>normdp.R.B</td>
<td>cf</td>
<td></td>
<td>acqu. status parameters for ARX with BSMS (a)</td>
</tr>
<tr>
<td>normdp.X</td>
<td>cf</td>
<td></td>
<td>acqu. status parameters for AMX with SCM (a)</td>
</tr>
<tr>
<td>normdp.X.B</td>
<td>cf</td>
<td></td>
<td>acqu. status parameters for AMX with BSMS (a)</td>
</tr>
<tr>
<td>hpcudp</td>
<td>dpa</td>
<td></td>
<td>as normdp + HPCU parameters (a)</td>
</tr>
<tr>
<td>hpculp</td>
<td>lpa</td>
<td></td>
<td>as normlp + HPCU parameters (a)</td>
</tr>
<tr>
<td>hpcupl</td>
<td>plot, view</td>
<td></td>
<td>as normlp + HPCU parameters (a)</td>
</tr>
</tbody>
</table>
Numerics
2D lookup tables 263
4-phase modulator 89, 241

A
abs command 36, 53, 195
ACB parameters 272
ACB service tool 285
accumulation of the FID 190
acqu command 219
acquisition
dimension 44, 46
interface 191, 194
menu 190, 194, 200
mode 12, 44, 52
order 53
parameters 7, 8, 9, 10, 11, 152, 161, 162, 163,
165, 190, 200, 202, 206, 278, 279,
280, 287
status parameters 7, 9, 52, 150, 278, 279, 280,
289
time 11, 45, 148
air flow 140, 245, 247, 250, 251
amplifier
correction table 72
linearization 72
routing 32, 34, 154, 156
amplitude list 179, 181
Amplitude Setting Unit 72
AMX spectrometer 17, 25, 97, 99, 109, 179
analog filter 17, 22
apk command 53, 195, 221
ARX spectrometer 97, 100, 109
as command 148
ased command 148, 152, 218
ASU
blanking 88
correction 72
linearization 75
ATM probehead 132, 134, 145, 218
atma command 51, 132, 134, 218
atmm command 134
attenuator 72
AU program
binaries 69, 80, 96, 171, 281
Bruker defined 69, 80, 96, 170
compilation 69, 80, 170, 215
creation 170
deletion 258
edit 170
execution 215
files 281
for acquisition 12, 190, 216
for processing 216
installation 96
kill 216
macro 4, 5
rename 262
sources 69, 80, 171, 281
user defined 80, 96, 170
au_zg AU program 13, 190
auto lock-in 108, 109, 191, 194
autolock key 54, 106, 110, 114
automatic
receiver gain optimization 211
shimming 119, 123, 126, 191, 194
tuning and matching 132
automation with Icon-nmr 5, 43, 66, 86, 104, 138,
204, 216, 275
autoshim 118
Avance spectrometer 5, 31, 97, 99, 109, 179, 282
B
basic frequency 13, 32, 34, 57, 59, 82, 102, 144, 154
BPSU unit 67, 70
Bruker
AU programs 69, 80, 96, 170, 198, 262, 281
CPD programs 15, 174
gradient files 24
gradient programs 177
parameter sets 14, 34, 97, 102, 156, 162, 166,
216, 258
pulse programs 15, 23, 30, 36, 40, 175, 186, 213,
263
shape files 42
solvent list 92
spectrometers 17, 225
BSMS
display 102, 120, 141, 285
keyboard 8, 54, 58, 102, 104, 106, 109, 110, 112,
114, 117, 120, 126, 140, 141, 144
lock unit 109
rs232 channel 65
service tool 286
unit 54, 101, 103, 109, 110, 124, 141
bsmsdisp command 102, 120, 141
butselau AU program 193
butselnmr 191
buttonau AU program 196
buttonnmm command 39, 194, 221

C

calibration 59, 103
carrier frequency 34, 35, 41, 98, 99
cf command 13, 32, 62, 96
cfbacs command 64, 66
cfbpsu command 67
cfmas command 238, 247, 251
cfte command 67, 68
chemical shift 35, 59, 103, 109
communication problems 62
compilation of AU programs 80, 96, 170, 215
compileall command 69, 96, 215
composite experiments 275
composite pulse decoupling 14, 174
config command 32, 62, 70
configuration
  commands 61
  files 284
  of the BPSU unit 67
  of the MAS unit 238
  of the sample changer 66
  of the spectrometer 62
  of the temperature unit 68
  of XWIN-NMR 220
  suite 62, 70
contour levels 161, 162, 163, 164, 166, 167
conventions in this manual 3
Cortab
  experiment 72, 76
  linearization 72
  program 72
  verification 72
  cortab command 72
counter list 179

CPD
  command 37
  power level 159
  programs 14, 38, 96, 99, 174, 185
  pulse length 37, 149, 159
cplbruk command 80, 96, 215, 258
cpluser command 80, 215
crplock command 274
crpoobs command 274
crpooff command 274
crpon command 274
cryo preamplifier 274

D
data path parameters 287
dataset list 19, 179
decimation factor 16, 21, 53
define statement 50, 97
delau command 258
delay list 179
delete
  AU programs 258
  gradient programs 258
  macros 258
  parameter sets 258
  pulse programs 258
  shim files 258
  various lists 260
delgp command 258
dellist command 260
delmac command 258
delpar command 258
delpul command 258
delsh command 258
demand
  spin rate 141, 238, 244, 247, 250
  temperature 46, 228, 232, 234, 243
deuterium 102
digital
  digitizer resolution 15, 18
  filtering 5, 15, 16, 17, 19, 21, 53
  lock 101
  quadrature detection 12, 18
digitizer
    mode 17
resolution 15, 18
start 16

type 11, 17, 22, 99
dimension
  2D direct 4, 9, 32
  2D indirect 4, 9, 31, 44, 46
  3D direct 9
  3D indirect 5, 9
dimensionality of data 36, 162
DNA/RNA experiments 158
dpa command 7, 8, 52, 150
DQD
device 12
mode 18
DSP firmware 54
dummy scans 18, 148, 218, 219, 267
duty cycle 272
dwell time 17, 20, 43, 148

E
ed4ph command 241
data command 7, 8, 10, 11, 159, 162, 166
dabc command 272
dsp command 13, 21, 25, 31, 32, 34, 38, 57, 218
dau command 5, 38, 96, 170, 215
dcc command 166, 191, 194, 218
dccp command 172
dccpd command 15, 174, 185
dcdpul command 39, 175, 177
dcg command 162, 166
dcg command 177, 185
dcgg command 162
dcgh command 40, 56, 84, 102, 136, 218
dccp command 240
dccv command 162
dclist command 19, 23, 47, 48, 49, 50, 178
dcllock command 8, 29, 86, 102, 106, 108, 114
ddmac command 5, 185
dnc command 13, 63, 82
do command 103, 162, 166
dpl command 152, 162, 166
dprosol command 8, 39, 43, 84, 123, 159, 218
dpul command 36, 185, 186
dsc command 16, 88, 222
dsolv command 92
dsp command 94, 154
dte command 226, 227, 231
dtune command 119, 123
e command 195
efp command 192
ej command 140
eject
  air time 238, 245
  mechanism 238
  the sample 245, 247, 251
  the spinner 250
em command 53, 192, 221
euroktherm temperature unit 225
experiment time 31, 195, 197
expinstall command 17, 40, 69, 80, 95, 96, 97, 162, 170, 186
expt command 31, 190, 197

F
FID
  area 125
  display 12, 34, 41, 200, 201
  envelope 123
  number 36
  resolution 22, 46
  signal 40
field value 102, 103, 112
follow command 216
font conventions 3
format files 287
frequency
  list 23, 179, 180, 223, 278
  unit 266
ft command 36, 53, 192, 221

G
getpcu command 255
getcosy command 275
getlmd command 275
getlrv command 275
getjres command 275
getprosol command 8, 39, 43, 86, 158, 191, 195, 218
getxhco command 275
go command 11, 198, 220
gpro command 158
gradient
experiment 196
file 24, 25, 96, 97
parameter table 23
parameters 24, 25
program 25, 99, 172, 177, 185, 258, 263
pulse length 159
recovery delay 159
service tool 286
shaped 24
shimming 25, 218, 280, 285
static 24
strength 24
gradshim command 218
group delay 5, 53, 54
gs command 11, 12, 34, 41, 190, 200, 212

H
halt command 31, 133, 198, 202, 210, 212, 213, 220
hard pulse 85, 86, 159
hardware list 64, 66, 238, 284
hardware resolution 15, 18
high power
accessory 38
amplifier 25, 33, 155
cabinet 255
output 33, 155
preamplifier 25
routing 58, 99, 157
tube transmitter 240, 255
holder position 56
homodecoupling
duty cycle 25
experiment 17
power level 159
homogeneity of the magnetic field 112, 123
hostname 62
hosts file 62, 63
HPCU
parameters 240
service tool 286
unit 255
HPPE preamplifier 25, 145, 274
service tool 286

I
iconnmr command 204
ii command 11, 205
ij command 140
impedance
of a probehead 143, 144, 145
input parameters 8
insert
airtime 238, 244, 245, 247, 250
the sample 140, 244, 245
the spinner 245, 247, 250
integral ranges 185, 275
interface
of the spectrometer 205
irradiation frequency 23, 32, 34, 35, 41, 57, 59, 98, 99, 109, 149, 154, 180, 200
irradiation frequency offset 35, 57, 59, 103, 180, 200

K
kill command 133, 202, 212, 216, 220

L
LC-NMR 67, 70, 158
lfilter command 104, 106
lgain command 55, 104, 106
liprosol command 86
lock
channel 274
display 104, 112
display file 113
frequency 102, 112
gain 108
irradiation frequency 59
level 124, 125
nucleus 28, 102, 112
parameters 7, 29, 58, 70, 102, 108, 114
phase 59, 103, 104, 108, 112, 114, 126
power 55, 59, 102, 103, 104, 108, 114
regulator cut-off frequency 55, 59, 102
regulator filter 106
regulator gain 54, 59, 102, 106
regulator time 55, 59, 102, 106
shift 55
signal 103, 104, 108, 110, 112, 114
status 56
sweep 104
  table 102
lock command 8, 29, 43, 58, 103, 106, 108, 114, 191, 194, 218
lockdisp command 104, 110, 112, 218
lock-in procedure 58, 108, 109, 114
logical frequency channel 21, 32, 58, 85, 99, 154, 157
loop counter 27
loop filter 55, 59, 102, 104, 106, 109, 114
loop gain 54, 59, 104, 106, 109, 114
loop time 55, 59, 102, 104, 106, 109, 114
loopadj AU program 104, 106
lopo command 8, 29, 43, 58, 103, 110, 114
lopoi command 29, 114
ltime command 104, 106

M
macros
  in AU programs 5, 281
  in XWIN-NMR 5, 185, 258, 260, 263
magic angle 237, 247, 250
magnet
  air flow 140
  strength 62
  type 66, 243
MAS
  commands 251
  control 29, 243, 247, 250
  log file 248
  manual 251
  monitor 55, 253
  parameters 238, 243
  pneumatic unit 70, 238, 243, 244, 245, 247, 250, 284
  spin rate 29, 55, 247, 251
  spin rate list 179, 185
mas command 29, 43, 247, 250
mascontrol command 250
mase command 250
masg command 250
mash command 250
masi command 250
masr command 29, 55, 250
masrmon command 55, 247, 253
matching knob 144, 145
matching the probehead 51, 132, 133, 134, 143, 190, 191, 194
mc command 46
micro imaging 100
mixed solvents 109
mixing time 85
multiefp AU program 192
multimas AU program 184
multizg AU program 221
N
new dataset 166, 191, 194, 218
NMR Superuser 13, 62, 96, 151, 153, 170
nuclei
  list 34, 82
  selection 154
  table 13, 63, 65, 82, 284
O
O1 spikes 12
observe nucleus 59, 103
optimization
  criterion 206
  of acquisition parameters 200, 206
  of the lock parameters 108
  of the receiver gain 211
  protocol of popt 206
output device parameters 161, 162, 163, 166
output parameters 7, 8
overflow 18, 35, 211
oversampling 16, 17, 18, 20, 22, 53
  dwell time 17, 20
P
parameter
  editor 8, 10
  optimization 200, 206
  sets 96, 97, 161, 165, 166, 216, 258, 262
  types 161, 162, 165, 166, 258
  value types 10
paropt AU program 208
paroptlin AU program 208
paroptlog AU program 208
pararray AU program 208
phase
alignment 42, 43, 85
correction factor 37
correction of a pulse 37
correction of the receiver 37
correction of the spectrum 16, 91
cycle 19, 37, 198, 202, 220
list 200
of a pulse 266
of the lock signal 59, 103, 104, 109, 112, 114, 126
of the receiver 16, 90, 266
program 36
values of a shaped pulse 183
phtrant AU program 37
pk command 192
plot
parameters 7, 161, 162, 163, 166
title 161, 162, 163, 166
plot command 192, 195
popt command 206
portfolio 280
power
level 8, 38, 42, 43, 85, 86, 149, 159, 200, 266, 267
list 181
mode 38
preamplifier
blanking 88
gain 39
modules 25, 33, 38, 58, 95, 99, 155, 156, 157
of a cryoprobe 274
of an MSL 39
routing 32, 33, 58, 95, 98, 154, 155, 156, 157
switching 16, 90
of a 180 degree pulse 159
of a 90 degree pulse 85, 143, 159
tuning and matching 144
pre-scan
delay 15, 90, 148
subdelays 16, 90
probehead 40, 102
acquisition parameter 56
ATM 132, 134
broadband 134, 145
commands 131
cryo 274
current 102, 136, 137, 218
dependent lock parameters 86
dependent parameters 8, 43, 59, 84, 158, 195, 218
dependent tune file 86
impedance 143
name 136
parameter editor 136
parameters 136, 137
resonance circuit 143
resonance frequency 134, 143, 145
table 70, 136
tune file 191
tuning and matching 51, 132, 134, 143, 191, 194, 218
type 243, 247, 250
processing
commands 3, 7, 36, 46, 52, 53, 54, 221
menu 190
parameters 7, 161, 162, 163, 166
prosol command 86
prosol parameters 7, 8, 39, 84, 158
protein experiments 158
pulsdisp command 11, 266
pulse channels 266
pulse length
CPD 37, 149, 159
decrement 26
display 269
increment 26
of a 180 degree pulse 159
of a 90 degree pulse 85, 143, 159
tuning and matching 144
of a gradient pulse 159
of a hard pulse 85
of a soft pulse 85
parameter 35
reset 26
pulse list 179
pulse program
Bruker defined 175, 186
compilation 218
constants 13
creation 175, 186
current 175
define statements 97
deletion 258
display 266
edit 175, 186
for AMX 99
for wobble 133
installation 96
label 27, 30, 48, 181
rename 263
timing 266
user defined 175, 186
pulsesort AU program 158

Q
QNP probe 40
qnpset AU program 40
quad images 12
quadrature detection 12

R
rackpow command 255
raw data 5, 7, 9, 30, 36, 45, 150, 162, 190, 195, 198, 202, 220, 222, 278, 279
receiver
channel 40
ccontrol 266
gain 40, 148, 200, 201
gain optimization 211
gate 16, 90
output 41
phase 16, 37, 90, 266
rs232 channel 65, 285
service tool 286
status 266
recycle delay 19, 210, 219
reference
50 ohm resistor 143
frequency 40, 99
number 92, 136
peak 97
phase 200
shift 59, 103
signal 59, 103
substance 13, 109
referencing the spectrum 102
relations
file 86, 158, 278
prosol-acquisition 86, 158, 278
relaxation delay 149
rename
2D lookup tables 263
AU programs 262
gradient programs 263
lists 264
macros 263
parameter sets 262
pulse programs 263
renau command 262
rengp command 263
renlist command 264
renlut command 263
renmac command 263
renpar command 262
renpul command 263
resonance circuit 143, 145
resonance frequency
of a probehead 134, 143, 144, 145
resume command 11, 198, 210
rga command 11, 211
ro command 41, 66, 141
ROESY experiment 85, 159
rotation of the sample 40, 66, 124, 132, 141, 142, 144, 247
rotor material 243
routing
parameters 34, 95, 156
table 13, 32, 57, 154, 155
rpar command 17, 34, 36, 40, 161, 165, 166, 191, 194, 218
rsh command 120, 126, 218
RX22
rs232 channel 65, 285
service tool 286

S
sample
changer 64, 66, 70
depth 137
diameter 136, 137, 238, 243
eject 140, 245
insert 140, 244, 245
position 140
rotation 66, 124, 132, 141, 144, 247
rotation frequency 40, 142
solvent 42, 59
temperature 19, 219, 228, 232, 234
transfer tube 245, 247
saturation of the lock signal 104
scaling region file 97, 185
SCM unit 109
SE451 receiver 41
sensitivity of GS sliders 201
sequential mode 12, 17
serial port 63
sethpcu command 255
setres command 171, 220
setsh command 122
setti command 162
Shape Tool 25, 42
shaped gradient
file name 223
shaped pulse
file name 223, 278
frequency offset 98
in CPD programs 38
list 179, 183
parameters 42
power 38
shim
commands 117, 125
definition file 123
file 120, 125, 128, 129, 258
increment 125
set 117, 120
unit 120, 122, 125, 126, 128
value 120, 122, 129, 218
shimming
automatically 123, 191, 194
manually 120, 122
on the FID 123
on the lock level 124
on the lock signal 112
using simplex 125
simplex algorithm 125
simplex AU program 126
simulation pulse sequence 266
simultaneous mode 12
single channel detection 12
sliders
on a probehead 134, 145
smilies 53
soft pulse 85, 86
solid state 33, 100, 155, 238, 241
solvent
acquisition parameter 42
dependent lock parameters 59, 86, 109
dependent parameters 8, 84, 158, 191, 195, 218, 285
list 92, 102, 108
table 70, 92
solvloop command 86
spdisp command 270
spectral width
acquisition parameter 43
adjustment 20
in 2D data 26, 30
maximum 44
optimization 275
parameter 43, 44
spectrometer
communication problems 62
components 64
configuration 61, 62, 70, 95, 284
constants 88
frequency 97, 102
hardware 63
installation 64
interface 205
internal CPU 62
name 62, 63, 284
routing 32, 34, 57, 94, 154, 156
type 62, 96, 97
spectrum
display 34, 41
edges 53
noise 198
phase correction 16, 37, 91
referencing 58
resolution 45
spin rate 29, 55, 124, 141, 238, 243, 247, 248, 250, 253
spinlock tolerance 238
sref command 29, 43, 59, 103
stator of an MAS probe 238, 245, 247, 250
status of raw the data 150
status of the raw data 7, 9
stdisp command 25, 42
steady state conditions 19, 219
stop command 133, 145, 198, 202, 210, 212, 213, 220
suspend command 198, 210, 213
Switchbox 33, 38, 45, 58, 95, 155, 157

T
T1 relaxation 19, 219
te2get command 228
t2ready command 232
t2set command 234
tegtemon command 228
temnon command 229
temperature
acquisition parameter 46
commands 225
list 50, 179, 182, 278
maximum 229
minimum 229
monitor 229
of the inlet capillary 232
of the inlet cappilary 228
of the probe preamplifier 274
of the probehead coil 274
of the second regulator 228, 232, 234
parameter set 231
parameters 226, 227
stabilization 19, 219, 232
unit 46, 183, 225, 226, 227, 228, 231, 234
unit configuration 68, 70
unit rs232 channel 65, 285
temporary parameters 8
tepar command 231
teready command 232
teset command 46, 232, 234
tf3 command 53
time domain 45, 148

TMS 109
TOCSY experiment 30, 85, 159
tomography 100
tr command 214, 219
transfer data to disk 214
transmitter
blanking 88
frequency 143
gate 14
power 143
tuning 240, 255
tube amplifiers 255
tune command 86, 119, 122, 123, 125, 191, 194
tune file 86, 119, 123, 124, 191, 194
tuning knob 144, 145
tuning the probehead 51, 132, 133, 134, 143, 190, 191, 194

U
user defined
AU programs 69, 80, 170, 262
CPD programs 15, 174
experiments 192
gradient files 24
gradient programs 177, 258
hard pulses 86
parameter sets 161, 162, 163, 258
pulse programs 40, 175, 186, 213, 258, 263
relations file 86
shape files 42
soft pulses 86
XWIN-NMR settings 280

V
variable
amplitude list 47, 181, 185
counter list 48, 185, 278
dataset list 19, 185
delay list 49, 178, 185, 278
frequency list 185, 278
pulse list 49, 185, 278
temperature list 50, 185, 278
vish command 128
W
well-plate 56
wide bore probe 245, 247, 250
wobb command 51, 132, 134, 143, 190, 191, 194, 218
wobble
  curve 51, 144, 190
  parameters 133, 135, 146
  procedure 144
  pulse program 133, 135, 146
  steps 51, 146
  sweep width 51, 146
wpar command 162, 165
wsh command 128, 129

X
xau command 96, 215, 258
xaua command 13, 192, 195, 215
xaup command 215
XCMD macro 5
xfb command 195
Xwin-nmr
  command sequence 5
  display 191, 194, 208, 220
  file handling 3
  graphics 282
  home directory 4, 63
  installation 39, 63, 95, 96, 170, 186
  macros 5, 263
  menu 6
  parameters 7
  patchlevel 284
  popup menus 6
  resource settings 280
  status line 124
  version 86, 133, 135, 158, 198, 200, 208

Z
zg command 7, 8, 11, 190, 198, 218